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RECORD MUSIC WITHOUT A COMPUTERRECORD MUSIC WITHOUT A COMPUTER

Working within limitations expands 
your skills

Working with two-inch, you’re limited to 
up to 24 tracks at a time (unless, of course, 
your chaining tape machines). This means 
making hard choices on the spot, like 
bouncing multi-tracked vocals or guitars 
down in the middle of a tracking session to 

clear up tracks for another layer. You may 
find yourself limiting the number of mics 
to put on a source (do you really need that 
second mono drum room mic when you 
know deep down you’ll end up muting it in 
the mix?). Eliminating that potential clutter 
can help you dial-in the sound you want, 
from the onset.

If you do want to multi-mic a single source 
and you’re working with a desk, you can 
mix multiple mics (say that Shure SM57 
and Sennheiser 421 on guitars) down to 
a mono bus that you then send to tape—
committing on the spot to that blending of 
mics as your to-tape sound. 

Both of those examples help you hone 
your ear. With a DAW workflow, you can find 
yourself putting those same mics on your 
guitar cabinet, but not really tweaking the 
blend until you’re in the mix stage. While 
that’s an entirely valid approach, commit-
ting to that sound up front helps you define 
a guitar tone for the whole tracking ses-
sion—something that can boost a guitar-
ist’s confidence in the recording session, 
resulting in better performances. 

In many ways, dealing with tape is a lesson in 
less is more, something that the convenience 
of DAW-based recording and near-unlimited 
track counts can blissfully help you avoid. 

You’ll learn to listen with your ears, 
not your eyes

The other massive difference between 
working with a DAW, versus tape (au-

3 Reasons to Record Music without a Computer in 2018
by Jaime Traba

There is no doubt there is magic in recording to two-inch tape, not just in the 
appreciable audio quality it provides, but in having to work within how func-
tionally limiting it can be. If you remember when tape was your only option 

for making music, or are fortunate enough to have gotten hands-on experience with 
it more recently, you know exactly what I mean. 

At a quick glance, aside from its audible magic (the rich harmonic content 
now emulated by countless plug-ins and hardware units—the endless quest for 
“mojo”), tracking to tape can be viewed as kind of a pain. It doesn’t use time as 
efficiently as a DAW (think of the time lost spent waiting for tape to rewind), needs 
consistent upkeep, such as biasing the machine, and most terrifying of all: there is 
no Command Z to undo a mistaken delete!

However, I submit that these functional quirks of dealing with two-inch tape 
make you a stronger engineer, and can be practiced (or at least emulated) in a 
variety of ways to help fill your bag of tricks. I assure you, I’m no Luddite; I love the 
convenience and functionality of the modern DAW, and it is ultimately where I’m the 
most comfortable working. But getting out of our comfort zone helps us grow as 
creative professionals.
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dible considerations notwithstanding, 
of course), is how much more visual the 
process becomes with DAW-based ses-
sions; our eyes are literally glued to a 
colorful monitor that, on some level, our 
brains begin to relate back to the audio. 
Visually appealing software isn’t just hap-
penstance—programmers know users 
are going to spend hours staring at their 
screen and want that experience to be 
eye-catching and pleasant. Sure, you can 
just limit yourself to only 16 tracks in Pro 
Tools or Cubase, but you’re just underuti-
lizing your DAW track count rather than 
getting out of that DAW mind space. 

At various stages in tracking and mixing, I 
turn my computer monitor off and just listen 
to the playback. You’d be surprised how of-
ten you can hear nuances in a mix or track-
ing session better when your eyes aren’t fol-
lowing along with the playback head.

You’ll get more right on the way in
Since editing tape is nowhere as precise 

as editing within a DAW, a producer/engi-
neer who isn’t tracking to a computer is go-
ing to fi nd themselves pushing the artist for 
the best takes in a different way than when 
working with a DAW. No “we’ll comp it from 
15 takes,” or “we can just Melodyne it later.”

Getting the best performance out of an 
artist is undoubtedly a skill set unto itself, 
requiring one to fi nesse between consistent 
encouragement and tough love. You will 
learn to read an artist better, as well; I’ve re-
corded vocalists who wanted it as blunt as 
“that sucked, you can do better!” and gui-

tarists who got offended when I suggested 
we track another take to compare (he knew 
he had nailed the fi rst one—he hadn’t). 

This approach has helped me learn to 
use the conveniences of a DAW—easy ed-

iting, comping, and tun-
ing capabilities—not as a 
crutch but simply as the 
current state of recording 
tools. There’s an adage 
that will apply no matter 
the era: gold in, gold out. 
The best performances 
are harder to mess up in 
a mix than terrible per-
formances are to fi x. 

Getting out of the box
The good news is that 

you don’t need to fi nd and restore an old tape 
machine to put these ideas into practice. 
Like any skill, engineering and producing 
can be improved with practice, and a good 
practice is to challenge yourself. Tascam has 
long made computer-less recording options 
in the form of its ever-evolving Portastudio 
line of recorders. The original models al-
lowed you to record four tracks to cassette 
tape, while the more recent additions to the 
line, such as the digital DP-32SD, gives you 
21 faders, allows you to track up to eight 
tracks simultaneously (with 32 for playback 
and mixdown), and gives you mixing and 
mastering effects, all in one package. 

If you want to change direction com-
pletely, the Zoom F8 has established itself 
as a top-notch fi eld recorder that, thanks 
to its pristine preamps and ability to track 
10 tracks at once, could also serve in the 
studio. You’d have to dump your tracks to 
a DAW for access to mixdown effects, but 
it might be worth the tradeoff for its porta-
bility. Sound Device’s newer MixPre lineup 
features its famous Kashmir preamps 
and can function both as a USB interface 
or stand-alone recorder, providing some 
more options for you.

Whatever route you take, learning to 
work within the limitations of older gear or 
techniques can open your eyes to new ways 
to exploit modern music-making conve-
niences. Learning the skills of multiple ap-
proaches will let you know which may be 
best for any scenario—the mark of a great 
engineer. Q

RECORD MUSIC WITHOUT A COMPUTERRECORD MUSIC WITHOUT A COMPUTER

There’s an adage that 
will apply no matter the 
era: gold in, gold out. 
The best performances 
are harder to mess up 
in a mix than terrible 
performances are to fi x.
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SMALL DIAPHRAGM CONDENSER MICROPHONESLARGE DIAPHRAGM CONDENSER MICROPHONES

INCLUDED 
ACCESSORIES KEY:

6C = 6-Pin Cable
CC = Carry Case

DC = Dust Cover
HC = Hard Case

LB = Leather Bag
MF = Microfi ber Cloth

MS = Mic Stand
PF = Pop Filter

PS = Power Supply
SB = Stereo Bar

SM = Shockmount
TA = Threaded Adapter

UC = USB Cable
WC = Wood Case

WS = Windscreen
XC = XLR Cable

Large Diaphragm Condenser Microphones
A go-to mic choice for tracking vocals, voice overs, string instruments such as acoustic guitars and violins, 
percussion, and more, B&H carries a wide variety of large diaphragm condensers to suit a variety of needs 
and budgets. Available selections provide polar patterns ranging from supercardioid 
(very narrow pickup path) to omnidirectional (360 degree pickup), while many can 
handle SPL levels as high as 150dB for use on louder sound sources. Many selections 
include stands, cases, and cables and come in a wide variety of fi nishes.

 Brand AKG Aston Audio-Technica Behringer Blue CAD Lewitt MXL Microtech Gefell Polsen

Model P420 C214 P220 Origin AT2020 AT2035 AT4040 C-1 BlueBird SL Spark SL E100S LCT-440-Pure 770 M 930 PCR-65

Diaphragm Size 1” 1” 1” 1” .63” .96” — .63" — — 1” 1” — 1” 1”

Polar Pattern Multi Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Super Cardioid Cardioid Cardioid Cardioid Cardioid

Freq. Response 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 40Hz-20kHz 20Hz-20kHz 20Hz-20kHz 40Hz-18kHz 20Hz-20kHz 30Hz-20kHz 40Hz-18kHz 20Hz-20kHz

Dynamic Range — — — — 124dB 136dB 133dB — 126dB 119dB — — — 135dB —

S/N Ratio 79dB 81dB 78dB 76dB 74dB 82dB 82dB — 82dB 73dB — 87dB 74dB — —

Pad -20dB -20dB -20dB -10dB N -10dB -10dB — -20dB -20dB -10db — -10db N N

HP/LC Filter Y Y Y Y N Y Y N Y Y Y N N N N

Max. SPL 155dB 156dB 155dB 127dB 144dB 148dB 145dB 136dB 138dB 136dB 150dB 140dB 137dB — 125dB

Included Acc. SM, HC SM, HC,WS SM, CC — SM SM, TA, PP SM, CC SM, CC SM,HC SM, HC SM, HC CC, WS SM, HC WC, MS SM, MS

Color Black Black Black Silver Black Black Black Silver Blue Red Black Black Black Bronze Silver

SKU AKP420B AKC214  AKP220B ASTORIGIN AUAT2020 AUAT2035 AUAT4040 BEC1 BLBSLM BLSSL CAE100S LELCT440PURE MX770 MI211151 POPCR65

Price 199.00 399.00 149.00 269.0 99.00 149.00 299.00 49.99 299.99 199.99 499.00 269.00 75.00 1,215.50 79.99

 Brand Mojave Neumann Rode sE Electronics Senal Shure Studio Projects Warm Audio

Model MA-50 U 87 Ai TLM103 TLM-102 NT1A NT1 Kit NT2A Studio Pkg X1 Studio Bundle SC-550X SCM-660 KSM32/SL C1 WA-14 WA-87

Diaphragm Size 1” – – – 1” 1" 1” 1” – 1.3" .75” 1.06” 1” 1”

Polar Pattern Cardioid Multi Cardioid Cardioid Cardioid Cardioid Multi Cardioid Cardioid Multi/Variable Cardioid Cardioid Multi Multi

Freq. Response 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 30Hz-20kHz 20Hz-20kHz 20Hz-20kHz

Dynamic Range – 131dB 131dB — 132dB — 140dB – 140dB – – – – –

S/N Ratio – 87dB 87dB 82dB 132dB — 87dB – 79dB 60dB 81dB 77dB – –

Pad N -10dB N N N — -5dB, -10dB -10dB -10dB -10dB -15dB -10dB, -20dB -10dB, -20dB -10dB

HP/LC Filter N N N N N Y Y Y Y Y N N N Y

Max. SPL 125dB 117dB 138dB 144dB 137dB 132dB 147dB 125dB 140dB 140dB 148dB 131dB 138dB 125dB

Included Acc. SM, CC CC WC, SM SM PF, XC, DC, DVD SM, DC PF, XC, DC, DVD SM, PF SM, CC, PF SM, CC SM, SM, HC SM, CC, WS SM, HC

Color Black Nickel Nickel Black Silver-Gray Nickel Nickel Black Black Black Champagne Silver-Gray Black Black

SKU MOMA50 NEU87AI NETLM103A NETLM102MB RONT1ACRS RONT1KIT RONT2ASSP SEX1SSTUDIOB SESC550X SESCM660 SHKSM32SL STC1 WA14 WA87

Price 495.00 3,200.00 1,300.00 699.00 229.00 229.00 399.00 Log-On 99.99 199.99 549.00 249.99 499.00 599.00
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Small Diaphragm Condenser Microphones
A mic locker standard that is at home in front of a variety of string or acoustic instruments, choirs, 
drum overheads, and more, small diaphragm condensers are both excellent on their own and integral 
companion mics to their big brother, the large diaphragm condenser. Available selections provide polar 
patterns ranging from hypercardioid (very narrow pickup path) or omnidirectional (360 degree pickup), 
with certain models handling up to 155dB of SPL. Many selections include stand mounts and 
cases, and like large diaphragm condensers, they are available in a variety of fi nishes.

INCLUDED 
ACCESSORIES KEY:

6C = 6-Pin Cable
CC = Carry Case

DC = Dust Cover
HC = Hard Case

LB = Leather Bag
MS = Mic Stand

PF = Pop Filter
PS = Power Supply

SA = Stand Adapter
SB = Stereo Bar

SM = Shockmount
TA = Threaded Adapter

UC = USB Cable
WC = Wood Case

WS = Windscreen
XC = XLR Cable

Brand CAD Earthworks Neumann Rode Samson Schoeps Sennheiser Shure Studio Projects

Model e70 QTC30 SKM184MT KM 185 MT M3 M5 NT3 NT5 C02 Colette E614 MKH 50 SM137 KSM137/SL C4

Polar Pattern Cardioid, 
Omnidirectional Omni Cardioid Hypercardioid Cardioid Cardioid Cardioid Cardioid Cardioid Super--

cardioid
Super--
cardioid

Super--
cardioid Cardioid Cardioid Multi

Freq. Response 20Hz-20kHz 6Hz-30kHz 20Hz-20kHz 20Hz-20kHz 40Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 40Hz-20kHz 40Hz-20kHz 40Hz-20kHz 40Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz

Dynamic Range – – 122dB – 121dB – 128dB 128dB 112dB – – – 123dB 131dB –

S/N Ratio – – 78dB 70dB 73dB – 77dB 78dB – 79dB – 12dB 75dB 80dB 78dB

Pad -10dB, -20dB – N N -20db, -10dB N N N N N N -10dB -15dB 20db,15db -10dB, -20dB

HP/LC Filter Y – N N Y N N N N N N Y N Y Y

Max. SPL 134dB 142dB 142dB 125dB 142dB 140dB 140dB 143dB 134dB 128dB – 134dB 137dB 145dB 140dB

Included Acc. SM, WS HC, SM MS, WS, CC WS, SM MS, WS, CC MS, WS WS, CC MS, WS, CC SM, WS, CC MS, WS, CC MS, CC SM, WS MS, WS, CC WS

Color Black Nickel Black Matte Black Black Black Silver-Gray Silver-Gray Nickel Gray Black Black Black Nickel Silver-Gray

 SKU CAE70 EAQTC30 NESKM184MT NEKM185MT ROM3 ROM5MP RONT3 RONT5 SAC02 SCCMC641S SEE614 SEMKH50 SHSM137 SHKSM137SL STC4

Price 299.00 799.00 1,599.00 899.00 149.00 199.00 269.00 429.00 139.99 1,655.00 199.95 1,200.00 179.00 299.00 349.99

Brand AMT AKG Audio-Technica Audix Behringer Blue DPA Polsen Sennheiser Senal

Model M40 C1000S P170 Pro 37 AT4053b AT2021 SCX1/HC MB5050 C-2 -C-4 Hummingbird SMK4060 SDC-2150 MKH-8040 SCI-3212

Polar Pattern Hemispherical Hypercardioid 
Cardioid Cardioid Cardioid Hypercardioid Cardioid Hypercardioid Cardioid Cardioid Cardioid Cardioid Omni-

directional Cardioid Cardioid Multi/Variable

Freq. Response 20Hz-20kHz 50Hz-20kHz 30Hz-20kHz 30Hz-15kHz 20Hz-20kHz 30Hz-20kHz 40Hz-20kHz 50Hz-19kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 20Hz-20kHz 50Hz-18kHz 35Hz-50kHz 30Hz-18kHz

Dynamic Range — — — 112dB 129dB 126dB 116dB — 140dB — – — — — —

S/N Ratio — 73dB 75dB 65dB 78dB 75dB 20dB — 75dB — 85.5dB 71dB — — —

Pad N -10dB -20dB N -10dB N N N -10dB -10dB N N N N —

HP/LC Filter N Y N N Y N N N N — N — N N —

Max. SPL 114dB — 155dB 141dB 145dB 145dB 130dB — 140dB 136dB 130dB 134dB 125dB 142dB 135B

Included Acc. HC WS, CC MS SM, WS, CC MS, WS, CC MS, CC None SA, WS, XC SA, WS, SB, CC SM, WS, CC SM, WS Kit MC SM, WS SM, WS

Color Gold Nickel Black Black Black Black Black Black Black Nickel Black Gray — — Black Nickel

 SKU AMM40 AKC1000SN AKP170B AUPRO37 AUAT4053B AUAT2021 AUSCX1HC AUMB5050 BEC2Q BEC4 BLASDCM DPSMKSC4060 POSDC2150 SEMKH8040ST SESCI3212

Price 471.00 199.00 99.00 169.00 599.00 79.00 499.00 549.00 59.99 59.99 299.99 949.95 39.95 2,400.00 59.95
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DYNAMIC / RIBBON / TUBE MICROPHONESUSB & iOS MICROPHONES

NT-USB
USB Microphone

  » 16-Bit/48kHz Resolution Capture
  » Cardioid Polar Pattern
  » 1/8” Headphone Monitoring Jack
  » Direct Mix Control » iPad Compatible
  » Includes Pop Shield & Tripod Desk Stand
  » Includes Ring Mount, & 20’ USB Cable
  » Includes Storage Pouch

(RORODNTUSB) ..........................................169.00

UB-440
Professional USB Mic

  » Cardioid Condenser Element
  » 16-Bit/48kHz Recording Resolution
  » Integrated Preamp with Variable Gain
  » Headphone Monitor Out with Gain Control
  » Selectable 10dB Pad
  » Selectable High-Pass Filter at 80Hz
  » Compatible with Windows, Mac & iOS
  » Includes Stand, Mount & USB Cable

(SEUB440) .............................................. 129.99

Podcaster
USB Broadcast Microphone

  »  USB Connection Provides Direct Connection 
to PCs without Additional Hardware

  » Built-In Headphone Input and Amplifi er
  » Includes Stand Mount
  »  Cardioid Polar Pattern,

Minimizing Off-Axis Noise 
and Feedback

(ROPODCASTER)................................................................................ 229.00

Blackgold  Wireless Microphone 
and Audio Recorder (16GB)

  » Syncs Audio to iPhone via Bluetooth 2.1
  » Syncs Audio with iPhone Video
  » 1" Gold-Plated Condenser Capsule
  » Records up to 24-Bit/96 kHz
  » Cardioid Polar Pattern
  » Internal Memory of 16GB
  » Rechargeable LiPo Battery
  » iOS App for Recording, Mixing & Sharing

(MIM540020301) ............................................................................... 499.00

G-Track Pro USB Microphone 
with Audio Interface
  »  Large-Diaphragm USB 

Condenser Microphone
  » Record Vocals/Instruments Simultaneously
  » Onboard 24-Bit / 96 kHz Audio Interface
  » Cardioid, Figure-8, Omnidirectional
  » Onboard Mixer with Level Controls
  » Zero-Latency Monitoring
  » Integrated Desktop Base » Mac, Windows

(SAGTRACKPRO)................................................................................ 149.99

Prof. Turret Broadcaster
Video-Streaming System

  » 1080p HD Video with H.264 Compression
  »  48 kHz/24-Bit USB 

Condenser Microphone
  » Daylight-Balanced LED Ring Light
  » High-Quality Headphone Amplifi er
  » Hi-Speed USB Output, Internal USB Hub
  » Easy-Reach Control Tower Stand
  » Mix Control to Add USB Audio Input » Cool & Warm Light Filters

(MATURRET) ...................................................................................... 299.00

Uber Mic
USB Mic with Headphone Output

  » 3-Capsule, Large Diaphragm Condenser Mic
  » 4 x Selectable Polar Patterns
  » 16-Bit/48 kHz Resolution
  » 1/8" Headphone Monitoring Jack
  » Mute Control » Latency-Free Monitoring
  » Desktop Stand » Mounts on Mic Stand
  » Include Mini-USB Cable
  » Mac, Windows & iOS Compatibility

(MAUBERMIC) ..................................................................................... 99.00

Yeticaster
Professional

Broadcast Bundle
  »  Yeti Microphone 
(without Desktop Stand)

  » Radius III Shockmount
  » Compass Desktop Boom Arm
  » USB Cable
  » 3/8" to 5/8" Adapter

(BLYETICASTER) ................................................................................ 199.99

AT2020USB+
Cardioid Condenser USB Mic

  » 16-Bit Audio at 44.1/48 kHz Sample Rate
  » Zero-Latency Monitoring
  » High-Output Internal Headphone Amplifi er
  » Mix Control Blends Input with DAW Audio
  » Off-Axis Rejection for Clean Recordings
  » Mac and Windows Compatible
  » Includes Desk and Stand Mounts

(AUAT2020USBP) ............................................................................... 149.00

Snowball iCE
USB Condenser Mic

 with Accessory Pack (Black)

  » Cardioid Pattern
  » USB Connectivity
  » Easy Plug-and-Play - No Drivers to Install
  » Mac or PC Compatible
  » From Desktop to Laptop to iPad
  » CD-Quality Audio
  » Includes Stand and USB Cable

(BLSBUSBMSIB) .................................................................................. 49.00

RC-77-U  USB Retro
Condenser Mic

  » 1.25" Large Diaphragm
  » No Drivers or Power Supply Needed
  » Delivers Clean & Natural Sound
  » Mac and Windows Compatible
  »  Includes Desktop Mic Stand, 

USB Cable & Carry Pouch

(PORC77U) ............................................................. 69.95

USB Retro

69.95

MOTIV MV51  Digital Large 
Diaphragm Condenser Microphone (Silver)

  » For Audio & Video Conferencing
  »  Works with iOS, Android, 
Mac & Windows

  » 5 x DSP Preset Modes
  » Headphone Monitoring
  » Onboard Touch-Panel Controls
  » Integrated Stand
  » Includes USB & Lightning Cables

(SHMV51A) ........................................................................................ 199.00

MOTIV MV5  
Digital Condenser Microphone (Gray)

  »  For Mac, Windows, iOS & 
Android Devices

  »  Suitable for Music, Podcasting 
& Skype

  » Built-In Real-Time Headphone Monitor
  » Removable Desktop Stand
  » Includes a Micro-B to USB Cable
  » Includes Lightning Cable

(SHMV5ALTG) ...................................................................................... 99.00

MiC Plus  USB Cardioid 
Condenser Microphone 

  » 24-Bit/96 kHz Resolution
  » Cardioid Polar Pattern
  » 3.5mm Headphone Monitoring Jack
  » Zero-Latency Monitoring
  » Gain and Mute Control
  » Multi-Color LEDs » High Maximum SPL
  » Includes USB and Lightning Cables
  » Includes Tabletop Tripod » Mac OS X, Windows, iOS

(APMICPLUS) .................................................................................... 249.00

Raspberry
USB Microphone

  » Mobile USB Cardioid Microphone
  » Ideal for Podcasting, Voice-Over, Streaming
  » Plug-and-Play with PC, Mac, iPhone & iPad 
  » Patent-Pending Internal Acoustic Diffuser (IAD)
  »  Built-in Headphone Volume 

Control, Mic Level and Mute
  » 24-Bit/48kHz Resolution

(BLRASPBERRY) ................................................................................ 199.00

Condenser Microphone 

USB Condenser Mic
 with Accessory Pack (Black)

Easy Plug-and-Play - No Drivers to Install

 ................................................................................ 199.99

Video-Streaming System

1080p HD Video with H.264 Compression

Daylight-Balanced LED Ring Light
High-Quality Headphone Amplifi er
Hi-Speed USB Output, Internal USB Hub
Easy-Reach Control Tower Stand

Record Vocals/Instruments Simultaneously

Mac, Windows
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Procaster
Broadcast Quality Dynamic Mic

  » Tailored for Vocal Capturing
  » Cardioid Polar Pattern
  » Internal Shock Mounting
  » Internal Pop Filter
  » All Metal Construction

(ROPROCASTER)........................................................ 229.00

BCD-1
Broadcast Dynamic Microphone

  »  High Quality Dynamic Mic Built for 
Broadcast and Voice-Over Productions

  » Excellent Side Rejection
  » Built-in Isolation Shockmount
  » Cardioid Polar Pattern    » Tuned Filter
  » Includes Windscreen

(MXBCD1) ......................................................................................... 169.95

SM57-LC 
Microphone

  » Professional Workhorse Mic
  » Dynamic » Cardioid Polar Pattern
  » Bright, Clean Sound
  » Extremely Durable
  » Ideal for Live Sound Reinforcement
  » For Instruments and Vocals

(SHSM57LC) ................................................................99.00

SM7B
Cardioid Dynamic
Announcer Microphone

  »  For Professional Voice-Over Applications
  »  Flat, Wide-Range Frequency Response
  » Air Suspension Shock Isolation
  » Built-In Pop Filter
  » Cardioid Polar Pattern

(SHSM7B) ...............................................399.00

Mondo
Dynamic Kick Drum Mic

  » For Kick Drums & Low Frequency Signals
  » Ideal for Live & Recording Applications
  » Dynamic Element & Cardioid Polar Pattern
  » Internally Shockmounted Capsule
  » Includes SSM Shockmount
  » Cabernet Wine-Red Finish

(AVMONDO) ....................................................................................... 125.00

RE20
Cardioid Dynamic Voice-Over 
Microphone

  » Tailored Response for Vocals
  » Rugged, Steel Construction with Low Handling Noise
  » Supercardioid Polar Pattern
  » Internal Windscreen, Internal Blast and Wind Filter
  » Bass Tilt Down Switch    » Flat Frequency Respone

(ELRE20) ........................................................................................... 449.00 

PR 40 Dynamic Cardioid
Studio Microphone

  » Large Dynamic Element
  » Steel Housing
  » Internal Sorbothane Shockmount
  » Cardioid Pickup Pattern
  » Ideal for Vocals and Kick Drums
  » Assembled in the USA

(HEPR40) ............................................................................Call or Log-On 

Miking System  Shure XL 57 
Internal Miking System for Floor Tom

  »  Shockmount Internal Drum 
Miking System

  »  Shure XL 57 with 
Integrated Mount

  » Sonic Isolation
  »  For Consistent & 

Controlled Sound

(MADSMAXL57SD) ............................................................................. 129.00

RIBBON MICROPHONES

K2  Variable Pattern
Studio Tube Condenser Mic

  »  Large 1" Capsule with Gold Sputtered Diaphragm
and Internal Shock Mounting

  » Ultra-Low Noise
  » Wide Dynamic Range
  »  Continuously Variable Polar Patterns, from Omni

through Cardioid to Figure 8
  » Dedicated Power Supply

(ROK2) .............................................................................................. 699.00

NTK  Valve 1.0" 
Condenser Microphone

  »  Large Diaphragm Condenser
  » Class-A Tube Circuitry
  » Mylar Dual-Diaphragm Capsule
  » Jensen Transformer
  » 9 Polar Patterns
  » Separate Power Supply
  » Uses +48V Phantom Power

(RONTK) ............................................................................................ 529.00

CV-12
Condenser Microphone

  » Dual 32mm Gold Sputtered Capsules
  » Hand-Selected 6072A Tube Output Stage
  » Variable Polar Patterns - 9 Stages
  » Pad Attenuation Switch: -10dB
  » Low Frequency Roll-Off: 80Hz
  » External Power Supply
  » Custom Retro Shockmount

(AVCV12) ........................................................................................... 499.00

Fat Head
Ribbon Mic

  » Stereo Matched Pair
  » Stock Transformer
  » Figure 8 Polar Pattern
  » High Sensitivity & Detail
  » Hand-Tuned Ribbon Element
  » Balanced Audio Input Signal

In Brown/Gold (CAFHBPBGR) .......................................................... 399.00

TUBE MICROPHONES

DYNAMIC MICROPHONES

R144
Studio Ribbon Microphone

  »  1.8 Micron Aluminum Ribbon with
Figure-8 Polar Pickup Pattern

  » High SPL Capability
  » Robust Metal Body Withstands Professional Use
  »  Complete with a Shockmount, Mic Stand Adapter,

Cleaning Cloth, and Carrying Case

(MXR144) ............................................................................................ 82.00

 For Professional Voice-Over Applications

399.00

KSM8/N  Dualdyne
Handheld Vocal Microphone (Nickel) 

  » For Live Sound and Recording
  » Two Ultra-Thin Diaphragms
  » Cardioid Polar Pattern
  » Accurate Frequency Response
  » Flat Off-Axis Attenuation
  » Pneumatic Shockmount » Carbon-Steel Grille

(SHKSM8N) ..................................................................... 499.00

Dynamic Element & Cardioid Polar Pattern

Project R1 Active MKIII
Active Ribbon Microphone

  » Classic Ribbon Mic Sound
  » Active Circuitry Provides Higher Output
  » Ultra-Realistic Reproduction
  » Bipolar/FET Discrete Low-Noise Amplifi er
  »  Uses 48V Phantom Power    » Handles up to 

160 dB SPL    » Figure-8 Polar Pattern
  » Integrated Stand Mount

(GOR1ACTMK3) ................................................................................. 229.99
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BOUNDARY / HANGING / GOOSENECK MICROPHONESHANDHELD PERFORMANCE & HEADSET MICROPHONES

SM58-LC
Cardioid Handheld Dynamic Mic 

  » Frequency Response Tailored for Vocals
  » Break 50Hz-15kMhz Frequency Response
  »  Break Unidirectional Cardioid Pickup Pattern 
50Hz to 15kHz Frequency Response

  » Built-In Pop Filter » Break-Resistant Stand Adapter
  » Available With or Without On/Off Switch

(SHSM58LC) ...............................................................99.00
SM58S Microphone with Switch (SHSM58S)................................ 104.00

SM31FH Fitness Headset
Condenser Microphone

  »  Designed for Fitness 
Instructors

  »  Hydrophobic Fabric 
Protects Mic

  » Flexible Gooseneck
  » Cardioid Polar Pattern
  » Includes Windscreen

(SHSM31FHTQG) ................................................................................. 99.00

UEM-155-TA4F-BE
Omni Earset Microphone

  » Miniature Omni Earset Microphone
  » Optimized for Speech and Vocals
  » For Shure Transmitters
  » Slim and Flexible Boom Arm
  » Comfortable Ear Grip
  » Low Profi le and Lightweight

With TA4F for Shure Transmitters (BEIGE) (SEU155TA4FBE) ...... 149.00
With Connector for Sennheiser (BEIGE) (SEUE15535HBE) .......... 149.00
With Connector for Sennheiser (BLACK) (SEUE15535HBK) ........ 149.00

KMS 105 
Live Vocal Condenser Mic

  » K 105 Supercardioid Capsule
  » Low Self-Noise » Transformerless
  » Good Pop Shielding without Side Effects
  » Includes Pouch for Transporting Mic
  »  Includes Nylon Bag
  » Matching Stand Clamp

Black (NEKMS105BK) ................................................699.00
Nickel (NEKMS105NI) ................................................699.00

835S
Cardioid Handheld Dynamic Mic

  » Metal Construction / Rugged and Reliable
  » Shockmounted Capsule
  » Cardioid Pickup Pattern
  » Hum Compensating Coil Reduces Electrical Interference
  » Neodynum Ferrous Magnet with Boron
  » Falcon Ring / Consistent Sound over Time

(SEE835) ....................................................................99.95

PVi 100  Dynamic Handheld 
Microphone (XLR Cable)

  » Cardioid Polar Pattern
  » On/Off Switch
  » Includes 19' XLR Cable
  »  Well Suited for Capturing Speech and Singing

During Performances, Presentations, Sermons
and More

(PEPVI100XLR) ...........................................................22.99

Isomax Headset Microphone
with 3-pin XLR Connector

  » 3-Pin XLR Connector
  » Cardioid Polar Pattern
  » 20Hz to 20kHz Frequency Response
  » Flexible, Adjustable Band
  » Beige
  » For Speech & Performances

(COMHCP6L) ..................................................................................... 239.00

SE10T Omnidirectional
Head Worn Microphone

  » Micro-Miniature Condenser with 3mm Capsule
  » Omnidirectional Pickup Pattern
  » Fits left or right ear 
  » Moisture Resistant Coating
  » Detachable Cable
  » Four Cable Adapters for Wireless Transmitters
  » Includes: 3 Windscreens, Clothing Cable Clip & Carry Case

(SASE10T) ...........................................................................Call or Log-On

HDM-16-S  Handheld Dynamic 
Performance Mic 

  »  Optimized for Vocals and Speech
  »  Wide Frequency Response with

Impressive Sensitivity
  » Supercardioid Polar Pattern 
  » Rugged and Portable
  » Integrated On/Off Switch
  » Includes 16' XLR Cable and Mic Clip and Carry Pouch

(POHDM16S) ................................................................... 39.99

PRO 8-HEX
Condenser Headworn Microphone

  »  Professional Quality Vocal Pickup 
with Hands-Free Operation

  »  Low Visibility Headband 
Provides Stable, Comfortable Fit

  »  Pivot Mounted Flexible Mic 
Boom Descends From Left or Right Side

  » 7.2'  Cable Attached

(AUPRO8HEX) ...................................................................................... 79.00

D5 Handheld Supercardioid
Dynamic Vocal Microphone

  » Supercardioid Polar Pattern
  » Dual Shockmount Capsule
  »  Patented AKG Laminated 

Varimotion Diaphragm
  » 70Hz–20kMHz frequency response
  » Rugged Construction
  » Includes: Stand Adapter, Pouch 

(AKD5) ............................................................................99.00

CO-3  Earworn Omnidirectional 
Microphone

  »  Optimized for Speech » TA4-Female 
Connector » For Shure Wireless 
Transmitters

  »  Omnidirectional 
Polar Pattern

  » Left Ear Placement Low-Profi le Design

(POCO3SHBE) ...................................................................................... 99.00
For Audio-Technica Transmitters (Beige) (POCO3ATBE) ............... 99.00

 Break-Resistant Stand Adapter

AT2010  Cardioid Condenser 
Handheld Mic

  »  For Live Stage, Studio, and Voice-Overs
  » Delivers All-Around Performance
  » Cardioid Polar Pattern » Hand-Tuned Capsule
  » Reinforced Construction
  » Heavy-Duty, Metal-Plated Finish
  »  3-Pin XLR Output
  » Includes Mic Clip and Storage Pouch
  » Additional Chrome Mic Grille

(BLE100B) .....................................................................99.99

Hum Compensating Coil Reduces Electrical Interference

Condenser Microphone

Head Worn Microphone

Micro-Miniature Condenser with 3mm Capsule

Four Cable Adapters for Wireless Transmitters
Includes: 3 Windscreens, Clothing Cable Clip & Carry Case

HANDHELD PERFORMANCE

HEADSET MICROPHONES

Boom Descends From Left or Right Side

ND76
 Dynamic Cardioid Vocal Mic

  » For Live Sound and Recording
  » Effective in Small-to-Medium-Sized Venues
  » Shockmounted Capsule
  » Memrafl ex Grille Resists Denting
  » Neodymium Magnet
  » Humbucking Coil Guards against Line Hum

(ELND76CM) .............................................................129.00

XM8500  Dynamic
Cardioid Vocal Mic

  » Cardioid Polar Pattern » Dynamic Transducer
  » 50 Hz - 15 kHz Frequency Response
  » Smooth Mid-Frequency Presence Rise
  » Ultra-Low Distortion for a Super Clean Sound
  » Internal Shockmount System
  » Microphone Stand Adapter Included

(BEXM8500) ................................................................ 19.99

Omni Earset Microphone Microphone
Optimized for Speech » TA4-Female 

For Shure Wireless 

Low-Profi le Design
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CM12C
Hanging Choir Microphone

  » Miniature Hanging Choir Microphone
  » Condenser Element » Cardioid Pickup Pattern
  » Mini XLR Connector » Hardwired 30-foot Cable
  » Steel Hanging Positioning Bracket
  » Mini to Standard XLR Connector included
  » Multistage Windscreen

(SACM12C) .......................................................................................... 99.99

BOUNDARY / HANGING / GOOSENECK MICROPHONESHANDHELD PERFORMANCE & HEADSET MICROPHONES

PRO-44 Hemi-Cardioid
Condenser Boundary Microphone

  » Low Profi le for Minimum Visibility
  » Wide-Range Condenser Element 
  » Rugged Design and Construction
  »  Self-Contained Electronics Eliminate 
Need for External Power Modules

  » Low-mass Diaphragm for Superior Performance

(AUPRO44) .......................................................................................... 99.00

U855QL
Cardioid Dynamic Gooseneck Mic

  »  Designed for Dispatch, 
Paging & Talk-Back

  » Tailored Frequency Response
  » Flexible Adjustable Gooseneck
  »  Measures 18" 

(45.72cm)

(AUU855QL) ................................................................ 109.00

MX393/O Microfl ex
Omnidirectional Boundary Microphone

  » Omnidirectional Polar Pattern
  » 50 Hz to 17 kHz Frequency Range
  »  Suitable for Low-Profi le Situations
  » Attached XLR Cable
  »  Built-In RF-Shielding 

Technology

(SHMX393O) ...................................................................................... 242.00

Voice Tracker II
Array Microphone

  » Feedback Rejecting AEC Technology
  » Ideal for Voice Recognition
  » Listening Beam Technology
  »  Coverage throughout 
a Large Room

  » Optional USB Power Adapter » Mac & Windows Compatible

(ACVTIIAM) ........................................................................................ 342.00
Voice Tracker I Array Microphone (ACVTIAM) .............................. 243.00

AC-404 
Portable USB Conferencing Microphone

  » Low Profi le Design
  » 180-Degree Coverage
  »  No Drivers Needed, 

Plug-and-Play
  » 3 Capsule Boundary Design
  » Mac & Windows Compatible

(MXAC404) .......................................................................................... 73.95

MX412DC  18" Desk-Top
Cardioid Gooseneck Microphone

  » Locking Flange Mount 
  » Interchangeable Cartridges 
  » Balanced, Transformerless Output 
  » Wide Dynamic Range & Frequency Response 
  »  Shockmount That Provides 
over 20dB Isolation

(SHMX418DC) ............................................. 288.00
MX412DC (SHMX412DC) .......................... 288.00

MEG 14-40
Table Top Condenser Mic

  » FCardioid Polar Pattern
  » For Lectures, Conferences, & Meetings
  » 50 Hz to 20 kHz Frequency Response
  » RF Shielding Reduces Interference
  » 12 to 48V Phantom Power
  » XLR 3-Pin Male Connector

(SEMEG1440) ...................................................................................... 30.12

 Self-Contained Electronics Eliminate 

Wide Dynamic Range & Frequency Response 

288.00
288.00

Voice Tracker II

Feedback Rejecting AEC Technology

PCC-160
Phase Coherent Cardioid Microphone

  »  Industry Standard Stage 
Microphone

  »  Half Super-Cardioid 
Polar Pattern

  » XLR Connection
  » Phase Coherent Pick-Up
  » Rugged Design » Compact Dimensions

(AKPCC160) ....................................................................................... 349.00

3 Capsule Boundary Design
Mac & Windows Compatible

PRO 45
Cardioid Condenser Hanging Mic

  » Perfect for Suspension Over Choirs and Orchestras
  » Wide Range Condenser Element with Hi-SPL Handling  
  » Low Mass Diaphragm for Superior Performance
  » Flat, Smooth Frequency Response
  » 25' XLR Cable Permanently Attached 

Black (AUPRO45) ............................................................................... 99.00
White (AUPRO45W) ........................................................................... 99.00

Cardioid Condenser Hanging Mic

Perfect for Suspension Over Choirs and Orchestras
Wide Range Condenser Element with Hi-SPL Handling  
Low Mass Diaphragm for Superior Performance

 ............................................................................... 99.00
99.00

Centaverse
Overhead Cardioid Condenser Mic

  » Low Profi le Mic with Minimum Visibility
  »  Integrated Wire Aiming Hanger Allows for Suitable 

Placement Above Choirs and Other Ensemble
  »  CommShield Technology Guards against Unwanted 

RF Interference

Black (SHCVOBC) ..................................................... 89.00
White (SHCVOWC) .................................................... 89.00

OHCM-200
Overhead Hanging Microphone

  » Overhead Signal Capturing
  » Attached 20' Cable with XLR Connector
  »  Cardioid Polar Pattern
  » Low-Mass Condenser Element
  » Miniature Profi le
  » Includes Hanging Wire Mount

(NAOHCM200B) ................................................................................... 48.20

Overhead Hanging Microphone

Attached 20' Cable with XLR Connector

CHM 99 
Hanging Microphone

  » Cardioid Polar Pattern
  » Especially Suited for Choir Recordings
  » Frequency Response: 70Hz to 18kHz
  » 125° Pickup Angle   »  33' Cable
  » Adjustable Hanging Clamp

White (AKCHM99W) ......................................................................... 149.00
Black (AKCHM99B) .......................................................................... 149.00

BOUNDARY MICROPHONES

GOOSENECK MICROPHONES

HANGING MICROPHONES

Ceiling Microphone Array Kit 
for Converge Pro & Interact Pro Mixers

  » For Meeting and Conference Rooms
  » Three Cardioid Condenser Microphones
  » 360º Coverage » 100 Hz – 12 kHz Freq. Response
  » RF Hardened and Shielded » RJ45 Output
  » Includes RJ45 to Mini-Phoenix Adapter
  » Includes Multiple Cables » Phantom Powered

(CLCMAK) .......................................................................................... 599.00

UB1 Omnidirectional
USB Boundary Microphone

  » Surface-Mount Condenser Microphone
  » Miniature, Low Profi le Design
  » Omnidirectional Polar Pattern
  »  Records 16-Bit Audio at 44.1 

or 48 kHz
  » Plug-and-Play Operation
  » Compatible with Mac and Windows

(SAUB1) .............................................................................Call or Log-On

MEG 14-40

30.12
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MICROPHONE ACCESSORIESMIC STANDS / BROADCAST ARMS / POP FILTERS

MC-66B
Mic Stand with 
One-Handed Height 
Adjustment

  »  Fast, Lightweight, 
One-Handed Clutch

  » Durable Aluminum Construction
  »  Tripod Base with 
Upward-Folding Legs

  » Fast Setup and Storage

(UL17962) ...........................................................69.99

goSTAND
Portable Microphone Stand

  »  Designed to 
Fold Down & 
Fit in Your Bag

  »  58" High When 
Fully Extended

  »  Folds Down to 
Less Than 18"

(AIGSPMS) ..........................................................49.00

PSA-1
Studio Boom Arm
for Broadcast Microphones

  » 32” Horizontal Reach
  »  33” Vertical
Reach

  »  Touch-Fastener 
Cable Wraps

  » Desk Clamp Included
  » Desk-Insert Hardware

(ROPSA1) ............................................................99.00

210/9
Tripod
Microphone Stand
with Telescoping Boom

  »  Stable and Sturdy Steel 
Material with Zinc 
Die-Cast Base

  »  2-Piece Telescopic 
Boom Arm

(KM2109B) ..........................................................89.99

ProBoom Ultima LP
Adjustable Mic Boom

  »  Mount Microphones to a Table
  »  Ideal for Announcers,

Interviews & DJs
  » 12" Fixed Horizontal Arm
  » 30" Reach
  » 6 lb Weight Rating
  »  Low 

Profi le
  » Integrated Wire Channeling

(OCULPMB) ...................................................... 314.10

MS-5130
Round Base
Microphone Stand

  »  Telescoping Shaft with 
Ergonomic Clutch

  » Weighted Round Base
  » Non-Slip Rubber Feet
  » Durable Steel Construction

(AUMS5130) ........................................................19.50

A-188
Desktop Microphone Stand 
with Tripod Base

  » Folding Tripod Legs
  » Rubber Microphone Holder
  »  Adjustable Height between

4.3 to 6.7”
  »  Ideal for General 

Speech Capturing in Broadcast, 
Recording and Public-Address Applications

(QUA188) .............................................................19.99

DS-7E
Adjustable 

Round Base Desk Stand

  »  Variable Height Adjustment
between 8” - 13”

  »  6” Cast-Iron Round Base
  » Grip-Action Clutch
  » Non-Refl ective Black Tubing
  » Weighs just 3 lb
  »  Quality Construction Assures Extended 

Service and Quality Appearance

(ATDS7E) .............................................................29.99

MBS5000
Broadcast/Webcast
Boom Arm with
XLR Cable

  » Durable Articulating Boom Arm
  » Ergonomic Three-Prong Knobs
  » Quiet and Flexible Positioning
  » Pre-Installed 10' XLR Cable
  » 19.5" Vertical & Horizontal Arm Length
  » C-Clamp and Flange-Style Mount

(ONMBS5000).....................................Call or Log-On

PFSS-55  Pop Filter 
with Gooseneck

  »  5.5˝ Double-
Layered Nylon

  » 13.5˝ Gooseneck
  »  Prevents Vocal 

Pops
  » Protects Mic from Corrosive Moisture
  » Locking Nut for Secure Hold
  » Spring-Loaded Clamp for Easy Mounting

(AUPFSS55)......................................... 18.99

MS-5230F
Tripod Microphone 
Stand with Fixed Boom 

  » Multi-Angle Boom Arm
  »  Telescoping Shaft with

Ergonomic Clutch
  » Reinforced Tripod Base
  » Non-Slip Feet
  » Durable Steel Construction
  » Portable, Collapsible Design

(AUMS5230F) ......................................................21.99
OTHER CONFIGURATIONS AVAILABLE

TT-6220
Telescoping Tabletop
Microphone Stand 

  »  Telescoping Shaft for
Adjustable Height

  » Weighted round base
  » Five, non-slip rubber feet
  » Microphone cable guide
  » Durable steel construction

(AUTT6220B) .......................................................12.00

BAI-2X
Two-Section Broadcast Arm 
with Internal Springs

  »  Internal Springs for Clean 
& Sleek Look

  » Supports Mics up to 5 lb
  » 5/8"-27 Standard Mic Thread
  » Fits Mic Clips and Shockmounts
  » Extends to 40"/Rotates 360°
  » 14" Riser
  » Integrated XLR Cable

(AUBAI2X) ........................................................ 119.99

ISO-ARMOR-2
Microphone Isolation Chamber

  »  Reduces Ambient Noise & 
Room Refl ections

  »  Yields a More Dry, 
Direct Sound

  »  Fits Microphone Diameters 
up to 2.3"

  » Perforated Aluminum Shell
  » Built-In Nylon Pop Filter Screen
  » Integrated Shockmount Adapter

(AUISOARMOR2) ................................................. 99.99

with Tripod Base

Rubber Microphone Holder
 Adjustable Height between

Speech Capturing in Broadcast, 

Desk Clamp Included
Desk-Insert Hardware

SPACE
Refl etion Filter

  » Reduces Ambiance & Refl ections
  » 10-Layer Acoustic Filter Design
  »  7 Vertical 

Bass Pillars
  »  Adjustable 

Clamp
  »  Locks 

Horizontally & Vertically
  » Tilts for Instrument Recording

(SEESPACE) ........................................Call or Log-On

10-Layer Acoustic Filter Design

Horizontally & Vertically

Protects Mic from Corrosive Moisture
Locking Nut for Secure Hold
Spring-Loaded Clamp for Easy Mounting

......................................... 18.99

Stand with Fixed Boom 

21.99

Microphone Stand
with Telescoping Boom

89.99

Built-In Nylon Pop Filter Screen
Integrated Shockmount Adapter

19.5" Vertical & Horizontal Arm Length

MIC STANDS

BROADCAST ARMS

FLOOR & TABLE STANDS

POP & REFLECTION FILTERS

Sound Shield
Compact Folding Vocal 
Refl ection Filter

  »  Compact Microphone 
Isolation Solution

  »  Absorbs Unwanted 
Ambient Refl ections

  » Folding, Curved Metal Panels
  » High-Quality Acoustic Foam
  » Mounts Directly on Mic Stands
  » Lightweight for Easy Transport

(MASNDSHLDCMC) ..............................................59.00

5/8"-27 Standard Mic Thread
Fits Mic Clips and Shockmounts
Extends to 40"/Rotates 360°

 Ideal for Announcers,
Interviews & DJs
12" Fixed Horizontal Arm
30" Reach
6 lb Weight Rating

Folding, Curved Metal Panels
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Pearstone IMA-1030
Switchable In-Line 

Attenuator

(PEIMA1030) ........................... 24.99

Neutrik NA3MM
XLR Male to

XLR Male Adapter

(NENA3MM) .............................. 6.61

TRITON AUDIO FetHead
In-Line Microphone 

Preamp

(TRFETHEAD) ........................... 89.95

B&H’s selection of in-line accessories 
provides a variety of solutions to com-
mon everyday issues found in studios 
or ENG scenarios. Ranging from in-line 
attenuators, to phase switches, gender 
changers, ground lifts, and more, our 
in-line accessories section has the 
solution you’re looking for.

CLIPS

SHOCKMOUNTS

CLAMPS, MOUNTS & BRACKETS

THREAD ADAPTERS

IN-LINE MIC ACCESSORIES

To view a full listing
of all Microphone

Accessories

or visit our website
BandH.com/w15295

SCAN THIS CODE

®

Whether you need a clip for your hand-
held dynamic, small diaphragm con-
denser, or shotgun mic, B&H’s selec-
tion will provide you with what you’re 
looking for. Ranging from rubber to 
plastic and clothespin style, we have 
a variety of clip options to select from.

On-Stage MY200
Clothespin-Style Plastic 
Microphone Clip

(ONMY200) ................................ 5.95

QuikLok MP892
Small Rubber Mic Clip 
for Wired Microphones

(QUMP892) ................................ 1.99

Shure A25DM
Stand Adapter for 
SM58/57/87A & Beta 87A

(SHA25DM) ............................... 4.95

Auray SHM-UC2
Clamping Suspension 
Shockmount

(AUSHMUC2) ............................ 24.99

On-Stage MY-410
Studio Microphone 
Shockmount

(ONMY410) .............................. 19.95

Shure A55M
Isolation and Swivel 
Shock Stopper Mic Mount

(SHA55M) ................................ 21.99

WindTech M-1
5/8"-27 Female to 3/8"-

16 Male Thread Adapter

(WIM1A) .................................... 3.50

Auray Combo
Male to Female Reversible 

Thread Adapter

(AUADCOMBOS) ......................... 4.95

K&M 217
3/8" Female Thread,

5/8" 27 Male Thread

(KMTAZCTD) .............................. 2.49

Prevent your mic from being plagued by 
vibrations from your stand or mount by 
incorporating shockmounts from B&H’s 
wide selection. Regardless of what 
kind of mic you’re using, whether it’s a 
large diaphragm condenser, a small di-
aphragm condenser, a dynamic or cam-
era-mounted shotgun mic, our website 
has a vast array to suit your needs.

AKG KM235/1
Stereo 
Microphone Bar

(AKKM2351) ........... Call or Log-On

Dinkum Systems 3013
FlexiMount

(DI3013) .................................. 49.00

On-Stage MM01
Ball-Joint Mic Adapter
with Textured Finish

(ONMM01)................................. 9.95

Whether you’re capturing audio in the 
studio, in ENG environments, or work-
ing with live sound, it’s inevitable that 
you’re going to have to attach one piece 
of equipment to another. B&H stocks a 
large selection of clamps, mounts, and 
brackets, ranging from the common to 
the unique, ensuring that your acces-
sory needs are covered.

Don’t let mismatched threads keep you 
from connecting your gear to stands or 
cameras. Regardless of whether you’re 
trying to connect a mic to a stand or 
an accessory to your camera’s shoe 
mount, B&H’s ample thread adapter 
options will help keep your gear con-
nected.
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COMPRESSORS / EQUALIZERSMIC PREAMPS / CHANNEL STRIPS

DMP-2
Compact Microphone Preamp

  » Switchable Limiter » Phantom Power
  » Compact and Portable Housing
  » Battery Powered » 2 Channel

(NADMP2) ........................................................................................... 69.00

m101 
Microphone Preamp with Ribbon Mic Mode

  »  Fully Balanced, 
Transformerless, 
Single-Channel 
Microphone Preamp with Optimized DI Instrument Input

  » Built in Switchable 75Hz, 12dB/8ve High-Pass Filter
  » Precision 12-Position, Gold Contact, Rotary Switch Gain Control
  » 10 to 75dB Gain Range, 10dB Output Trim Controls
  » Switchable 48V Phantom Power

(GRM101) .......................................................................................... 765.00

RNP8380 
Really Nice Preamp

  »  Two-Channel Microphone
Preamplifi er

  » 1/4" and XLR Inputs
  » Pristine Class-A Preamps
  » Innovative Circuit Design
  » Repeatable Gain Switch
  » Accurate Signal-Level Metering
  » Front-Panel Unbalanced DI Inputs

(FMRNP) ........................................................................................... 475.00

VT-737SP
Channel Strip

  »  Single Channel »  Microphone Preamp » Instrument DI
  » Line Input » Opto-Compressor » 4-Band EQ » VU Meter
  » Universal Power Supply

(AVVT737SP) ..................................................................................2,475.00

 SOLO/610  Classic Vacuum Tube 
Microphone Preamplifi er and DI Box

  »  Classic Putnam 610 Console 
Microphone Preamplifi er and DI

  »  Legendary all-tube Sound at 
a project studio price

  »  Gain, level and impedance 
selection for max. tonal variety

  »  Rugged Construction-Steel 
Chassis in a Portable Design for Studio, Desktop or Stage

(UNS610) .......................................................................................... 999.00

MIC100 ULTRAGAIN PRO
Tube Mic Pre and Direct Box

  »   Tube Mic/Line Preamp with 
Integrated Limiter 

  » 12AX7 Vacuum Tube 
  »  Phase Reverse Switch, 20dB Pad
  »  +48v Phantom Power, Wide-Range 
Input Gain and Outputlevel Adjustment. 
Balanced I/O on 1/4” TRS Phone and XLR Connectors

(BEMIC100) ......................................................................................... 39.99

TubePre v2
Tube Preamplifi er/DI Box

  » Single Channel
  » Preamp and DI
  » Solid-State Preamp
  » 12AX7 Vacuum-Tube Stage
  » Balanced and Unbalanced I/O » Phantom Power
  » High-Pass Filter » Phase Reverse
  » Backlit VU Meter » Rugged and Compact Enclosure

(PRTUBEPREV2) ................................................................................ 129.95

Studio Channel
Vacuum-Tube Channel Strip

  » Class A Tube Preamp
  » 12AX7 Tube with Gain and Tube Drive Controls
  » VCA Compressor » 3-Band Parametric Equalizer
  » Illuminated VU Meter Displays Output Level and Gain Reduction
  » 80Hz High-Pass Filter » 20dB Pad » Phase Invert
  » Make-Up Gain, Auto, and Soft (Compressor Section)

(PRSTUDIOCHAN) .............................................................................. 299.95

VTB1
Variable Tube Microphone Preamplifi er

  »  Perfect for the Professional and Home Project Studio 
Doing Production, Broadcast and Voice-Over Work

  » Single Channel » Line Input » Hi-Pass Filter
  » Tube Blend » Tube Stage » Output Stage

(STVTB1) ........................................................................................... 179.99

286s
Mic Preamp/Channel Strip

  » Single Channel
  » 4 Processors
  » Compressor

  » De-Esser
  » Enhancer
  » Expander/Gate

  » Phantom Power
  » Insert Jack
  » Meters

(DB286S)........................................................................................... 199.95

Tube MP Studio V3
Tube Microphone Preamp

  »  V3 Technology Which Presets That 
Allow You to Select Between 
Preamp Settings Designed for 
Guitars, Keyboards, Drums, 
Vocals and more

  »  OPL (Output Protection Limiter) 
Accurately Controls and Maintains the Output Peak Signal

(ARTMPSV3) ........................................................................................ 75.00

Auteur MkII
2-Channel Mic Preamp

  »  2x Balanced XLR 
Microphone Inputs

  »  2x 1/4" TRS 
Output Jacks

  » 48V Phantom Power » Low Distortion and Noise
  » 10 dBu Pad » Includes Phase Effect
  » Edcor Output Transformers

(BLAUTEURMK2) ............................................................................... 399.00

XL48
8-Channel Microphone Preamp 

  »  8 MIDAS XL4 Microphone Preamps
  » Per Channel Phantom Power and 20dB Pad
  » MIDAS XL4 Low- and High-Pass Filters
  » 8-Segment LED Meter per Channel
  » Low Latency 24-bit/96kHz A/D Converters
  » AES and ADAT Output, 1U Rack Chassis

(MIXL48) ........................................................................................... 899.99

TB12 Tone Beast
Microphone Preamplifi er

  »  Mic, Instrument, & Line Inputs
  » Up to 71dB of Gain, Output Gain Attenuator
  » Switchable Discrete Op Amp, Switchable Input Impedance
  » Switchable Output Transformer, Switchable Capacitor
  » 48V, Polarity Switch, 20dB Pad

(WATB12) .......................................................................................... 599.00

Input Gain and Outputlevel Adjustment. 
Balanced I/O on 1/4” TRS Phone and XLR Connectors

OctoPre
8-Channel Preamp

» Adds 8 Mic Pres and 8 Line Outs to Existing Interfaces
» 118 dB Input Gain & 119 dB Output Gain
» 24-Bit/192 kHz AD/DA » Dual-Port ADAT I/O for 8 Channels
» Switchable Insert Point » 48V Power on All Inputs
» Word Clock I/O » Front-Panel Inputs Suitable for Guitars

(FOOP824) ......................................................................................... 699.99

276-285 Pro Audio.indd   284 3/16/18   1:00 PM



285www.BandH.com

PRO AUDIOCOMPRESSORS / EQUALIZERSMIC PREAMPS / CHANNEL STRIPS

RNC1773 
Really Nice Compressor
»  Stereo Compressor 

in 1/3 Rack Size
»  High-Fidelity Audio 

Path and Compression
»  Normal and Super 

Nice Modes » 5 Parameter Controls
» Attack and Release Controls » 2 x 1/4" Input/Outputs
» 1 x 1/4" TRS Sidechain Insert » Aluminum and Steel Enclosure
(FMRNC) ........................................................................................... 175.00

COMP-3A   1 Channel Vintage Style 
Compressor and Leveler

  »  Optical Compressor 
Modeled on the LA-3A

  »  Program-Dependent 
Compression

  »  Geared toward Project Studios
  » High-Frequency Sidechain Circuit » Selectable Metering
  » XLR & 1/4" TRS Jacks » Transformer-Balanced Inputs & Outputs

(GOCOMP3A) ..................................................................................... 499.99

FINALIZER PLUS
96K - Stereo Studio Mastering Dynamics 

  »  Multiband Compressor and Limiter Algorithms Bring Mixes to Life
  » Enter and Exit at any Sample Rate - 32, 44.1, 48, 88.2 and 96kHz
  » Asynchronous Conversion » Five Band Stereo Digital Equalizer
  » Optimizes the Overall Level with the Automatic Make-Up Gain
  » High Resolution LED Metering of Input, Output and Gain Reduction

(TCF96K) ........................................................................................1,449.00

CLX-52
Compressor/Limiter

  »  Stereo or Dual Mono Operation of Compression 
with Side Chain Access, Extremely Low Noise and Distortion

  » Dual Release Time for Minimizing “Pumping”
  » Powerful Peak Control with Minimum Audible Side Effects
  » Both XLR and 1/4” Input and Output Connectors

(ASCLX52) ......................................................................................... 249.00

SL33b 
Stereo Program Limiter

  »  Threshold
Control

  »  Output Level
Control

  »  1/8" Stereo / 
RCA Inputs & Outputs

  » Automatic Program Limiting » Stereo Compressor/Limiter

(ROSL33B) .......................................................................................... 63.00

MDX4600 MULTICOM PRO-XL
Compressor/Limiter & Peak Limiter

  » Program Adaptive Compression Circuitry 
  » Switchable High-Pass Filter » Stereo Couple Function
  » Accurate 8-Segment LED Meters » Servo Balanced I/O
  » Operating Level Switchable from +4dBu to -10dBV

(BEMDX4600) .................................................................................... 149.99

MQX-2310
Stereo 31-Band Graphic Equalizer

  » Dual Channel 31 Band 1/3 Octave Graphic Equalize 
  » Precision Wein-Bridge Filters » Clip Level Indicators
  » Constant-Q Filtering » Variable High-Pass Filters
  » 25mm Center Detent Sliders » Variable Input Level Controls

(ASMQX2310) .................................................................................... 399.00

S-com 4
Four-Channel Compressor/Limiter

  » 4-Channel » Compressor, Limiter, Expader & Gate
  » Trigger Control for Gate/Expander » VCA Operation
  »  Threshold & Release for Each Channel » Auto-Switching 

Smart Knee Detector » Linkable in 2 Stereo Pairs
  » LED Meters for I/O & GR » Servo-Balanced XLR & 1/4" I/O

(SASC4) ............................................................................................ 119.99

320D COMPELLOR
Automated Compressor/Leveler/Limiter

  » Two Channels » Dual mono or stereo operation
  » Digital AES/EBU input and output 
  » 24-Bit/96kHz resolution A/D and D/A converters
  » Intelligent Automated Gain Control

(AP320D) ........................................................................................1,349.00

MINIFBQ FBQ800
 Compact 9-Band Graphic Equalizer

  »  Ultra-Compact 9.5" 
Graphic Equalizer 

  »  Revolutionary FBQ 
Feedback Detection system instantly reveals critical frequencies and 
can also be used as Audio Analyzer

  » Additional Low-cut fi lter removes unwanted frequencies
  » Accurate 6-segment LED input/output meters

(BEFBQ800) ......................................................................................... 69.99

231s Dual Channel
31-Band Graphic Equalizer

  » Dual Channel, 2 x 31-Band
  » 1/3 Octave » Switchable Boost / Cut Range
  » 20mm Sliders » 4-Segment LED Ladders

(DB231S)........................................................................................... 199.95

EQ-341  Dual Channel 15-Band 
2/3 Octave Graphic Equalizer

  » Dual Channel 15-band 2/3 Octave Graphic Equalizer
» 20mm Center Detent Sliders
  » Selectable Boost/Cut Range of 6dB or 12dB
  » Variable Input Level Control » Clip Level Indicators

» Active Balanced and Unbalanced Input and Output Connections

(AREQ351) ......................................................................................... 115.00

COMPRESSORS

EQUALIZERS

PPEQ100
Dual 10-Band Stereo Equalizer

  » Dual 10-Bands EQ with Blue LEDs
  » Four Audio Source Line input » 4 RCA line input
  » 2 RCA line output » Removable Rack Mount Brackets
  » VFD Spectrum Graphic Display Screen

(PYPPEQ100) ....................................................................................... 71.78

RPQ160b
 Parametric Equalizer

  » 4 Bands of Parametric Equalization
  » Great for Room Equalization, Sound Reinforcement
  » Adjustable High and Low Shelving Filters
  »  "T" Filers, Which Avoid the Distortion of State-Variable Filters
  » XLR, 1/4" and RCA Inputs and Outputs

(RORPQ160B) .................................................................................... 160.00

166xs
Compressor/Limiter/Gate

  » Dual Channel » Stereo or Dual-Mono
  » PeakStop Limiter » Classic dbx "Auto" Mode
  » Side Chain Insert » Separate LED Displays

(DB166XS) ......................................................................................... 239.95
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CD RECORDERS / CASSETTE RECORDERS / PLAYERSDIGITAL RECORDERS / EFFECTS PROCESSORS

DN-700R
Network SD and USB Recorder

  »  Web Remote Setup and Control » Automatic or Timed FTP File 
Archiving » IP, RS-232c, GPIO, USB Keyboard Control

  »  Records to SD/SDHC and USB Media » MP3 and WAV at 
 24-Bit/96 kHz Resolution » XLR, RCA, and AES/EBU Audio 
Connections » Switchable XLR/Line with +48V Phantom

(DEDN700R) ...................................................................................... 599.00

UREC7 Professional
Rack-Mountable USB/SD Recording Deck

  » USB Flash Drive / SD Card (up to 32 GB), RCA, 1/8’’ (MP3) Inputs
  » RCA (Line Out) Output » USB 2.0 Compatible
  » Frequency Response: 20Hz-20KHz ±3dB
  » Plays .mp3, .wav, .wma Files from USB Drives and SD Cards
  » 20Hz-20KHz ±3dB Frequency Response

(TEUREC7) ........................................................................................... 64.95

VIRTUALIZER 3D FX2000
3D Multi-Engine Effects

  » 71 Algorithms with true RSM Stereo and 3D Effects
  » Wave-Adaptive Virtual Room Reverb Algorithms
  » Multiple Modulation, Dynamic, Psychoacoustic and EQ Algorithms
  »  11 Effect-Combinations with Selectable Serial / Parallel 
Confi guration » Extensive MIDI Implementation

(BEFX2000) ....................................................................................... 129.99

SDR-4000 Dual Digital
USB / SD Audio Recorder & Player

  » Dual Digital Recording to SD & USB Drive
  » Dual Playback » SD Card Slot & USB Port
  » RCA & XLR Connectors
  » 1/4” Headphone Jack on Front Panel
  » Toggled Output » Slim 1RU Chassis

(VOSDR4000).......................................................................Call or Log-On

MX-200
Multi-Effects Processor 

  » 16 Legendary Lexicon Reverbs » Dual-Processor Design
  » dbx Dynamics » USB "Hardware Plug-In" Feature
  »  Four Routing Confi gurations: Dual Mono, Cascade, Dual Stereo 

(Parallel) and Mono Split » 99 Factory and 99 User Programs
  » MX-Edit Editor / Librarian Software

(LEMX200) ........................................................................................ 199.00

LiveTrak L-12
12-Channel Digital Mixer & Multitrack Recorder 
» Built-In 14-Track SD Recorder
»  USB Audio Interface 

(iOS Compatible)
» 8 Mono + 2 Stereo Inputs
» Channels 1-2 Offer Hi-Z Inputs
» Phantom Power and -26 dB Pad
» 8 Channels of Compression » Channel Strip with 3-Band EQ
» Low-Cut Filter and 16 Digital Effects
» 5 Headphone Outputs with Individual Mix

(ZOZL12) ........................................................................................... 599.99

Built-In 14-Track SD Recorder

Channels 1-2 Offer Hi-Z Inputs
Phantom Power and -26 dB Pad

DP-24SD
Digital Portastudio

  » Record up to 8 Tracks Simultaneously » 19 Faders
  » Records to SD/SDHC Cards
  »  24-Bit/48 kHz 
Resolution

  » Up to 24-Track Playback
  » 8 Combo XLR/TRS Mic Inputs
  » Built-In Mixing & Mastering Effects

(TADP24SD) ....................................................................................... 499.99
DP-32SD 32-Track Digital Portastudio (TADP32SD) ......Call or Log-On

Records to SD/SDHC Cards

Up to 24-Track Playback
8 Combo XLR/TRS Mic Inputs
Built-In Mixing & Mastering Effects

AIRA VT-3
Voice Transformer

  » Real-Time Vocal Processing
  »  Dedicated Pitch and 

Formant Sliders
  » Reverb and Mix Balance Sliders
  »  Three Favorite Settings for Recall
  » Optional Footswitch Connection
  » XLR/TRS Combo Jack with +48V
  » Stereo or Wet / Dry Outputs » Built-In USB Audio Interface

(ROVT3) ............................................................................................ 199.99

Real-Time Vocal Processing

Reverb and Mix Balance Sliders
 Three Favorite Settings for Recall
Optional Footswitch Connection

DP-008EX
8-Track Digital Pocketstudio 

  » Dual Omnidirectional Microphones
  » XLR and 1/4” TS Inputs
  » Mini-USB 2.0 Output
  » Includes 2GB SD Card
  » Records WAV Files at 16-Bit/44.1kHz
  » Onboard Channel, Reverb and Mastering FX
  » Integrated Metronome and Tuner » RCA Stereo Line Output
  » 5.5 Hours of Operation on 4 AA Batteries

(TADP008EX) .......................................................................Call or Log-On

DP-006
6-Track Digital Pocketstudio

  » Dual Omnidirectional Microphones
  » Records WAV Files at 16-Bit/44.1 kHz
  » Two Unbalanced 1/4" TS Inputs
  » Mini-USB 2.0 Output
  »  Integrated Metronome
and Tuner

  » Includes 2GB SD Card
  » 8 Hours of Operation on 4 AA Batteries

(TADP006) ......................................................................................... 129.99

SS-R200
Solid-State Digital Audio Recorder

  » Slim 1RU Chassis » WAV and MP3 Recording
  » Writes to CF, SD/SDHC, and USB
  » Balanced and Unbalanced XLR and RCA I/O
  » Coaxial Digital RCA I/O » PS/2 or USB Keyboard Connection
  » RS-232C and Parallel Control I/O » Multiple Playback Modes

(TASSR200) ....................................................................................... 459.99

8-Track Digital Pocketstudio 

Records WAV Files at 16-Bit/44.1 kHz

8 Hours of Operation on 4 AA Batteries

M350 Dual Engine
Multi-Effects and Reverb Processor

  » Dual Engine Multi-Effects and Reverb Processor
  » 15 Reverbs and 15 Effects with 5 Seconds of Delay
  » Full DAW Integration Through VST / Audio Units Compatible Editor
  » Can Function Both in Dual Send / Return or Serial Patching Setups
  » Tap Tempo Using PedalInput

(TCM350) .......................................................................................... 199.99

Eclipse V4
Multi-Effects Processor

  » Dual Effects Block Architecture » Classic Eventide Effects
  » I/O Ports for Maximum Versatility » Dedicated Tap Button
  » Easy Setup and Operation » Hot Keys » Compact Design
  » Design Your Own Presets » Flash Card Slot

(EVECLIPSE4) .................................................................................1,995.00

KP3+
Dynamic Effects/Sampler

  » Manipulate Effects in Real Time
  » XY Touchpad » 150 Effects
  » 4 Sample Banks
  » 8 Program Memories
  » Hold Function » USB MIDI
  »  Store Samples on SD/SDHC Cards
  » Mac OS X » Windows XP/Vista/7/8

(KOKP3PLUS) .................................................................................... 269.50
mini Kaoss Pad 2S (KOMINIKP2S) ................................................ 150.99

Dynamic Effects/Sampler

Manipulate Effects in Real Time
 150 Effects

 USB MIDI
 Store Samples on SD/SDHC Cards
Mac OS X » Windows XP/Vista/7/8

R8
Digital Recorder/Interface/Controller/Sampler 

  » 8-Track Recorder
  » Writes to SD Cards
  » 16- or 24-Bit WAV fi les
  » Integrated Stereo Mics
  » High-Defi nition USB Interface
  » Full Mixing and Transport Controls
  » 8-Voice Pad Sampler and Sequencer
  » XLR/TRS Combo Inputs with 48V Phantom

(ZOR8) .............................................................................................. 299.99

High-Defi nition USB Interface
Full Mixing and Transport Controls
8-Voice Pad Sampler and Sequencer
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For all CD Recorders 
& Players

SCAN THIS
or visit BandH.com/w15299

DN-300CMKII
CD/Media Player with Tempo Control 1 RU

  » Plays CD & MP3 Files » Includes IR Remote
  » Random, Repeat & Power-on-Play Modes
  » Supports Removable USB Thumb Drive
  » 10-Key Direct Track Access Buttons
  » XLR & RCA Line Outputs » 1U Rack-Mountable

(DEDN300CMKII) ............................................................................... 199.00

CD-RW900MKII
Professional CD Recorder

  » High-Performance AKM Codec » Digital and Analog I/O
  » Gapless Live Recording » Various Track Division Functions
  » 4-Second RAM Buffer Prevents Skipping
  » Auto Start / Stop Record at Preset Level
  » Fade-In / Fade-Out Recording Function

(TACDRW900MK2) ...............................................................Call or Log-On

BD-01U
Rackmount Blu-ray Player

  » Single Rackspace Blu-ray & DVD Player
  » CD, WAV, MP3, WMA, DTS, Dolby Audio
  »  Wired & Wireless Control Options  » VTR Style Front Panel Buttons
  » Ethernet LAN or RS-232C Control   » 1.3x Playback Mode
  » Stereo XLR & RCA Outputs, Optical / Coaxial Digital Audio Outputs

(TABD01U) ...........................................................................Call or Log-On

CD-200
Rack Mount CD Player

  » Plays CDs, MP3 CDs, and WAV CDs » Repeat Function
  » Supports CD TEXT and ID3 Tags » Pitch Control
  » Continue, Random, and Program Modes
  » Optical and Coaxial S/PDIF Output » RCA Outputs
  » Front Panel Headphone Jack » Wireless Remote Included

(TACD200) ...........................................................................Call or Log-On

CD-A580
Cassette, USB & CD Player/Recorder

  »  Shuffl e, Program, All & Single Playback » Cassette Deck, CD 
Player & MP3 Player » Plays Back CDs, Cassettes & MP3s

  »  Record from CD to MP3 & Tape, Tape to MP3 and Line-Input to 
Tape & MP3 » Supports CDs, CD-RWs & Data CDs

(TACDA580) ....................................................................................... 399.99

PMD-300CP
Dual Cassette Deck with USB

  » Convert Tapes to MP3 » Normal and High-Speed Dubbing
  » Dynamic Noise Reduction » Supports Normal and CrO2 Tapes
  » Stereo RCA Inputs and Outputs » USB Output to Computer

(MAPMD300CP) ...................................................................Call or Log-On

PMD-326C
CD/Media Player

  » Plays CDs and MP3 Files » 3.5mm Auxiliary Input
  »  10-Key Direct Track Access Buttons » Supports Removable 

USB Thumb Drives » CD-Text Support » RCA & XLR Outputs
  » Includes Wireless Remote » RCA Cable & Rack Ears Included

(MAPMD326C) ................................................................................... 179.00

TAPE 2 PC USB
Cassette-to-MP3 Converter

  »  Mac/Windows 
Compatible

  » USB 1.1 Connection
  » Dual Cassette Deck
  » Metal / CrO2 Tape Type Selector
  » Converter Software Included » Requires Internet Connection
  » Display Shows Audio Meters and Record and Dubbing Status

(IOTAPE2PC) ...................................................................................... 103.94

PT649D Rack-Mountable
Dual Cassette Player

  » Auto Stop
  » Dynamic Noise Reduction
  »  Normal and High-Speed Dubbing
  » CrO2 Tape Selector » 3-Digit Tape Counter
  » Recording Level Control » Rec/Play Level Meters

(PYPT649D) ......................................................................................... 76.86

Dynamic Noise Reduction

Tape Express+ 
Portable Tape-to-MP3 Converter

  »  Convert Your Cassette 
Tapes to Digital Files

  »  Comes with EZ Vinyl / Tape 
Converter Software

  » Battery-or USB-Powered
  »  Load Music Files to Your Mobile Player
  » 1/8” Audio Output » Plays Chrome or Normal Tapes

(IOTEH) ............................................................................................... 33.94

 Load Music Files to Your Mobile Player

DN-500BDMKII  1RU Professional 
Blu-ray Disc and Media Player

  » Supports Blu-ray, DVD, and CD Discs
  » Control over IR Remote, RS-232C, or IP » OLED Display
  » On-Screen Display Hiding Mode
  » Panel Lock and IR Remote Lock
  » Discrete 7.1 Analog Surround Sound Outs

(DED500BDMKII) ............................................................................... 399.00

DN-300ZB
Media Player

  » Balanced XLR Audio Outputs » Wireless Playback via Bluetooth
  » AM/FM Tuner with Dedicated Audio Output
  » Plays CD-DA, MP3, WAV & AAC Files
  » Supports USB Thumb & HDDs, SD/SDHC Cards
  » Super-Fast Loading, Slot-In CD Player

(DEDN300ZB)..................................................................................... 399.00

CD-200BT
Rackmount CD Player / Bluetooth Receiver 

  »  Bluetooth 3.0 » Register Multiple Bluetooth Devices
  » CD Drive Designed by TEAC » 10-Second Shockproof Memory
  » Plays CDs, CD-Rs, CD-RWs » Plays WAV, MP2, MP3 Data CDs
  » 3.5mm Stereo Aux. Input » Coaxial & Optical Digital Output

(TACD200BT) .......................................................................Call or Log-On

CAS1500
Cassette Player & Recorder 

  » Durable ABS Construction
  » Cassette Playback / Recording
  » Integrated Mic and Speaker
  » 2.5mm/3.5mm Remote Mic Inputs
  » 500mW Amplifi er  » Volume Control
  » Large, Sturdy Buttons
  » Dual 1/4" Headphone Jacks
  » AC or Battery Power

(CACAS1500) ....................................................................................... 59.95

2.5mm/3.5mm Remote Mic Inputs
Volume Control

DN-700R
Network SD and USB Recorder

  » Web Remote Setup and Control
  » Automatic or Timed FTP File Archiving
  » IP, RS-232c, GPIO, USB Keyboard Control
  » MP3 and WAV at 24-Bit/96kHz Resolution
  » XLR, RCA, and AES/EBU Audio Connections

(DEDN700R) ...................................................................................... 599.00
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STUDIO MONITOR ACCESSORIESSTUDIO MONITORS

Brand JBL KRK M-Audio Mackie Neuman Pioneer DJ PreSonus Tannoy Yamaha

Model 308P MkII  Rockit 5 G3 AV42 CR3 KH 120 DM-40BT Eris E5 Reveal 402 HS5

Pair/Single Single Single Pair Pair Single Pair Single Single Single
Woofer Size 8" 5" 4" 3" 5.25" 4" 5.25" 4" 5"

Power Output 56W 50W 20W 50W 160W 2 x 21W 70W 50W 70W
Input Connector XLR, 1/4" XLR, RCA, TRS" RCA, 1/8" 1/4" & 1/8" TRS, RCA XLR 1/8", RCA, Bluetooth XLR, RCA, 1/4" XLR, 1/4", 1/8" XLR, 1/4"
Volume Control No No Yes Yes No Yes No No No
Headphone Jack No No Yes Yes No Yes No No No

Item Code JB308PMKII  KRRP5G3NA MAAV42XUS MA204402900 NEKH120A PIDM40BTB PRERISE5 TAR402 YAHS5

Price 249.00 149.50 149.00 99.99 699.95 199.00 149.95 Call or Log-On 199.99

Brand Adam Alesis Avantone Behringer Focal Fostex Genelec Genelec JBL

Model A7X Elevate 5 MKII MixCube MS40 Shape 65 6301NE  8010 8030C 305P MkII

Pair/Single Single Pair Pair Pair Single Single Single Single Single
Woofer Size 7" 5"   – 4" 6.5" 4" 3" 5" 5"

Power Output 150W 40W 60W 40W 80W 20W 25W 100W 41W
Input Connector XLR, RCA 1/4" XLR, TRS RCA, 1/8”, S/PDIF, Toslink XLR, RCA 1/4" XLR XLR XLR, 1/4"
Volume Control Yes Yes Yes Yes No Yes No No No
Headphone Jack No Yes – Yes No No No No No

Item Code ADA7X ALELEVT5MKII AVABM BEMS40 FOSHAPE65 FO6301NE GE8010AP GE8030CP JB305PMKII

Price 749.99 149.00 479.00 179.99 899.00 259.99 295.00 695.00 149.00

Isolation Pad  for Studio Monitor

This monitor speaker isolation pad is made from high-density acoustic foam that is designed to decouple your monitor’s speaker from its 
resting surface by absorbing the monitor’s vibrations. This stops reverberation through the desk or speaker stands. Removing these unwelcome 
vibrations results in greater depth of fi eld, tighter low-end and transient response, and a higher level of detail across the frequency spectrum.

Small 7.5 x 11.25” 
(AUIPS) ................... 15.00
Medium 10.25 x 14.5” 
(AUIPM) .................. 16.00

Large 12.75 x 12.75” (AUIPL)...17.00

Studio Monitors
Monitoring is one of the most important purchases you can make 
for your studio, and B&H offers a large selection to cater to just 
about every scenario and taste. Choose from a variety of active (self-
powered) or passive (requiring an external amplifi er) monitors with 
woofers ranging from 3 to 8” can be chosen from. Available models 
also provide connectivity for RCA, 1/4”, 1/8” XLR, SpeakOn, or binding 
post sources, with many models providing integrated volume control.
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For all Studio Monitor
Accessories

SCAN THIS
or visit BandH.com/w15301

Monitor Isolation Pads
for Pair of Speakers

Sometimes easy solutions provide benefi ts 
that far outweigh the cost. In this instance, 
isolating one’s monitors from what they are 
standing on, be it speaker stands or the 
meter bridge of a console, can provide an 
instant improvement in bass response 
and stereo imaging.

(AUMPS) ............................................................................................................................................................... 49.99

LMS-355
Studio Monitor Stands

Constructed from steel tubing and a 9” steel plate, these stands are designed 
to support studio monitors at the optimal listening position in professional and 
home recording studios. An ergonomic locking knob secures the stand and a 
locking pin is inserted into six pre-drilled holes to allow the height of each 
monitor to be adjusted between 35 and 58.5”. The three-leg design has a base 
spread of 23” for stability and a geometry that allows for the stand to fi t around 
corners and beside studio furniture. They come with both interchangeable 
rubber feet for hardwood fl oors as well as metal spike feet for carpeted fl oors.

(AULMS335) .......................................................................................................................................................... 79.99

IPRS-M Stabilizing Isolation Pad
for Studio Monitors

  » Steel Plate Prevents Speaker Recoil
  » Non-Slip Neoprene Holds Speaker in Place
  » Prevents Resonant Coupling
  » Greater Detail across Frequency Spectrum
  » Tighter Low-End and Transient Response
  » Greater Depth of Field » Improved Stereo Imaging
  » 3/4" Down-Fire or Up-Fire Profi le » 10.25 x 12.75"

Medium, Single (AUIPRSM) ............................................................................................................................... 69.99

Constructed from steel tubing and a 9” steel plate, these stands are designed 
to support studio monitors at the optimal listening position in professional and 
home recording studios. An ergonomic locking knob secures the stand and a 

monitor to be adjusted between 35 and 58.5”. The three-leg design has a base 
spread of 23” for stability and a geometry that allows for the stand to fi t around 

rubber feet for hardwood fl oors as well as metal spike feet for carpeted fl oors.

 Improved Stereo Imaging

Big Knob Passive
Studio Monitor Controller

  » Two by Two Monitor Controller
  » 2x Sources and 2x Monitor Pairs
  » Classic Big Knob Volume Control
  » Mono, Mute, and Dim Functions
  » Pristine Audio Quality
  » Passive Audio Path » Sturdy Design
  » No Power Supply Needed

(MABKPSMC) ........................................................................................................................................................ 69.99

Big Knob Studio
Monitor Controller and Interface

  » 3x Sources and 2x Monitor Pairs
  » Classic Big Knob Volume Control
  » Independent Trim on All Sources
  » Mono, Mute, and Dim Functions
  » 2x2 USB Recording Interface
  » 24-Bit/192 kHz Recording and Playback
  » Compatible with Windows & Mac Computers
  » Sturdy Design » Includes Tracktion Recording Software

(MABKSMC) ........................................................................................................................................................199.99

ISO-PUCK
Modular Solution for Acoustic Isolation

  » For Monitors, Amplifi ers, DJ Gear & More
  » Portable Solution for Decoupling Needs
  » Provides Isolation and Decoupling
  » Improves Focus & Reduces Image Smearing
  » For Use in Studios & on the Stage
  » Suction Cup Design to Improve Isolation
  » 20 lb Weight Capacity per Puck

Pair (ISOPUCK) .................................................................................................................................................... 59.99

JS-MS70
Studio Monitor Speaker Stands

  » Ideal for use with small studio monitor speakers
  »  The stable low-profi le bases have a triangular shape that can be 

positioned into tight areas
  »  The top platform measures 9" square and has 1mm thick non-slick 

strips to keep your monitor speakers in place
  »  Each stand can be adjusted to 4 different heights for terrifi c customization. 

A locking pin ensures accurate and secure height adjustment

Pair (ULJSMS70) ................................................................................................................................. Call or Log-On

Level Pilot
Analog Stereo Volume Control

  »  Precision Analog Stereo Volume Control at Your Fingertips
  » Stylish Aluminum Construction
  »  Slip-Free Finish and Tight Grip 
Rubberized Bottom Plate

  » Standard XLR Connection
  » No Power Supply Required
  » Quad-Core Cabling for Minimal Clutter

(TCLP) ................................................................................................................................................................... 89.99

 Precision Analog Stereo Volume Control at Your Fingertips
Stylish Aluminum Construction

Moco 
Passive Monitor Controller

  »  Fully Passive Monitor controller for Perfect Control Over 
the Playback Volume of Studio Monitors.

  » 2x Mono Balanced 1/4" TRS Input (input A)
  » 2x Mono Unbalanced RCA Input (input B)
  » Stereo Unbalanced 1/8" Mini Jack Input and Output
  » 2x Mono Balanced XLR Output (output A)
  » Selected High Quality Potentiometer for Passive Volume Control
  » L/R Switch to Swap Left & Right Audio Channels
  » Mono Downmix Button (mixes left to right channel and right to left channel)

(ESESIMCO) .......................................................................................................................................................... 89.95

PMC-II
Passive Monitor Controller

  » Precision Oversized Volume Knob
  » For Professional and Consumer Equipment
  » Passive Design Doesn't Affect Sound
  » Balanced XLR/TRS Combo Inputs
  » Balanced XLR Outputs
  » 1/8" TRS Mini Stereo Inputs & Outputs
  » Mute Button » Mono Button » Durable Steel Housing with Wood Panels

(SEPMCII) ............................................................................................................................................................. 99.95

Selected High Quality Potentiometer for Passive Volume Control
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Professional Audio
Precision-engineered microphones and monitoring 
solutions to accurately capture and reproduce your audio.

The Senal AWS-2000 system 
provides a durable, reliable, and 
lightweight wireless solution for 
ENG, interviews, fi lm production, 
conferences, theater, and more. 
With 1280 tunable frequencies 
across 32 MHz, the AWS-2000 
quickly locks onto a solid channel 
with automatic scan and sync with 
the press of a button. The rugged, 
metal-bodied components can be 
powered by AA batteries or USB 
connection. The system ships with 
batteries, antennas, mounting op-
tions, cables, and a carrying case.

Senal SMH headphones are rapidly becoming the industry standard for audio professionals in the fi eld and in the studio. They 
are ideal for demanding musicians, engineers, and broadcasters who require a wide dynamic range, natural frequency response, 
durability, and comfort. And we have carefully optimized the impedance to work with your mobile device or smartphone. 

SMH Series
T H E  N E W  S TA N D A R D

The Senal AWS-2000P is a plug-on transmitter de-
signed to provide reliable and versatile wireless trans-
mission of any XLR microphone to Senal’s AWS-2000 
advanced wireless microphone system in concerts, 
theater production, houses of worship, ENG, confer-
ences, interviews, and more. The rugged, metal-bodied 
transmitter supplies 48V phantom power over its XLR 
3-pin connector and offers a range of up to 500’ via its 
variable RF power output.

SMH-500
Professional
Studio Headphones
•  Closed-Back, Over-Ear 

Circumaural Design
•  Soft Replaceable Ear Cushions
• Refi ned EQ Curve
• 40mm Neodymium Drivers
• 10' Attached Coiled Cable
•  1/4" Gold-Plated 

Adapter Included
• 3-Year Limited Warranty

#SESMH500 .............................$49.99

SMH-1000
Professional Field and Studio 
Monitor Headphones
•  Closed-Back, Over-Ear 

Circumaural Design
•  Rugged Design for Field & Studio Use
•  Detachable, Twist-Locking Cable Design
•  EQ Curve for Pro Field & Studio
• Collapsible for Easy Storage
•  10' Coiled, 3' Straight Cables Included
• 1/4" Gold-Plated Adapter Included
• 3-Year Limited Warranty

#SESMH1000 .....................................................$74.99

SMH-1010CH/1020CH
Professional Communication 
Headsets

•  Headphone with Neodymium Driver
• Super-Cardioid Gooseneck Microphone
•  Rugged Design for Field & Studio Use
•  Detachable, Twist-Locking Cable Design
•  Interchangeable Cables for Wired and 

Wireless Communication Systems
• Collapsible for Easy Storage
• Rugged Design for Field and Studio
• Soft Replaceable Ear Cushions
• 3-Year Limited Warranty

Single-Sided #SESMH1010CH ..............$179.00

Dual-Sided #SESMH1020CH .................$199.00

SMH-1200
Enhanced Studio Monitor Headphones

•  Closed-Back, Over-Ear Circumaural Design
• 40mm Neodymium Drivers
• Detachable, Twist-Locking, Cable Design
• EQ Curve for Music and Monitoring
• Slightly Boosted Lows for Defi ned Bass
• Refi ned Mids Reveal Recording Details
• Extra Deep Replaceable Ear Cushions
• 10' Coiled and 4' Cable for Mobile Use
• Adjustable Headband & Foldable Design
• 3-Year Limited Warranty

Onyx #SESMH1200OX .........................$149.99
Nautical Blue #SESMH1200BL .......$149.99
Burgundy #SESMH1200BU...............$149.99
Cherry Red #SESMH1200LER .........$149.99

AWS-2000
Advanced Wireless Microphone System

AWS-2000P
Plug-On Transmitter for AWS-2000

AWS-2000P Plug-On Transmitter for AWS-2000
#SEAWS2000PA Frequency Band: A: 522 to 554 MHz . . $249.95
#SEAWS2000PB Frequency Band: B: 554 to 586 MHz . . $249.95

AWS-2000 Wireless System
#SEAWS2000A Frequency Band: A: 522 to 554 MHz . . . $449.95
#SEAWS2000B Frequency Band: B: 554 to 586 MHz . . . $449.95

Professional Audio
Precision-engineered microphones and monitoring 
solutions to accurately capture and reproduce your audio.

Professional AudioProfessional AudioProfessional Audio
Precision-engineered microphones Precision-engineered microphones Precision-engineered microphones 
solutions to accurately solutions to accurately solutions to accurately 

quickly locks onto a solid channel 
with automatic scan and sync with 
the press of a button. The rugged, 
metal-bodied components can be 

connection. The system ships with 
batteries, antennas, mounting op-
tions, cables, and a carrying case.

Advanced Wireless Microphone System

durability, and comfort. And we have carefully optimized the impedance to work with your mobile device or smartphone. durability, and comfort. And we have carefully optimized the impedance to work with your mobile device or smartphone. 

• Super-Cardioid Gooseneck Microphone

•  Detachable, Twist-Locking Cable Design

Onyx
Nautical Blue
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HD 280 Pro
Circumaural Monitor Headphones

  » Dynamic, Closed-Back Design
  » Circumaural / Sound Isolating: -32 dB
  » Leatherette Cushions
  » Swiveling Earcups
  » Padded, Adjustable Headband
  » Frequency Response: 8 Hz to 25 kHz
  » Standard 3.5mm Plug with 1/4" Adapter

(SEHD280PQ) ...................................................................................... 99.95
HD 380 Pro Circumaural Monitoring Headphones (SEHD380P) ...... 149.95 

HD 650
Reference Class Stereo Headphones

  » Open, Dynamic, Circumaural Design
  » Audiophile Sound Reproduction
  » Frequency Response: 10 Hz to 39.5 kHz
  » Acoustic Silk Attenuation
  » Highly Conductive OFC Copper Cable
  » Lightweight Aluminum Voice Coils
  » Works with Portable Audio Devices
  » Compatible w/ SACD, DVD-A & CD Players
  » Includes 1/8 to 1/4" Adapter

(SEHD650) ......................................................................................... 369.00

HN-7506
Headphones

  » Provides High-Noise Isolation
  » Features Sony MDR-7506 Drivers
  »  Reduces Outside Noise 
up to 45 dB

  »  Customized Internal 
Earpiece Baffl ing

  »  Includes Screw-On 
1/4" Adapter

(REHN7506) ..................................... 309.99

Circumaural Monitor Headphones

99.95

HN-7506

SIH 1
Stereo Isolation Headphones

  » For Live Stage and Recorded Music
  » Lightweight Construction
  » Padded Foam Cushions
  »  Reduces Overall Noise Levels 
by 24 dB

  »  Protects Hearing from 
Potential Damage

  » 1/8" Mini-Jack Connector

(VISIH1) .............................................................................................. 69.99

SRH440   Professional
Around-Ear Stereo Headphones

  » Closed-Back Design
  » Foldable Construction
  » Swivel Earcups
  » Replaceable Around-Ear Cushions
  »  Single-Sided Coiled
Detachable Cable

  » 3.5mm Plug with 1/4" Adapter
  » Carrying Bag Included

(SHSRH440) ............................................99.00

K 240 Professional Semi-Open
Stereo Headphones

  » Semi-Open, Circumaural Design
  » Self-Adjusting Headband
  » Patented Varimotion Speakers
  » Thick Around-Ear Cushions
  » Single-Sided Detachable Cable
  » Standard Stereo Mini Plug
  » 1/4” Adapter Included

(AKK240STUDIO) ................................................................................. 69.00 .................................................................................

HPC-A30   Closed-Back 
Studio Monitor Headphones

  » Studio, Field, Mobile & DJ Applications
  » 50mm Drivers » Pivoting Ear Cups
  » Closed-Back for Isolation
  » Collapsible for Easy Storage
  » Padded Adjustable Headband
  » Single-Sided 9.8' Cable
  » Includes 1/4" Adapter
  » Output Optimized for Mobile Devices

(POHPCA30) ........................................................................................ 29.99

KNS 8400 Closed-Back
Around-Ear Stereo Headphones

  » Adjustable, Padded Spring Steel Headband
  » 40mm Neodymium Drivers
  » Thick Around-Ear Cushions
  » Swivel Earcups
  » In-Line Volume Control
  » Detachable Single-Sided OFC Cable
  » Foldable Design, Carrying Case Included 

(KRKNS8400) ............................................ 149.99

SMH-1000 Professional
Field & Studio Monitor Headphones

  » Closed-Back, Over-Ear Circumaural Design
  » Rugged Design for Field and Studio Use
  » EQ Curve For Pro Field and Studio Use
  » Collapsible For Easy Storage
  » Soft Replaceable Ear Cushions
  » 10’ Coiled, 3’ Straight Cables Included
  » 1/4” Gold-Plated Adapter Included

(SESMH1000) .........................................74.99

K92
Closed-Back Studio Headphones

  » 40mm Drivers
  » Over-Ear and Lightweight Design
  » Closed-Back for Maximum Isolation
  » Self-Adjusting Headband
  » 16 Hz to 22 kHz Frequency Response
  » 9.8' Integrated Cable
  » Includes 1/4" Screw-On Adapter

(AKK92)............................................................................................... 59.00

Closed-Back, Over-Ear Circumaural Design

ATH-M50x
Monitor Headphones

  » 45mm Neodymium Drivers
  » Circumaural, Sound-Isolating Design
  » 90-Degree Swiveling Earcups
  » Single-Ear Monitoring
  » Detachable Single-Sided Cable
  » Includes Straight, Coiled & Short Cable
  » Includes Pouch & Screw-On 1/4” Adapter

(AUATHM50XB) .................................................................................. 149.00

MDR-7506
Headphones

  » 40mm Neodymium Drivers
  »  Closed-Ear Design for Clear,

High-Quality Sound Reproduction
  » Swiveling Earcups
  » Single-Sided Cable
  » Coiled Cable
  » Protective Storage Soft Case

(SOMDR7506) ......................................................................Call or Log-On

MDR-V6
Stereo Studio Headphones

  » Closed Earcup Design
  » Around-Ear Cushions
  » Padded, Adjustable Headband
  » 3.5mm Plug with 1/4" Adapter
  »  Flexible Coiled Cable 

with 10' Extensio

(SOMDRV6) ......................................................................................... 98.00

Stereo Studio Headphones

SMH-1200 Enhanced
Studio Monitor Headphones

  »  Closed-Back, Over-Ear
Circumaural Design

  »  Detachable, Twist-Locking, 
Cable Design » EQ Curve

  » Slightly Boosted Lows
  » 40mm Neodymium Drivers
  »  Extra Deep Replaceable 
Ear Cushions

Cherry Red (SESMH1200LER) ......................................................... 149.99

TH-02
Studio Headphones

  » Closed-Back Design
  » Designed for Balanced Response
  » 50mm Drivers
  » 32-Ohm Impedance
  » Collapsible Folding Mechanism
  » Padded Headband and Ear Pads
  » Comes with 1/4" Adapter

(TATH02B) ........................................................................................... 29.48

Stereo Isolation Headphones

99.00

SENAL
AD
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HEADPHONE AMPLIFIERS / DACS / ACCESSORIES

For all Headphone Amps, 
DACS & Accessories
 SCAN THIS
or visit BandH.com/w15335

Powerplay HA8000 V2 Headphone
Mixing & Distribution Amplifi er

  » For Stage and Studio Applications
  » 8 Independent Stereo Amplifi er Sections
  » 2 x Main Stereo Inputs   »  8 Independent Direct Inputs
  » 8-Digit LED Output Meter per Channel
  » Mono/Stereo Switch per Channel
  » TRS Front & Rear Phones Connector

(BEHA8000V2) ................................................................................... 149.99

PM50s
Personal Monitor Amplifi er

  »  Personal monitor amplifi er with 
microphone pass-through

  »  Seperate volume controls for 
monitor feed & microphone input

  » Pair of headphone outputs
  »  Small footprint makes the unit 

easy to use in diffi cult situations

(ROPM50S) .........................................................................Call or Log-On

HP4
Headphone Distribution Amplifi er

  » Four High Power Headphone Outputs
  » Convenient Controls
  »  Separate Volume Control, 

Monitor Mute Switch, 
and Mono Switch

  » Modular Add-On
  » 4 Channels

(PRHP4) ............................................................................................ 129.95

 Separate Volume Control, 

HD-DAC1
32-Bit D/A Converter with Headphone Amp

  »  Optical, Coaxial and 
USB Digital Inputs

  »  192 kHz 24-Bit 
Resolution

  » Native DSD2.8 and DSD5.6 Support
  » Asynchronous Mode    »  CS4398 DAC    »  Jitter Remover
  » Dual Clock    »  Noise Isolation for All Digital Inputs
  » iDevice-Capable Front USB Input

(MAHDDAC1) ..................................................................................... 799.00

HPA-4X2 Reference
Headphone Amp

  » For Pro & Project Studio Applications
  » Durable & Compact Design
  » 1x 1/4” TRS Stereo Input
  » 4 Channels    »  Stereo RCA Inputs
  » 4x 1/4” Stereo Headphone Outputs
  »  Link Feature Daisy-Chains Multiple Units
  » Independent Amp Circuits per Channel    »  Stereo / Mono Switch

(POHPA4X2) ........................................................................................ 39.99
HMA-41 4-Channel Stereo Headphone Amplifi er (POHMA41) .. 29.95

Headphone Amp

 Link Feature Daisy-Chains Multiple Units

Headphone Holder
  » Soft Rubber-Covered Construction
  » Screw Clamp » Slotted Front
  » Fits Tubes up to 30mm in Diameter

(KM16080B) ......................................................................... 19.99

Headphone Holder

 ......................................................................... 19.99

Extra Deep Earpads
  » For Senal SMH-1000 & SMH-500 Headphones

  » For Sony MDR-7506 & MDR-V6 Headphones

Pair (AUEDMDR7506) ......................................... 24.95

Headphone Holder 
with Padded Cradle

  » Holds One Pair of Full-Sized Headphones
  » For Horizontal and Vertical Surfaces

(AUCOHH1) .......................................................................................... 19.99

Universal Headphone Case
  »  Rigid EVA Plastic Molding, Soft Interior Nylon 

Fabric, Abrasion-Resistant Nylon Shell

(AUUHC725) ......................................................... 19.95

19.99

1/4” Stereo Adapter
Screw-On

  » Male 1/8 to Male 1/4” » Gold-Plated Construction

(PEAMPS3S)............................................................................2.99

D1 
24-Bit Digital to Analog Converter

  »  High-Quality 24-Bit 
192 kHz Audio

  »  Digital USB and 
Optical Inputs

  » Headphone Preamp
  »  Mac or Windows 

Compatible

(AUD1Q) ............................................................................................ 169.00

E10K 
DAC Headphone Amplifi er

  » Handles PCM Files up to 24-Bit/96 kHz
  » Front Panel 1/8” Headphone Output
  » Selectable Bass Boost
  » Coaxial Digital Output
  » Micro-USB Connector
  » 1/8” Line Output
  » Bus Powered

(FIE10K) .............................................................................................. 75.99

PHA40
Stereo Headphone Amplifi er

  » Compact and :ightweight Design
  »  Up to 4 Users to Listen to the 

Same Audio Signal 
  » 4 Channels
  » 1/4” Stereo Jacks
  » Individual Level Controls
  » Power LED    »  Power Supply Included

(PYPHA40) ........................................................................................... 16.58

Compact and :ightweight Design
 Up to 4 Users to Listen to the 

Power Supply Included

HeadAmp4
Stereo Headphone Amplifi er

  » High-Quality Headphone Amplifi er
  » Stackable Metal Construction
  »  4 Channels, With Up To Two 

Users per Channel 
  »  Both 1/4” and 1/8” Connectors 

Are Available for All I/Os 
  » Four Level Control Knobs on the Front Panel

(ARHEADAMP4) ................................................................................... 65.00

High-Quality Headphone Amplifi er

ADI-2 Pro
Reference AD/DA Converter with Extreme 
Power Headphone Amplifi ers

  »  High-Fidelity
32-Bit/768 kHz
Audio

  »  2-Channel A/D, 4-Channel D/A Converter
  » 2 x Extreme Power Headphone Outputs
  » PCM/DSD Record/Playback » SteadyClock III Technology

(RMADI2PRO) .................................................................................1,999.00

m900
Compact, Portable Headphone Amp, DAC, 
and Preamp

  »  Digital Inputs: USB, S/PDIF, TOSLINK
  »  Supports up to 192 kHz

(TOSLINK: 96 kHz)
  »  Two 0 Ω Headphone Outputs
  » Stereo RCA: Monitoring Control
  » High and Low Power Modes
  » DAC Filter Settings for Custom Playback

(GRA900) ........................................................................................... 499.00

HA-400
Headphone Amplifi er

  » 4 Independent Stereo Outputs
  » Level Control Per Channel
  » Ultra Compact
  » Power On LED
  »  DC 12V Adapter 
Included

(BEHA400) ........................................................................................... 24.99

Headphone Amplifi er

4 Independent Stereo Outputs
Level Control Per Channel

Storage Pouch  for SMH
Series Headphones

  » For Safe Storage and Transport
  » High-Quality Leatherette Material

(SESMHPOUCH) ......................................................................................9.99

Digital Inputs: USB, S/PDIF, TOSLINK

AUDIO INTERFACES 
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U-PHORIA UMC404HD
USB 2.0 Audio/MIDI Interface

  » 4 Input/4 Output » MIDAS-Designed Microphone Preamps
  » 48V Phantom Power » 24-Bit/192 kHz
  » Headphone Out, Zero-Latency Monitoring
  » Analog Inserts and MIDI I/O » Status, Signal and Clip LEDs

(BEUMC404HD) ................................................................................... 99.99

AUDIO INTERFACES 

USBPre 2
Microphone Interface for Computer 

  » 2 Channel USB Interface
»  Precision Mic Preamps 

with 48V Phantom
Limiters, High-Pass 
Filters, and 15dB Pad

  » Dynamic Range Greater Than 114dB
  » Flat 10Hz to 40kHz (@96kHz SR) Audio Bandwidth

(SOUSBPRE2) .................................................................................... 895.00

MOTIV MVi
Digital Audio Interface

  »  For Mac, Windows, iPhone, 
iPod, iPad, and Android

  » Single-Channel Class-A Preamp
  » XLR + 1/4" Combo Input »  5 DSP Presets
  »  Phantom Power »  Touch-Panel Control »   Headphone Output
  » 24-Bit/48 kHz »  Micro-USB Type-B to USB Cable
  » Micro-USB Type-B to Lightning Cable

(SHMVIALTG) ..................................................................................... 129.00

Komplete Audio 6
USB 2.0 Digital Audio Interface

  » 6 Input / 6 Output
  » 2 Microphone Preamps
  » MIDI I/O
  » S/PDIF I/O
  » Phantom Power
  » Zero Latency Direct Monitoring
  » Includes Software

(NAKA6) ............................................................................................ 229.00

XU-1648
XLR to USB Interface

  » XLR Input to USB Output
  » Microphone Input Level Adjustment
  » Switchable 48V Phantom Power
  » Monitoring with Balance Adjustment
  » 1/8” Headphone Output with Level Control
  » Zero-Latency Monitoring » Peak Level Indicator
  » Rugged Metal Chassis » USB Cable Included

(SEU1648) ........................................................................................... 89.00

1/8” Headphone Output with Level Control
Peak Level Indicator

USB Cable Included

iXZ
Mic & Instrument Interface

  » Switchable Mic / Line Input
  »  Phantom Power for
Condenser Mics

  » XLR Mic Input & Gain Control
  » High-Impedance Guitar Input
  » Headphone 1/8" Output for Monitoring
  » Mic Input Powered by 2 AA Batteries » Non-Powered Guitar

(TAIXZ) ................................................................................Call or Log-On

Switchable Mic / Line Input

XLR Mic Input & Gain Control

Studio 68
6x6 192 kHz, USB 2.0 Audio/MIDI Interface

  »  For Musicians, 
DJs, Engineers, 
Producers

  » USB 2.0 Recording System » Four XMAX-L Solid-State Mic Preamps
  » 24-Bit/192 kHz » 4 Analog Inputs and 6 Analog Outputs
  » Headphone Cue Mix: Toggles A/B Mixes » Direct Monitoring
  »  Breakout Cable: MIDI I/O and S/PDIF I/O » Mac and Windows 
Compatible » Studio One Artist Included

(PRSTUDIO68) ................................................................................... 299.95

XLR-USB-48
XLR to USB Audio Interface

  » Connects XLR Mic to USB
  » Selectable 48V Phantom Power
  »  Plug-and-Play with 

No Drivers Needed
  »  1/8" Headphone Output 

with Level Control
  » USB Cable Included

(POXLRUSB48) .................................................................................... 44.99

AudioFuse
14x14 Audio Interface

  » 14 Inputs and 14 Outputs
  » Two Line/Instrument Inputs
  » Two Analog Inserts
  » ADAT, S/PDIF, and Wordclock
  » Two Phono RIAA Preamps with Ground
  » Two DiscretePRO Microphone Preamps
  » 24-Bit / 192 kHz » 3-Port USB Hub
  » PC, Mac, iOS, Android, and Linux

Gray (ARAFSG) ................................................................................. 599.00

U-PHORIA UMC22
2x2 USB Audio Interface

  » Up to 48 kHz Sampling Rate
  » Midas-Designed Mic Preamp
  »  Front Panel Combo 
XLR/TRS & 1/4" Inputs

  » Dual 1/4" Outputs
  » Selectable Direct Monitoring
  » Metal Chassis » DAW Software Download with Registration

(BEUMC22) .......................................................................................... 39.99

Studio 1810
18x8 USB 2.0 Audio Interface

  » High-Speed USB 2.0 Computer Interface » 24-Bit / 192 kHz
  » 2x Mic/Instrument/Line Inputs » 2x Mic/Line Inputs
  » XMAX Microphone Preamps » 8x Channels of ADAT I/O
  »  6x 1/4" TRS Bal. Outputs » MIDI & SPDIF I/O + BNC Wordclock Out

(PRSTUDIO1810) ............................................................................... 399.95
STUDIO 1824 (PRSTUDIO1824) ....................................................... 499.95

AudioBox 96
USB 2.0 Audio Recording Interface

  » 2 Input / 2 Output
  » 2 Mic/Line Combo Inputs
  » Phantom Power
  »  Zero-Latency Monitoring 

via Mix Knob
  » Portable » 24-Bit/96 kHz » Studio One 3 Artist Software
  » 1/4" TRS Headphone and Main Outputs

(PRABU96) .......................................................................................... 99.95
AudioBox 96 Studio Kit (PRAUDIOBOX96) .................................... 199.95

AudioFuse

Two Phono RIAA Preamps with Ground
Two DiscretePRO Microphone Preamps

iRig Pre
Microphone Interface

  »  Connect Any Type of Mic to 
iOS Device

  »  Compatible with iPhone
iPod Touch/iPad

  » 3.5mm Headphone Output for Monitoring
  » Built-In Connector Cable
  » Gain Control
  » Includes 2 Free Apps

(IKIRIGPRE)......................................................................................... 39.99

M-Track 2X2M
USB 2.0 Interface with MIDI I/O

  » 24-Bit / 192 kHz
  »  Headphone Output 

with Dedicated Volume
  »  Direct/USB Knob 

for Low-Latency
  » 2 x Combination 1/4"/XLR Jacks
  » 2 x Instrument Jacks » 2 x 1/4" Monitor Outputs
  » 5-Pin MIDI Input & Output » Mac & Windows Compatible

(MAMTRACK2X2M) ............................................................................ 149.00

2 x Combination 1/4"/XLR Jacks

U-PHORIA UM2
2x2 USB Audio Interface

  » Up to 48kHz Sampling Rate
  » XENYX Mic Preamp with 48V
  » Stereo RCA Outputs
  » Selectable Direct Monitoring
  » Front Panel Combo XLR/TRS Mic/Line Input
  » DAW Software Download with Registration
  » 1/4" Headphone Output » Front Panel 1/4" Instrument Input

(BEUM2).............................................................................................. 29.99
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Clarett 2Pre
USB 10x4 USB Audio Interface

  »  2 Preamps Model the 
Classic ISA Design

  »  Low-Noise and Low-
Distortion Mic Preamps

  » 24-Bit / 192 kHz Audio Resolution » Low-Latency Monitoring
  » 2 Monitor Outputs, 2 Line Outputs » USB, MIDI I/O, ADAT Input
  » Gain Halo Meters » One Headphone Output
  » Includes Software Bundle » Mac, Windows

(FO2PREUSB) ..........................399.99   Other Confi gurations Available

4pre Compact
Hybrid FireWire/USB Audio Interface

  » 4 Microphone Preamps
  » 6 Inputs / 8 Outputs
  » 8-Bus Digital Mixer
  » Digital I/O
  » Phantom Power
  » Time Code Support » 24-Bit / 96kHz
  » Standalone Operation » Mac OS X » Windows Vista/7

(MA4PRE).......................................................................................... 449.00

828mk3 Hybrid
FireWire, USB2 Audio Interface

  » 28 Inputs / 30 Outputs » Hybrid FireWire/USB2 Connectivity
  » Dual Microphone Preamps » Phantom Power, Pad & Trim per Preamp
  » Multiple CueMix FX Mixes » Sample Accurate MIDI
  » Clip Protection » Standalone Operation » Mac OS X
  » Windows XP/Vista/7

(MA828MK3H) ................................................................................... 729.00

iD44
20-Input/24-Output Audio Interface

  »  4x Class-A Preamp and
 2x JFET Instrument

  »  Pro-Quality 24-Bit/96 kHz
ADA Converters

  » Low Latency DSP Mixer
  » 2 Independent Headphone Output
  » Monitoring Hardware Control
  » 2x ADAT Digital I/O Expansion

(MA828MK3H) ................................................................................... 729.00

UltraLite-mk 4
18x22 USB Audio Interface with DSP

  » 192 kHz/24-Bit Recording
  »  18 Inputs, 22 

Outputs
  »  8 Analog Audio 

Inputs & Outputs
  » 8 Line Outputs, Main Outs & Headphones
  » S/PDIF, Optical, MIDI I/O » Onboard 32-Bit DSP
  » 48-Channel Mixer with Onboard Metering

(MAULMK4) ....................................................................................... 595.00

iTrack Solo (Lightning) USB 2.0 
Audio Interface for Compatible iPad, Mac, PC
  »  2 Inputs/2 Outputs
  » Microphone Preamplifi er
  »  XLR/TS Microphone/

Instrument Input
  » RCA Unbalanced Monitor Outputs
  »  Direct Monitor Switch, LED Signal Halos » Up to 24-bit/96 kHz 

Audio Resolution » Ableton Live Lite Software
  » Focusrite Scarlett Plug-In Editing Suite » Mac OS X, Windows 7

(FOMOIS0010) ................................................................................... 119.99

Arrow
2x4 Thunderbolt 3 Audio Interface

  » High-Speed Thunderbolt 3 Interface
  » Unison Mic Preamps
  » 192 kHz / 24-Bit
  » 2x Combination XLR-1/4" Inputs
  » 1/4" Instrument Inputs
  » 2x 1/4" Monitor Outputs
  »  1/4" Headphone Output » Bus Powered 
over Thunderbolt 3 » Near-Zero Latency Performance

(UNARROW) ...................................................................................... 499.00

Babyface Pro
USB Bus-Powered Audio Interface

  » 12 Analog Inputs, 12 Analog Outputs
  » 3.5mm and 6.3mm Headphone Outputs
  » TOSLINK I/O » FPGA Chip for DSP
  » Integrated XLR Socket
  » SteadyClock Jitter Reduction

» MIDI I/O via Included Breakout Cable
  » Class Compliant for Mac, PC, Linux, iPad

(RMBFP) ........................................................................................... 749.00

12 Analog Inputs, 12 Analog Outputs
3.5mm and 6.3mm Headphone Outputs

FPGA Chip for DSP

MIDI I/O via Included Breakout Cable
Class Compliant for Mac, PC, Linux, iPad

VRS8 8-Channel Interface 
with Included Software

  »  8-Channel Interface with Linear Response » 124 dB Dynamic 
Range » Offers 0.7 ms Latency across Platforms

  » AKM AK5578 Converter Chips » XTC Clocking
  »  Preamp & Microphone Emulations » Included 1-Year Everything 

Bundle » Software Compatible with Mac & Windows
  » Operates in VST, AU & AAX Formats

(SLSDVRS8101) ..............................................................................1,999.00

AI-1
Studio-Quality USB Audio Interface

  » USB-C Audio Interface
  » 96 kHz / 24-Bit
  »  Premium Discrete Headphone 
Amplifi er » Single Combo XLR-1/4" Input

  » Phantom Power for Condenser Microphones
  » Two 1/4" Monitor Outputs » Zero-Latency Monitoring
  » Includes Ableton Live Lite
  » Includes USB Cable

(ROAI1) ............................................................................................. 129.00

UR22mkII USB 2.0 Audio 
Interface with Dual Microphone Preamps

  » 2-Inputs / 2-Outputs
  »  D-PRE Mic Preamps

with Phantom Power
  » MIDI I/O
  » 24-Bit/192 kHz
  »  Latency-Free Hardware Monitoring
  » Loopback Function » Mac OS X, Windows

(STUR22MKII).................................................................................... 149.99

Element 46  12x14 Thunderbolt
Audio I/O Box for Mac

  »  High-Quality 
AD/DA Conversion

  » 24-Bit / 192 kHz
  »  Boutique-Quality 

Microphone Preamps
  » 4x Analog Inputs & 6x Analog Outputs
  »  Wordclock Input and Output » Thunderbolt Connection to 

Mac » Includes Apogee Control Software

(APELEMENT46) ................................................................................ 895.00

Duet  USB Audio Interface for iPad, 
Mac & Windows 10

  »  2 Inputs / 4 Outputs
  » 2 High-Gain Microphone Preamps
  » Phantom Power
  » Soft Limit
  » Full Color OLED Screen
  » Multi-Function Controller Knob
  » Maestro 2 Software for Mac and iOS
  » Includes PC-Compatible Maestro Software

(APDUETMACIOS) .............................................................................. 595.00

Microphone Preamps

Rubix22
2x2 USB Audio Interface

  » 2 Inputs / 2 Outputs
  »  2 Low-Noise Mic Preamps, 

48V Phantom
  » Hi-Z Input for Guitar
  » 24-Bit/192 kHz Resolution
  » Powered via USB » Includes Ableton Live Lite
  » MIDI I/Os » Mac OS, Windows, iPad Compatible

(RORUBIX22) ..................................................................................... 149.99
Rubix24 2x4 USB Audio Interface (RORUBIX24) ........................... 199.99

2x2 USB Audio Interface

Scarlett 2i2
USB Audio Interface (2nd Generation)

  »  2 Scarlett Inputs and
2 Outputs

  » Powered via USB
  » Line/Instrument Switches » Independent Headphone Output
  » 48V Phantom Power » 24-Bit/192 kHz » Direct Monitoring
  » Included Internal Mixer Software » Included Software Bundle

(FOS2I22G) ........................................................................................ 149.99
Scarlett 2i2 with Recording Accessories Kit (FOS2I2K2) ........ 249.95

High-Speed Thunderbolt 3 Interface

RCA Unbalanced Monitor Outputs

2 Independent Headphone Output

KEYBOARD CONTROLLERS
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Brand Model # of
Keys

Keyboard
Type Aftertouch Arpegiator Rotary 

Encoders Faders Includes 
Software Grid Button 

Encoders Pads Transport iOS
Dock

CV/
Gate

MIDI
I/O SKU Price

Acorn Instruments Masterkey 61 61 Synth Action ✓ ✓ ✓ ✓ (ACMK61) 99.00

Alesis Vortex Wireless 37 Synth Action (ALVORTEXWIR2 ) 299.00

Akai MPK mini MKII 25 Synth Action ✓ ✓  ✓ ✓  ✓ (AKMPKMINIWHI) 99.00

Akai LPK25 25 Synth Action ✓ (AKLPK25) Log-On

Akai MPK mini 2 25 Synth Action ✓ ✓ ✓ (AKMPKMINI2) 99.00

Akai APC Key 25  25 Synth Action ✓ ✓ ✓ (AKAPCKEY25) Log-On

Alesis V25 25 Synth Action ✓ ✓ ✓ (ALV25) 89.00

Arturia Key Step 32 Slim Key ✓ ✓ (ARKSCS) 119.00

Arturia MiniLab Mk II 25 Synth Action ✓ ✓ ✓ ✓ ✓ (ARMINILABMK2) 99.00

CME Xkey37 LE 37 Velocity-Sensitive ✓ ✓ (CMXKEY37LE) 179.00

CME Xkey-Silver 25 Synth Action ✓ (CMXKEYS) 99.00

IK Multimedia iRig KEYS Pro 37 37 Synth Action ✓ ✓ (IKIRIGKEYPRI) 149.99

Kawai VPC1 88 Hammer Action ✓ (KAVPC1) 1,849.00

Keith McMillen QuNexus  25 Smart Senso ✓ ✓ (KEK708) 179.00

Keith McMillen K-Board Pro 4 48 Smart Sensor ✓ ✓ (KEK919) 599.00

Korg naoKEY Studio 25 Push Button ✓ ✓ ✓ ✓ (KONANOKEYST) 149.99

M-Audio Keystation Mini 32 II  32 Synth Action ✓ ✓ ✓ (MAKSMI32) 49.00

M-Audio Keystation 49 II 49 Weighted ✓ ✓ (MAKEYSTATION) 99.00

M-Audio Keystation 88 II 88 Semi-Weighted ✓ ✓ (MAKS88) Log-On

M-Audio Oxygen 25 IV 25 Synth Action ✓ ✓ ✓ (MAOG25) 119.00

M-Audio Oxygen 49 IV 49 Synth Action ✓ ✓ ✓ (MAOG49) Log-On

Native Instruments Koplete Kontrol S61 25 Synth Action ✓ ✓  ✓ ✓ ✓ (NA24797) 699.00

Native Instruments Koplete Kontrol S88 88 Hammer Action ✓  ✓ ✓ (NA23588) 999.00

Nektar Technology GX49 49 Synth Action ✓ ✓ ✓ (NEGX49) 89.99

Nektar Technology Impact LX25 25 Synth Action ✓ ✓ ✓ ✓ (NEIMPACTLX25) 99.99

Nektar Technology Panorama P6 61 Semi-Weighted ✓ ✓ ✓ ✓ ✓ (NEPANORAMAP6) 599.99

Novation Launchkey MK2 49 49 Synth Action ✓ ✓ ✓ ✓ ✓ (NOLNCKY49MK2) 199.99

Novation Launchkey-Mini MK2 25 Synth Action ✓ ✓ ✓ (NOLNCHKYMNK2) 99.99

Roli Seaboard Block  25 Keywave ✓ ✓ (ROL001142) 799.00

Roli Seaboard RISE 49 49 Keywave ✓ ✓ (ROSBRISE49) 1,099.05

StudioLogic SL73 73 Hammer Action ✓ (STSL73STUDIO) 499.95

Keyboard Controllers
B&H stocks a wide variety of keyboard controllers for hands-on con-
trol of your virtual instruments or external synth hardware. Available in 
25 to 88 key  variations, with keybeds ranging from synth action (spring 
loaded) to semi-weighted / weighted, many models also feature rotary 
and button encoders, faders, transports controls, and pads. MIDI I/O 
ranges from traditional 5-pin DIN connections to USB.
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Push 2
USB Software Controller

  »  Completely Redesigned 
Hardware Interface

  »  11 Touch-Sensitive 
Encoders

  » Live 9 Intro Software
  » 64 Velocity- and Pressure-Sensitive Pads
  » 2 Assignable Footswitch Inputs » Mac & Windows

(ABAP2USBSWC) ............................................................................... 799.00

64 Velocity- and Pressure-Sensitive Pads

Touché MIDI / CV  
USB Control Surface with Lié Software 

  »  Expressive and Intuitive Controller
  » 4 x Independent Expression Shifting
  » Force Feedback and Sensitivity Settings
  » 4 CV/Gate Outputs + MIDI Input & Output
  » Confi gurable CV Signal Curve
  » Confi gurable MIDI CC Messages
  » Lié Software - Editor & Preset Manager
  » Includes UVI Workstation Plug-In

(EXXPETOUCHE1) ............................................................................... 399.00

BeatStep Pro
MIDI/Analog Controller and Sequencer
  »  16x Projects with 
16x2 Melodic 
Sequences

  »  16x Drum Sequences 
& Controller Maps

  » 16x Touch-Sensitive Rotary Encoders
  »  16x MIDI Controller & Sequencer Presets
  »  16x Velocity- and Pressure-Sensitive Pads

(ARBSP) ..............................................................................Call or Log-On
Beatstep Controller & Sequencer (ARBEATSTEP) ........Call or Log-On

Pro Tools Dock  EUCON Control 
Surface for Integrating with iPad

  »  16 Soft Keys
  » 8 Soft Knobs
  » 2 Touch Strips
  » Jog Wheel
  » Channel Fader
  » Transport Controls
  » Uses Free iOS App (iPad Not Included)
  » Compatible with Avid S3 or Artist Mix Keys

(AVPTD)............................................................................................. 995.00

Artist Mix
Touch-Sensitive Fader Control Surface

  »  8 Touch-Sensitive
Motorized Faders

  »  8 Touch-
Sensitive Rotary Encoders

  » 8 Knob Select/On Keys
  » Solo/Mute/Transport Keys   »  Record/Automation Keys
  » 8 OLED Displays   »  Footswitch Jack

(AVMCMIX) ........................................................................................ 995.00

Sensitive Rotary Encoders
8 Knob Select/On Keys

nanoKONTROL2
Slim-Line USB MIDI Controller

  » 8 Faders
  » 8 Knobs
  » 24 Switches
  » Transport Controls
  » Marker, Cycle, Track Buttons
  » iPad Support » Software Instrument Licenses
  » Mac OS X, Windows XP/Vista/7

(KONKC2B) .......................................................................................... 59.99

Launchpad MK2
Ableton Live Controller

  » 64x RGB Backlit Pads
  » USB Bus Powered
  »  Pads Match the Color
of Your Clips

  » Start and Stop Loops, Arm Tracks
  » Control Volume, Pans, and Sends
  » Includes 1GB of Loopmasters Samples
  » Novation Bass Station and VST/AU Plug-In

(NOLAUNCHPAD2) ...............................................................Call or Log-On

VRS8 Interface
with ML-1 Micr ophone - Virtual 

Recording Studio with Included Softwar

  »  8-Channel Interface with Linear Response
  » 124 dB Dynamic Range   »  Included ML-1 Microphone
  » Cardioid Polar Pattern   »  Flat & Linear Response
  » Latency of 0.7 ms Across Platforms   »  Mac & Windows Compatible

(SLSDVRS8102) ..............................................................................2,499.00

Start and Stop Loops, Arm Tracks
Control Volume, Pans, and Sends

Maschine Jam
Production and Performance System
  » 8x8 Multicolor Click-Pad Matrix
  »  Note Input, Step Sequencer,
Pattern Jam   »  Sequence 8 Sounds
Simultaneously   »  Eight Dual-Touch
Smart Strips   »  Play Melodies
and Chords   »  One-Touch Pattern
and Scene Sequencing   »  Over 8GB of Maschine Library Content

  » Komplete 11 Select with 25GB of Content

(NAMJ) ............................................................................................. 399.00

Console 1 MKII
Hardware & Software Mixer with Integrated

  » Works with UAD Plug-Ins
  »  Controls Apollo Console 

Software   »  Works with 
Softube Plug-Ins

  »  Analog Modeling and 
Hands-On Control   »  Emulated SSL 4000 E-Series Channel Strip

  » Improved LEDs over Original   »  AAX, VST, AU Plug-In Formats
  » Mac & Windows Compatible

(SOCNSOLE1MK2) ............................................................................. 499.00

Faderport 8
Mix Production Controller

  » 8 Touch-Sensitive & Motorized Faders
  » Eight High-Defi nition Scribble Scripts
  » General Session and Transport Controls
  » Marker Creation and Navigation
  » Session Navigation
  » Channel and Automation Controls
  » Footswitch Input   »  Native Studio One Support
  » Emulates HUI & Mackie Control Universal
  » Mac OS X and Windows with USB 2.0

(PRFP8) ............................................................................................ 499.95

APC40 mkII Ableton Live 
Performance Controller 

  » Perfect Integration with Ableton Live
  » 5 x 8 Clip-Launch Matrix
  » 9 Faders
  » 8 Control Knobs
  » Assignable A/B Crossfader
  »  Downloadable Music 

Creation Software
  » Mac OS X   »  Windows

(AKAPC40MK2) .................................................................................. 299.00

X-TOUCH
Universal Control Surface

  » HUI & Mackie Control Protocols
  » Hands-On DAW Control
  » 8 LCD Scribble Strips
  »  9 Touch-Sensitive 

100mm Motorized Faders
  » 92 Dedicated Illuminated Buttons

(BEXTOUCH) ...................................................................................... 449.99
X-Touch Compact (BEXTOUCHC) .................................................... 299.99
X-Touch Mini (BEXTOUCHM) ............................................................. 49.99

HUI & Mackie Control Protocols

92 Dedicated Illuminated Buttons

Lightpad Block M  Wireless 
Illuminated Tactile Control Surface

  » Versatile "Space-Age" Touch Controller
  » Grid Modes: 2x2, 4x4 & 5x5
  » Redesigned Surface
  »  Five Dimensions of 

Touch (5D Touch)
  » Strike, Glide, Slide, Press & Lift
  »  Wireless MIDI over Bluetooth   »  Record and Perform Drum and 

Melody Loops   »  Add Live and Loop Blocks for Control
(ROL001591) ..................................................................................... 199.95

Versatile "Space-Age" Touch Controller

Strike, Glide, Slide, Press & Lift

MPC Studio
Music Production Controller

  » Integrated Hardware/Software System
  » Classic MPC Hardware Controls
  »  16 Velocity- and Touch-Sensitive 

MPC Pads
  » 4 Touch-Sensitive Knobs
  » Compact Design & USB Bus Powered
  » 128-Track Sequencing
  » 7GB+ Sound Library
  » Mac / Windows Compatibility

Black (AKMPCSTUDIOB) .................................................................. 399.00

Compact Design & USB Bus Powered

Uses Free iOS App (iPad Not Included)

4 CV/Gate Outputs + MIDI Input & Output

MUSIC SOFTWARE
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For a full listing of all
Music Software

SCAN THIS
or visit BandH.com/w15296

MUSIC SOFTWARE

Music Production Software
If you’re going to create, compose, program, mix, or master music on a com-
puter, you’ll need music production software. Any piece of said software is usu-
ally referred to as a DAW (digital audio workstation), and different DAWs have 
different inherent usages. One might be more suited for the recording, mixing, 
and editing processes (think Avid Pro Tools or Steinberg Cubase), while another 
might be more geared towards the manipulation and instantaneous creation of 
electronic music, either for live performances or for programmatic recordings 
(Ableton Live and Propellerhead’s Reason come to mind). Others still are often 
used in the composing and mixing of fi lm (Motu’s Digital Performer). Whether 
you choose to use the aforementioned DAWs or something like FL Studio or Bit-
wig Studio, the decision is ultimately a personal one; whichever DAW you utilize 
will shape your workfl ow, enable certain parameters while curtailing others, 
and affect your overall creative output. So make sure the DAW you go with gives 
you what you want in terms of track count, rewire capability, MIDI import/export 
options, hardware connectivity (MIDI and analog), and system compatibility.

Virtual Processor Plug-Ins
For equalizers, check out the FabFilter Pro Q 2, which is a linear phase EQ plug-in with 
mid capabilities, 24 assignable bands, an intuitive interface, and a bevy of bells and whis-
tles. As for dynamics processors, B&H has a virtual ton of bundles (Waves, UAD, and 
McDSP are all excellent) and single downloads to boot (The elysia mpressor and alpha 
compressor come to mind, as do the Pro C, Pro L, and Pro MB from FabFilter). To intro-
duce some dirt, grit, and character into your signal, try out a channel strip for a vintage 
combination of EQ and compression; the BOZ DIGITAL +10 db and Softube Tube-Tech 
Classic Channel are both excellent for this purpose. 

Onto the ambiance: Waves and UAD have several reverb modules, the Lexicon PCM Native 
Reverb Bundle, which gives you seven models of classic Lexicon digital verbs. Your DAW’s 
onboard delay will usually add the space that echo can provide, but if character is your 
goal, check out Waves’ H-Delay and Boz Digital Lab’s Imperial Delay, both of which have 
extended features to mangle up your signal in a most pleasing manner. 

For pitch correction, try the Melodyne 4—the only plug-in to be name-dropped in a pop 
song. Guitar amplifi er/cabinet emulations are also worth pursuing: IK Multimedia’s Am-
pliTube and Positive Grid’s BIAS are great places to start. 

Virtual Instrument Plug-Ins
If you are working under a budget and your track requires an analog-style syn-
thesizer or symphony orchestra, you’ll want to stock up on virtual instruments. 
Native Instruments has products to suit any occasion, most notably within their 
Kontakt engine, which can trigger orchestral libraries from developers such as 
Spitfi re Audio, Chris Hein, and more. Moreover, their Massive synth gives you 
both micro and macro control over sounds for EDM, hip hop, and other genres. 
Kontakt, Massive, and many more are available in their Komplete bundle. Also, 
be sure to check out Spectrasonic’s Omnisphere 2 and KV331 Audio’s Synth-
Master, both of which give you an array of cinematic sounds. For the analog 
purists out there, u-he has quite a few vintage synth recreations, including ACE, 
Bazille, and Diva. If it’s a comprehensive slate of bass timbres you’re after, Spec-
trasonic’s Trillian more than fi ts the bill. Finally, for drum programming, we car-
ry FXpansion’s BFD and Geist, the former being a superstar for acoustic drum 
triggering, the latter giving you a prime selection of sampled hits.
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Kaossilator Pro+ Dynamic Phrase
Synthesizer/Loop Recorder

  » Freely Playable Synthesizer
  »  XY Touchpad » Play Notes 

Manipulate Sound in Real Time
  » Gate Arpeggiator » USB MIDI
  » 4 Infi nitely Stackable Loop Banks
  » 250 Sounds » Choice of 35 Scales
  » Mac OS X » Windows XP/Vista/7/8

(KOKOPP) .......................................................................................... 275.00
MINI Kaoss Pad 2S (KOMINIKP2S)...................................Call or Log-On

volca sample
Digital Sample Sequencer

  »  Edit and Sequence up to 
100 Samples

  » 16 Step-Keys
  » Motion Sequencer
  »  Active Step and Step 

Jump Functions
  » Reverse Function » MIDI In
  » Built-In Speaker » Battery Powered

(KOVOLCASMPLE).............................................................................. 169.99

Synthesizer/Loop Recorder

 Choice of 35 Scales
 Windows XP/Vista/7/8

PO-30  Metal Series Pocket 
Operators Super Set

  » Built-In Sampling, Sequencing, & Effects
  » Built-In Microphone and Speaker
  » 3.5mm Audio I/O
  » Easy Data Backup, Restore, and Transfer
  » Includes PO-32 Tonic Drum Machine
  » Includes PO-33 KO Micro Sampler
  » Includes PO-35 Speak Vocal Synthesizer
  » Includes Three Cases  and Sync Cables

(TEPO30) ........................................................................................... 319.00

Theremini
Synthesizer Module

  »  Pitch Correction with Selectable Scales » Built-In Tuner 
for Learning Pitch » 32 Wavetable-Based Presets

  »  Built-In Speaker and Two 1/4” Outputs » Single-Pitch CV 
Output with Range » Adjustable Stereo Ping-Pong Delay

  » 3/8” Mic Stand and Camera Stand Adapter
»  User-Selectable Scale and Root Note
  » Removable Pitch Antenna

(MOTHEREMINI) ................................................................................ 299.00

Theremini
Synthesizer Module

 Pitch Correction with Selectable Scales » Built-In Tuner 
 32 Wavetable-Based Presets

 Built-In Speaker and Two 1/4” Outputs » Single-Pitch CV 
 Adjustable Stereo Ping-Pong Delay

3/8” Mic Stand and Camera Stand Adapter
 User-Selectable Scale and Root Note
Removable Pitch Antenna

299.00

Mother-32
Semi-Modular Analog Synthesizer

  »  100% Analog 
Sound Engine

  »  VCO with Square 
and Saw Waveforms

  »  LFO with Square and 
Triangle Waveforms

  » Classic Moog Filter: Switchable LP/HP
  » Records Note, Glide, Gate Length, Accent

(MOM32) ........................................................................................... 599.00

Semi-Modular Analog Synthesizer

DFAM - Drummer from Another Mother
Semi-Modular Analog Percussion Synthesizer

  » 100% Analog Sound Engine
  »  Two VCOs with Square 

and Saw Waveforms
  »  Classic Moog Filter: 

Switchable LP/HP
  »  Three Envelopes: VCO, VCF, VCA » 8-Step Sequencer with Pitch 

& Velocity » 24-Point Patchbay » External Audio Input or 
Noise Source » Eurorack Compatible, Skiff Friendly

(MOW01MK) ...................................................................................... 199.00

100% Analog Sound Engine

MPC Live  Standalone Music 

Production Center

  »  Integrated Sampler
and Sequencer

  » 7" Touch Screen
  »  16 Velocity-Sensitive

RGB Backlit Pads
  »  4 Q-Link Encoders

to Control Parameters » 16GB of Onboard Storage, 2GB of RAM

(AKMPCLIVE) ..................................................................................1,199.00

Boutique JP-08
Synthesizer Module

  »  4-Voice Synth Modeled 
after Jupiter-8

  »  Analog Circuit Behavior 
Modeling

  »  Compatible with 
Optional K-25m Keyboard » 36 Knobs and Sliders from the Jupiter-8

  »  Chain Two JP-08 Modules for 8 Voices » 24-Bit / 44.1 kHz Stereo IN/
OUT via USB » Battery Operated (4x AA) or USB powered

(ROJP08) ........................................................................................... 299.99

B4000+
Authentic Organ Sound Module

  » Supports 3 Manuals - Upper, Lower, Pedal
  » 9 Drawbars, 6 Dials
  » Tonewheel Emulation
  » Percussion
  » 128 Factory Presets
  » Rotating Speaker Emulation
  » Key Click, Key Contact Delay Simulation

(FEB4000) ......................................................................................... 499.00

Supports 3 Manuals - Upper, Lower, Pedal

Rotating Speaker Emulation

PL2
Synthesizer

  » Palm-Sized Duophonic Synthesizer
  » Two Oscillators » Four Waveforms
  » Square Wave Synthesis
  » Digital Filter » Analog Filter
  » 5-Pin MIDI Input » MIDI or USB Powered
  » 32 Factory & 32 User Presets
  » Use with PL2 Leukos & Other MIDI Gear

(PLPL2) ............................................................................................... 77.00

Digitone  8-Voice 
Digital FM Synthesizer and Sequencer

  » 4x Synth Tracks » 4 x MIDI Tracks
  » Multimode Filter per Voice
  » Base-Width Filter per Voice
  » Overdrive per Voice
  » 2x Assignable LFOs per Voice
  » Chorus, Delay, and Reverb Send Effects
  » High-Speed USB 2.0 Port MIDI In, Out, Thru, and DIN Sync
  » Overbridge Compatibility

(ELDIGITONE) .................................................................................... 739.00

Toraiz AS-1
Monophonic Analog Synthesizer

  »  Based on the DSI Prophet-
6 Analog Synth

  » Monophonic
  » 495 Preset Patches
  » 2 x VCO & VCF, 2 x EG, VCA, LFO » Resonant LP Filter & HP Filter
  » Each Preset Offers a 64-Step Sequencer » Arpeggiator
  »  Dual FX Engine from Prophet-6 » Touch-Pad Keyboard and 
Slider Control » Optional Mac/Windows Sound Editor

(PITAS1) ............................................................................................ 499.00

Peak
8-Voice Polyphonic Synthesizer
  »  Digital/Analog Hybrid 

Synthesizer
  » 8-Voice Polyphony
  »  512 Memory Patches, 
256 Factory Presets

  »  5 Voice Modes and 3 x Oxford Oscillators » State-Variable OTA 
Filter per Voice » 2 x LFO, Ring Mod, Noise, 3 x Envelopes

  » Modulation Matrix: 16 Slots » Arpeggiator » Analog Distortion,
(NOPEAK) .......................................................................................1,299.99

 4 x MIDI Tracks

Chorus, Delay, and Reverb Send Effects

MiniBrute 2S
Semi-Modular Analog Synthesizer/Sequencer

  » Advanced 3-Track Sequencer
  » Two VCOs with Waveform Mixer
  »  48-Point Patchbay
  »  Classic Steiner-Parker 
Multimode Filter

  »  16 Pressure and Velocity 
Sensitive Pads » MIDI, CV, USB Input/Output Connectivity

  » LFO 1&2 with Six Waveforms » Arpeggiator and Loop Function

(ARMINBRUTE2S) .............................................................................. 649.00

MIDI or USB Powered

Model D  Analog Synthesizer with 
Ladder - Eurorack Compatible

  » Authentic Layout and Sound
  »  Semi-Modular Design with 
14 Patch Points

  » Pure Analog Signal Path
  »  Three VCOs with Five 
Waveforms Each

  »  Classic 24 dB Ladder-Style Filter » Filter Switchable between 
Hi-/Low-Pass » MIDI In/Thru: USB and 5-Pin DIN

(BELAS3V) ......................................................................................... 299.99

Authentic Layout and Sound
 Semi-Modular Design with 
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Subsequent 37
Paraphonic Analog Synthesizer

  » 40 Knobs & 74 Switches
  » 37-Note Keyboard » Dual LFOs
  » Dual Oscillators » Sub-Oscillator
  » Dual ADSR Envelope Generators
  » Arpeggiator » Moog Ladder Filter

(MOSUB37) ..................................................................................................................................................... 1,499.00

DeepMind 6
True Analog 6-Voice Polyphonic Synthesizer

  » 37 Full-Size Keys with Vel and AT
  » Two Oscillators and Two LFOs per Voice
  » Three ADSR Envelope Generators per Voice
  »  Four FX Engines » 8-Channel Modulation 

Matrix Including FX » 19 Sources and 
130 Destinations » 32-Step Control Sequencer

(BEDEEPMIND6) ..................................................................................................................................................699.99

Paraphonic Analog Synthesizer

teenage engineering OP-Z  Synthesizer and Multimedia 
Sequencer

  »  16-Track Sequencer » 16 Synthesis, Sampler, 
& Control Tracks » Multi-Program Step 
Components » MIDI, CV, Trig Track Sequencing

  »  Modular Effects Architecture » Image and 
3D Graphic Sequencing » DMX Light Sequencing » Free iOS App with Screen Integration » Dual Domain 
Synthesis » Connect via USB or Wirelessly via Bluetooth

(TEOPZ) .................................................................................................................................................Call or Log-on

 JD-Xi
 Analog/Digital Synthesizer

  » Analog & Digital Sound Engines
  » Compact Footprint » 37 Mini Keys
  » Four-Track Pattern Sequencer
  » Vocoder & AutoPitch » Four Simultaneous Effects
  » USB for Audio/MIDI » Additional Sounds & Patterns Available

(ROJDXI) .............................................................................................................................................................499.99

FA-07
Music Workstation

  » 76-Note, Semi-Weighted Keyboard
  » Over 2000 Sounds
  » 16-Track Sequencer, Onboard Sampler
  » 16 Backlit Pads » Effects » 6 User-Assignable, Sound-Modifying Knobs » USB Ports
  » D-Beam, Rhythm Pattern » Arpeggiator, Chord Memory » Guitar/Microphone and Line Inputs

(ROFA07) ......................................................................................................................................................... 1,499.99

Prologue 16
Polyphonic Analog Synthesizer

  » 16-Voice - Fully Programmable
  » 61-Key Natural Touch Keyboard
  » 500 Fully Editable Presets » Modes: Poly, Mono, Chord, Unison » Open Source: User Customization
  » Sync I/O for Connecting Groove Machines » Arpeggiator » 24-Bit Digital Effects
  » OLED Display with Built-In Oscilloscope » Black Aluminum Panel with Oak Wood Sides

(KOPROLOGUE16) ............................................................................................................................................ 1,999.99
8-VOICE (KOPROLOGUE8) ................................................................................................................................ 1,499.99

Monotron DELAY
Analog Ribbon Synthesizer

  » Pocket Sized » True Analog Synthesizer
  » Space Delay with Time & Feeback Control
  » Original (VCF) Filter from MS-10 & MS-20
  » Waveshape, Rate, and Intensity Controls
  » VCF with Cutoff Control » Octave Ribbon Keyboard » Built-in Speaker » Headphone Output

(KOMONTROND) .................................................................................................................................................... 49.99

Minilogue
Polyphonic Analog Synthesizer

  » 4-Voice - Fully Programmable
  » 200 Fully Editable Presets
  » Modes: Poly, Duo, Mono, Chord, Unison » 16-Step Poly Note and Motion Sequencer
  » Tape-Style Delay » OLED Display w/ Built-In Oscilloscope » Aluminum Chassis w/ Pyinkado-Wood Panel
  » Chassis-Mounted Metal Shaft Pots » Rubber-Coated Knobs

 (KOMINILOGUE) ..................................................................................................................................................499.00

Prophet REV2  8-Voice Polyphonic
Analog Synthesizer

  » Semi-Weighted, Velocity-Sensitive Keys
  » 2x Digital Control Oscillators per Voice
  » Analog Curtis 2-/4-Pole LPF per Voice
  »  4 x LFOs » 3 x Envelopes » Control Knobs for 

Hands-On Adjustment » Polyphonic 6-Note Step Sequencer
  » Gated 16x4 Step Sequencer per Layer » MIDI In, Out, Thru » CV / Expression, Sustain Inputs

(DADSI2808) .................................................................................................................................................... 1,499.00

MiniNova
        37-Mini-Key Compact Synthesizer

» Powerful UltraNova Sound Engine
» 256 Factory Preset Sounds » Polyphony up to 18 Voices
»  Add up to 5 Effects to Each Sound
» Includes Gooseneck Microphone » VocalTune and Classic Vocoder Effects
» Patch Editing and Storage Software » USB and MIDI Connectivity

(NOMININOVA) ..................................................................................................................................... Call or Log-On

MicroBrute
Analog Synthesizer

  » 100% Analog Monophonic Synthesizer
  » 25-Note Mini Keyboard » Mixable Multi-Wave Oscillator
  » Steiner-Parker Multimode Filter » LFO with 3 Waveforms
  » ADSR Envelope Controls » USB MIDI In/Out
  » Modulation Matrix » CV/Gate Input and Output

(ARMICROBRUTE) ................................................................................................................................. Call or Log-On

Reface DX Mobile
Mini-Digital FM Synthesizer
» FM - Frequency Modulation Synthesis
» 37 HQ Mini-Keyboard
» Built-In Phrase Looper
» 8-Note Polyphony » 4 Operators and 12 Algorithms » Digital Display » Touch Control Interface
» Built-In Speakers » Built-In Effects » Librarian iOS App for Saving Presets

(YAREFACEDX) .....................................................................................................................................................286.65
Reface YC (YAREFACEYC) ..................................................................................................................................368.00
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P-115
88-Key Digital Piano 
with Graded 
Hammer Action

An 88-note, weighted-action piano that offers useful features for everyone, from beginning players to 
professionals. The unit is equipped with Graded Hammer Standard (GHS) action, which gives it a similar 
feel to an acoustic piano.

(YAP115B) ...........................................................................................................................................................599.99

Pa700 Professional
61-Key Arranger with Touchscreen 
Velocity-sensitive, 61-key keyboard designed 
for use for live performance, practice, and karaoke 
applications. Features a 7" capacitive touchscreen display. 
» Velocity-Sensitive Keys » Two 25W Amps with Dual-Cone Speakers » TC Helicon Vocal Processor
» Over 1700 Factory Sounds » MP3 Playback with Adjustable Pitch » 148 Effect Types + Kaos FX
» Storage: 960MB, USB, and MicroSD » 2x 1/4" Mic Inputs + Guitar Input » Supports MP3+G Lyric Display
(KOPA700)....................................................................................................................................................... 1,299.99

FP-30
Digital Piano (Black)

TThe black FP-30 from Roland provides the 
opportunity for the budget- and space-constrained 
student/performer to have access to the sound of a real piano in a light and portable form factor. The 88-key 
instrument delivers an authentic piano experience, both from the SuperNATURAL Piano engine, and the weighted 
keyboard that inherits the touch, escapement, and Ivory Feel keys found in the company's high-end home pianos.
  » Additional Non-Piano Sounds » Drum Patterns » Internal Recording » Twin Piano Setting for Duets

(ROFP30BK) ........................................................................................................................................................699.99

GO-61K
Music Creation Keyboard

The GO:KEYS GO-61K Music Creation Keyboard 
from Roland is a 61-key, touch-sensitive 
keyboard with 10 performance pads, Bluetooth 
connectivity, a recorder, and an innovative Loop Mix function. 500 or more pro sounds to explore, the GO-61K 
keyboard has a built-in amplifi er and speakers, and the easy-to-use recorder allows you to capture and share 
your creations everywhere you go.

(ROGO61K) ..........................................................................................................................................................299.99

KP-110
Portable Arranger Keyboard

  »  61-Keys, Synth Action » Three Selectable 
Response Levels » 128 Voice Polyphony

  » 653 Expressive Sounds
  » Includes Triple Strike Piano from PC3 » EQ, Reverb, and Chorus » Over 240 Pre-Recorded Patterns
  »  6-Track Recorder, 10-Song Capacity » Stereo 1/4" Inputs, Microphone Input » Includes Music Stand 

and Power Adapter
(KUKP110) ..........................................................................................................................................................399.00

Genos  76-Key 
Arranger Workstation Keyboard

  » 76-Note Keyboard with Aftertouch
  » 9" Color Touchscreen » Assignable Buttons
  » 1710 Instrument Voices & 216 Arpeggios
  » 550 Accompaniment Styles » C7 Grand Piano » Revo!Drum Voices
  » Vocal Harmony and Synth Vocoder » 16-Track MIDI Sequencer » 32-Bit Digital Audio Converter (DAC)

(YAGENOS) ...................................................................................................................................................... 5,499.99

PSR-S775
Arranger Workstation Keyboard

  »  1460 Voices, including Super Articulation voices 
and Organ fl utes, 50 Drum/SFX kits, and 480 XG voices

  » 433 Styles, including 30 Session Styles, 15 DJ styles and 1 Free Play
  » Half bar fi ll-in and Mono legato function » 280 MB on-board memory for expansion data
  » USB audio playback with time stretch, pitch shift, vocal cancel and MP3 lyrics display functions

(YAPSRS775) ................................................................................................................................................... 1,299.99

DGX-660
Portable Grand Digital Piano

88-key digital piano that features sounds based 
on samples from the company's CFIIIS 9' 
concert grand piano, a weighted keyboard 
with varying touch response across the key range, and Damper-Response DSP. To add to the genuine 
playing experience, the keyboard also provides 192-note polyphony that will easily accommodate 
two-handed sustained chords with heavy pedaling.

(YADGX660B) .......................................................................................................................................................799.99

Pa1000  61-Key 
Pro Arranger with Speakers
A workstation with a range of styles covering 
music genres from all over the world. Combine 
this with powerful performance functionality
and an intuitive user interface with rich sculpted sound 
» 1750 Ready-to-Play Sounds » Stereo Grand Pianos » KAOSS FX » Defi ned Nuance Control
» Built-In Amplifi er and Speakers » TC Helicon Vocal Harmonizer » Dual Crossfade Sequencer
(KOPA1000) ..................................................................................................................................................... 1,999.99

PX-160 Privia
88-Key Digital Piano

The PX-160 Privia features the innovative
AiR sound source, which provides multi-
dimensional sound production with a grand piano's playing and sound properties. The Tri-Sensor Scaled Hammer 
Action includes real hammers with a scaled weight. The 88-note keyboard is made from simulated ebony and 
ivory textured Keys and features 3 sensors per key to capture the dynamics of a performance, while the variable 
hammer mimics the timing that occurs naturally inside of an acoustic grand.
(CAPX160BK).......................................................................................................................................................499.99

ES 110
Portable Digital Piano (Black)

The black ES 110 Portable Digital Piano 
is the latest 88-key addition to the highly respected series of portable digital pianos, combining an 
authentic keyboard action with grade-weighted keys and piano sound technologies.
  » 88 Grade-Weighted Keys » Advanced Harmonic-Imaging Technology » Acoustic Piano Key Weighting
  » Realistic Touch, Natural-Motion Action » Reverbs, Noises, and Resonance Effects » Built-In Lessons
  » Lightweight and Portable » Bluetooth Connectivity

(KAES110) ...........................................................................................................................................................729.00

Recital Pro
88-Key Digital Piano

The Alesis Recital Pro is an 88-key digital 
piano designed to provide a realistic playing 
experience and education-friendly features for 
beginning keyboardists and experienced pianists in rehearsals, at home, or on stage. It delivers natural response 
via 88 hammer-action keys with adjustable touch sensitivity. There are 12 voices including acoustic and electric 
pianos, organs, strings, basses, and more.

(ALRECITALPRO) ..................................................................................................................................................349.00
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Surge Mesh Kit
Eight-Piece Electronic Drum Kit with Mesh Heads

  » Surge Drum Module
  » 1 x 10" Dual-Zone Mesh Snare Pad
  » 3 x 8" Dual-Zone Mesh Tom Pads
  » 8" Mesh Kick Pad Tower
  » 10" Hi-Hat, Crash, and Ride Cymbals
  » Kick and Hi-Hat Pedals
  » 4-Post Chrome Rack
  » Drum Key, Cable Snake, and Cable Wraps

(ALSURGEMESHK) ...............................................................................................................................................499.00

DTX450K
Electronic Drum Kit

  » DTX400 Drum Trigger Module
  » 10 Preset Kits & 169 Voices
  » TP70S 3-Zone Snare Pad & Real Kick Pedal
  » Deluxe HH65 Remote Hi-Hat Controller
  » Large 10" Cymbals & Hi-Hat Cymbal
  » Three 7.5" Tom Drum Pads
  » 10 Interactive Training Functions
  » 10 Play-Along Songs & Durable Steel Rack
  » More Songs Can Be Downloaded via USB
  » Compatible with DTX-PADs for Upgrading

(YADTX450K) .......................................................................................................................................................599.99

TD-11K
V-Compact Series Electronic Drum Set
with MDS-4V Stand

  » TD-11 Drum Sound Module
» 50 Drumkits and 190 Instruments
  » 10 Ambience Effects and Built-in EQ
  » SuperNATURAL Sound and Behavior Modeling
  » PDX Series Snare Pad » FD-8 Hi-Hat Controller
  » KD-9 Kick Pad with Double Pedal Support
  » Dual-Triggering Technology
  » USB Port for Memory and Connectivity
  » MDS-4V Drum Rack and Hardware

(ROTD11KS) ................................................................................. 799.99

TD-11KV
V-Compact Series Electronic 
Drum Set with MDS-4V Stand

  » TD-11 Drum Sound Module
  » 50 Drum Kits and 190 Instruments
  » 10 Ambience Effects and Built-in EQ
  » SuperNATURAL Sound and Behavior Modeling
  » 3 CY Series Cymbals
  » 4 PDX Series Snare and Tom Pads
  » KD-9 Kick Pad with Double Pedal Support
  » Dual-Triggering Technology
  » USB Port for Memory & Connectivity
  » MDS-4V Drum Rack & Hardware

(ROTD11KVS) .................................................................................................................................................. 1,299.99

V-Compact Series Electronic Drum Set

799.99

DD-75
Portable Digital Drum Set with 8 Pads

  » Eight Touch-Sensitive Pads
  » Two Foot Pedals
  » Aux Input Jack
  » MIDI I/O
  » Four-Track Song Recorder
  » Adjustable Pad Sensitivity
  » 570 Drum Voices and 30 Phrase Voices

(YADD75) ........................................................................................... 219.99

DR-01S Rhythm Partner
Organic Groove Machine and Speaker

  » For Acoustic Musicians
  »  Provides Grooves at Home or on 
the Go » Integrated Speaker

  » Easy-to-Use Control Panel
  » Over 15 Instruments Built-In
  »  50 Slots for Storing Patterns 
for Recall » 24-Bit Processing for High-Quality Sound

  » Battery Powered for up to 10 Hours » Includes AA Adapter

 (BODR01S) ....................................................................................... 229.99

CompactKit 4
4-Pad Portable Tabletop Drum Kit

  » 4x Velocity-Sensitive Pads
  »  Self-Recording & Built-In 

Metronome
  »  Coach Feature via 

LCD Screen
  » 5 User Kits
  »  70 Percussion Voices 

& 10 Effects   »  50 Play-Along Songs

(ALCOMPACTK4) .................................................................................. 79.00

4x Velocity-Sensitive Pads
 Self-Recording & Built-In 

RT-30K
Acoustic Kick Drum Trigger

  » Kick Drum Trigger
  » Attaches to Drum's Metal Rim
  » Single Trigger Design
  » Self-Guiding Mount
  » Fiberglass-Reinforced ABS Body
  » Protective Grip Prevents Marring
  » TRS Cable Included

(RORT30K) .......................................................................................... 89.99

KTMP1 Electronic Drum &
Percussion Pad Sound Module

  » Four Velocity-Sensitive Pads
  » Playable via Sticks or by Hand
  » 50 Drum and Percussion Sounds
  »  Tune, Pan, Reverb, 

Sensitivity & Level
  » Includes Stand Mount

(KAKTMP1).......................................................................................... 99.99

SPD::ONE PERCUSSION
Percussion Pad

  » Contains 22 Onboard Sounds
  »  Snare, Kick, Hi-Hats, 
and Cymbal Sounds

  » Imports WAV Data via USB to 12 Banks
  » Runs on 4 x AA Batteries or AC Adapter
  » USB-MIDI Enables Use as Pad Controller
  » Can Be Floor- or Tabletop-Mounted   »  Includes Mounting Adapter

(ROSPD1P) ........................................................................................ 199.99

Imports WAV Data via USB to 12 Banks
Runs on 4 x AA Batteries or AC Adapter
USB-MIDI Enables Use as Pad Controller
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GAX30 GIO Series Electric Guitar – Mustard (IBGAX30MST) ...................................................................... 149.99
GRX70QA GIO Series Electric Guitar – Transparent Emerald Burst (IBGRX70QATEB) .............................. 199.99
PC15VS PF Performance Series Acoustic Guitar – Vintage Sunburst (IBPC15VS) ................................. 149.99
TMB30 Talman Bass Standard Series Electric Bass – Ivory (IBTMB30IV) ................................................ 179.99

EC-258 8-String Electric Guitar – Black Satin (ESLEC258BLKS) ................................................................449.00
H-200FM LTD H-Series Electric Guita – See Thru Red (ESLH200FMSTR) ..................................................369.00
LTD Viper-256 Electric Guitar – Military Green Satin (ESLVIPER256M) .....................................................399.00
ESP LTD PS-1 Xtone Series Semi-Hollow Body Electric Guitar – Sea Foam Green (ESXPS1SFG) ................399.00

GB72CE-BSB G Series Acoustic/Electric Bass Guitar - Brown Sunburst (TAGB72CEBSB).......................639.99
EF381SC Legacy Series 12-String Acoustic/Electric Guitar with Case - Gloss Black (TAEF381SC) ......... 1,399.99
GD11MCE Dreadnought Acoustic/Electric Guitar - Natural Satin (TAGD11MCE) ......................................299.99
GD20CE G Series Dreadnought Acoustic/Electric Guitar - Natural Satin) (TAGD20CE) ............................449.99

S6 Cedar Original Slim Acoustic Guitar - Natural Semi-Gloss (SE46409) ............................................... 419.00
Coastline S12 Cedar 12-String Acoustic Guitar - Natural Semi-Gloss (SE029358)................................ 499.00
Entourage Rustic CW Concert Hall QIT Acoustic/Electric Guitar - Rustic Burst (SE040414) ................ 499.00

EC
-2

58

H-
20

0F
M 

LT
D

LT
D 

Vip
er-

25
6

LT
D 

PS
-1

GA
X3

0

GR
X7

0Q
A

PC
15

VS TM
B3

0

EF
38

1S
C

GB
72

CE
-B

SB

GD
11

MC
E

GD
20

CE

S6 CO
AS

TL
IN

E S
12

EN
TO

UR
AG

E C
W

Ultra-Light Compact Acoustic/Electric Guitar with Gig Bag -
Antique Brown (TRULSTBRN) ......................................................... 299.99
Original Escape - Compact Acoustic / Electric Guitar with Gig Bag - 
Natural (TRESCSNAT)...................................................................... 379.99

S-34C Grand Orchestra Acoustic Guitar -
Natural (JAS34C137132) ....................................................................79.99
S-35 Dreadnought Acoustic Guitar - Natural (JAS35137131) .......86.77

CE44-5 Celebrity Elite Series Acoustic/Electric Guitar -
Black (OVCE445) ............................................................................. 469.00
AE44II Applause Elite Acoustic/Electric Guitar -
Ruby Red (OVAE44IIRR) .................................................................. 299.99
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Sledgehammer Pro 
Clip-On Guitar & Bass Tuner

  »  Tuning Accuracy of +/- 0.1 Cents
  » 3D Tubular LED Visual Meter
  » Clips to Headstock of Guitar or Bass
  » Three Meter-Display Modes
  » Calibrate to Different Reference Pitches
  » Memory Backup Function » Auto Power-Off

(KOSHPRO) ......................................................................................... 19.55

Ditto
Looper Effects Pedal
  »  Single Knob & Switch Operation
  » Up to 5 Minutes of Looping
  » Unlimited Overdubs
  » Analog Dry-Through » True Bypass
  » Undo/Redo Functions » 24-Bit Conversion
  » Compact Design Uses Less Pedal Board

(TCDITTOL) .......................................................................................... 99.99

MicroBlock 45 
45W Compact Guitar Amplifi er Pedal

  » Pedal-Sized 45W Amplifi er
  »  Power Any Speaker: 

4, 8, 16 Ohms
  »  Gain Control: Clean to 

Soaring Overdrive
  » Tri-Q Control: Scoop, Normal, Lead Tones

(QUMICBLK45) .................................................................................. 149.00

SansAmp
Bass Driver V2 DI Pedal
  »  Drive and DI Pedal for Bass Guitar
  »  Expanded Low and Mid 

Frequency Settings
  » Well Suited for 5- & 6-String Basses
  » Functions as Preamp, stompbox or DI Box
  » Power via 9V Battery or DC Adapter

(TEBSDRV2) ...................................................................................... 209.00

DS-1  Distortion Pedal

(40th Anniversary, Limited Edition)

  » 40th Anniversary Body with Gold Accents
  » Includes 40th Anniversary Box
  » Hard-Edged Attack
  » Fluid Sustain
  » Distortion, Level, and Tone Controls

(BODS14A) ...............................................59.99

DOD Gunslinger
MOSFET Distortion Pedal
  »  MOSFET Distortion Circuit
  » Gain, Level, Low, and High Knobs
  » True Bypass
  » 9V Battery Powered
  »  Supports 9 and 18 VDC 

Power Supplies

(DIDODGNSLNGR) ................................................................................ 29.95

G1Xon Multi-Effects  
Guitar Pedal with Expression Pedal 

  » 105 Guitar Effects
  » 5 Effects Can Be Used Simultaneously
  » 68 Built-In Rhythm Patterns
  » Built-In Chromatic Tuner
  » 30-Second Phrase Looper
  » Backlit LCD Screen

(ZOZG1XON) ........................................................................................ 79.99

5 Effects Can Be Used Simultaneously

H9 MAX
Effects Pedal with Bluetooth Control

  » Single-Knob Interface
  » Edit Presets & Effects via Bluetooth
  » Compatible with iPod, iPhone & iPad
  » Stereo 1/4" TS Inputs & Outputs
  » 1/4" Expression Pedal Input
  » USB Port for Mac & Windows Control

(EV1179031) ...................................................................................... 699.00

Soul Press
Volume / Expression / Wah-Wah Pedal

  » 3-in-1 Volume, Expression & Wah Pedal 
  » True Bypass
  » Compact Size
  » Active Volume for Lossless Tone
  » 9 VDC or 9V Battery Power Supply

(HOTPSPRESS) ....................................................................Call or Log-On

Skyline Wally
Looper Pedal

  » Up to 15 Minutes of Loop Time
  » Unlimited Overdubs
  »  Tempo, Rec Level  
& Output Knobs

(HOTPSWALLY) ....................................................................Call or Log-On

Classic
Analog Bass Preamp Pedal

  » Wide Range of Classic Ampeg Tones
  » 3-Band Tone Stack with Volume Control
  » Ultra-Lo & Ultra-Hi Tone Stack Switches
  » -15 dB Pad on Internal Jumper
  » True Bypass

(AMCLASSIC) ...................................................................................... 99.99

Analog Drive
Multi-Circuit Distortion Pedal 

  » 8 Analog Distortions in 1 Stompbox
  »  100 User Preset Slots
  » Programmable Presets
  » Preset & Manual Modes
  »  Bass, Mid & Treble EQ » Sweepable 
Midrange » Expression Inputs for Gain & Midrange

(ELPFX1) ........................................................................................... 222.00

95000 Modulated 
Filter Pedal
»  Use with Guitars, Vocals, 

and More
»  375 Minutes of Looping 

on 100 Tracks
»  6 Mono Tracks & 1 Stereo Track per Loop » Panning Knob & 

Fader on Every Track » Stereo I/O with Combo XLR-1/4" Inputs

(EL95000) .......................................................................................... 550.00

TO800  Vintage Tube 
Overdrive Pedal

The Behringer TO800 Vintage Tube 
Overdrive Pedal is a bright green pedal 
that adds a powerful gain and 
historic fatness and crunch 
to your guitar tone.

(BETO800) ........................................................................................... 19.99

RAT 2
Compact Guitar Distortion Pedal

  » Control Knobs for Filter, Distortion, & Volume
  » Completely analog signal pat
  » Heavy-duty steel construction
  » Sloped face for easy stomping
  »  Glow-in-the-dark graphics for easy 

adjustments while the lights are off
(PRRAT2) ............................................................................................ 69.95

Control Knobs for Filter, Distortion, & Volume

TU-3
Chromatic Tuner

  » For Electric & Bass Guitars
  » 21-Segment LED Meter
  » Accurate to +/- One Cent
  » Accu-Pitch Verifi cation of Tuning
  » Powers for up to Seven Effect Pedals
  » High-Brightness Mode Enhances Visibility

(BOTU3) .............................................................................................. 99.99

Powers for up to Seven Effect Pedals
High-Brightness Mode Enhances Visibility

MFS-DELAY-02
Minifooger MF Delay Pedal

  » Updated Look over Original Pedal
  » Analog Delay Pedal
  » Up to 700 ms of Delay
  » Expression Pedal Input
  » Adjustable Drive » True Bypass
  » Adjustable Feedback Range

(MOMFSDELAY02) ............................................................................. 199.00

(40th Anniversary, Limited Edition)

40th Anniversary Body with Gold Accents

59.99

Tri-Q Control: Scoop, Normal, Lead Tones

TM

SN5X
Clip-On Guitar, Bass & Violin Tuner

  » Full Color Display
  » Rotates 360°
  » Tap Tempo Metronome
  » High Sensitivity Vibration Sensor
  » Tailored for Guitar, Bass & Violin

(SN5X) ...................................................................................................9.99

Well Suited for 5- & 6-String Basses

Minifooger MF Delay Pedal

Multi-Circuit Distortion Pedal 

8 Analog Distortions in 1 Stompbox

 Sweepable 
 Expression Inputs for Gain & Midrange

Clip-On Guitar & Bass Tuner

Auto Power-Off
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MOBILE CUBE
Battery-Powered Stereo Amplifi er

  » Integrated Stereo Effects
  » Center Cancel
  » Powered by 6 AA Batteries
  »  FX Engine Provides Chorus, 
Distortion, Delay, and Reverb

  » 5W of Stereo Sound

(ROMOBILECUBE) .............................................................................. 179.99

Nano Legacy Purple Wind
Class AB Guitar Amp

  »  Based on Marshall 
Plexi Super Lead 1959

  » Compact Size
  » 5W Output
  » FX Loop
  » 1/8" Headphone/Line Output
  »  1/4" Variable Impedance Speaker Output

(HOTANLA2) ........................................................................Call or Log-On
British Invasion Class AB Guitar Amp (HOTANLA1).......Call or Log-On

ID:Core Stereo 10 V2
2x 5W Super Wide Stereo Combo Amplifi er

  » For Electric Guitars   »  EQ with ISF Control
  »  12 Stereo Effects with

Envelope Filter
  »  6 Enhanced Voices:

Clean to Overdrive
  » Store up to 6 Sounds
  »  Insider Editor and Recording

via USB

(BLIDCORE102) ................................................................................... 99.99

FLY 3 Bass
3-Watt Mini Bass Guitar Amplifi er

  » Can Be Used as Compact Portable Speaker
  » 3" Speaker
  » Clean and Overdrive Channels
  »  Compressor & Infi nite Shape

Feature
  » 1/4" Instrument Input
  » 1/8" MP3/Line Input

(BLFLY3BASS) ........................................69.99

CODE50
50W 1x12" Combo Amplifi er

  »  50W Modeling Combo 
Amplifi er

  » 1x12" Speakers
  »  Emulates Vintage & Modern 

Marshall Tones
  »  Modeling Developed with 

Softube

(MAMCODE50U) ................................................................................. 249.99

JAM 96k  Guitar Interface 
for iOS and Mac with 

Lightning Cable
  » Up to 96 kHz/24-Bit Audio Resolution
  » Designed for Guitar and Bass
  » Circuit Design for Tube Tone Emulation
  » For iOS Devices & Mac Computers
  » Plug-and-Play Operation
  » Compatible with Any Core Audio App
  » Includes Lightning & USB Cables

(APJAM96KLO) ................................................................................... 129.00

Performance 2
Capo for Steel String Guitar (Silver)

  » Smaller and Lighter than Original Model
  »  Wrap-Around Rubber Protects 
the Finish on Your Guitar

  »  Clamps to Guitar Neck 
and Raises Pitch

  » Silicone Improves Tone & Protects Neck
  » Squeeze Design for Reduced Tuning Issues

(G7PERF26SSLV) .................................................................Call or Log-On
Performance 2 Black (G7PRF26STBLK) ..........................Call or Log-On

Rok-It
Tripod Guitar Stand

  » Holds One Guitar or Bass
  » Heavy-Duty Metal Tube Construction
  » Padded Neck and Body Cradles
  » Neck Restraint
  » Black Powder-Coat Finish
  » Rubber Feet

(GARIGTRSTD1) ..............................................8.99

Strum Buddy
Stick-On Guitar Amp

  » Amplifi er for Electric Guitars
  » Mounts to Guitar via Suction Cup
  » 6W of Power
  » Distortion, Reverb & Chorus DSP Effects
  » 40mm Neodymium Speaker
  » Built-In Li-Ion Battery » 3.5-Hour Runtime on a Single Charge
  » Included USB Cable for Charging
  » Included 1/4" to 3.5mm Cable » Portable Practicing Solution

(FLSBSOGA) ........................................................................................ 69.99

Katana-50  50W 1x12" Combo 
Amplifi er for Electric Guitar
  » 50W Amplifi er » 1x12" Speaker
  » 5 Distinct Amplifi er Characters
  »  58 Effects Accessible via 

Tone Central » Stores 15 FX, 
3 Available Simultaneously

  »  2 Recallable & Customizable 
Channels » Phones/Record Output

  »  Aux Input & Footswitch Jack » USB for Tone Central & DAW 
Recording » Built-In Tilt Stand to Adjust Projection

(BOKTN50) ........................................................................................ 219.99

Katana-Air  30W Stereo 
Combo Amplifi er with Wireless Transmitter
  » Wireless Guitar Amp for Portable Use
  »  30W Stereo (20W Stereo 
with Batteries)

  »  Transmitter Provides 
12 Hours of Play

  »  Intelligent Standby Conserves 
Battery » 5 Amp Characters

  » Over 50 BOSS Effects Available » 6 Onboard Memory Slots
  » Stream Music over Bluetooth or Wired

(BOKTNAIR) ....................................................................................... 399.99

17550 Memphis
Travel Guitar Stand
  »  Small in Size and Lightweight, Making it 

Very Attractive for Travelling Musicians. 
  »  Lightweight Guitar Stand, 

perfect for travel
  » Ready to use with just a few moves
  »  Non-marring plastic coating 

protects the guitar

(KM17550) .......................................................................................... 47.95

UCG102 GUITAR LINK
Guitar to USB Interface

  »  Plug in your guitar and turn your PC or Mac 
computer into a guitar amp and recording system 
without the need for any other hardware

  »  Connect the Guitar Link interface to the 
camera connection kit of your iOS 
device and enjoy jamming with guitar apps

  » Stereo headphone output
  » Powered via USB—no additional power supply required

(BEUCG102) ......................................................................................... 39.99

BA-210V2
450W 2x10" Combo Bass Amplifi er

  »  450W RMS at 4 Ohms 
or 283W RMS at 8 Ohms

  »  2x10" Speakers with 
Piezo HF Driver

  » -15 dB Pad on Input
  » 3-Band EQ with Bass, Mid, and Treble
  » Ultra Hi and Ultra Lo Selectors
  » Ampeg's Proprietary Scrambler Overdrive

(AMBA210V2) .................................................................................... 499.99

Kickback KB12 500W 1x12" 
Combo Amplifi er for Electric Bass

  »  500W Class D Amplifi er Technology
  » 1x12" Cabinet
  » For Active & Passive Basses
  » 1/4" Speaker Out for 4 Ohms Cabs
  » 1/4" Headphone Jack
  » XLR Direct Out for PAs & Mixers
  » 3-Band EQ and Shape Control Circuit
  » Built-In Limiter » Lightweight at 28 lb

(HAHMKB12) .......................................................................Call or Log-On

 Lightweight at 28 lb

 ........................................69.99

Wireless Guitar Amp for Portable Use
Amplifi er for Electric Guitar

Guitar to USB Interface
 Plug in your guitar and turn your PC or Mac 
computer into a guitar amp and recording system 

device and enjoy jamming with guitar apps
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FCC Incentive Auctions 
Results: New Wireless 
Frequency Bands

It is said that technology doubles in speed 
and is halved in size every 18 months. We 
are now manufacturing nano technology 
with electronic components nearing the size 
of the atom. These fast-paced technological 
advances seem to be overrunning the cur-
rent communication bandwidth. With an 
available bandwidth of 30 Hz to more than 
300 GHz, one would think there would be 
enough room for all forms of wireless com-
munication. Bear in mind, we are dealing 
with geo-satellites, industrial/scientific/
medical communication devices, commer-
cial/armature radio, cable television relay 
systems, satellite television broadcasts, Wi-
Fi, cellular phones, and the list goes on. 

There seems to be so much confusion as 
to what’s happening with the FCC and all 
wireless communications. To compensate 
for the growing demand of mobile data in 
the US, the FCC concluded an auction of 
some of the UHF TV band spectrum. Many 
wireless and microphones and personal 
monitoring systems operate in the UHF 
band and share the spectrum with DTV 
system and other wireless devices. After 
a 39-month transition period, the UHF 
TV band will extend from 470 to 614 MHz. 
The rest, known as the 600 MHz band, will 
mostly be used by mobile data providers. 
During the transition period, TV stations 
will begin moving to their new channel 
assignments and mobile data providers 
will commence operations gradually on a 
city by city basis. As soon as a mobile data 
provider begins using the 600 MHz band in 
your city, you must change frequencies to 
avoid interfering with them. At the end of 
the transition period, use of wireless micro-
phones and personal monitoring systems 
that can transmit on frequencies between 
617 and 652 MHz or between 663 and 698 
MHz will be prohibited by law and must be 
retired from service. 

By digging a little deeper into the results of 
the Incentive Auction, the FCC has updated 

and released some new facets to wireless 
usage laws that may prove beneficial to 
professional and semi-professional sound 
companies. The rules for White Space 
Devices (WSD) provide guidelines for unli-
censed equipment operating on unused TV 
channels. WSD deployment has been slow, 
but is expected to accelerate. The audio 
community has been concerned about this 
issue because of the increased potential for 
interference caused by more devices using 
the same frequency range. However, li-
censed operation of wireless microphones 
takes precedence over unlicensed devices, 
including WSDs. 

The FCC has issued a Notice of Proposed 
Rulemaking for a Reserved Channel, which 
allocates at least one UHF TV channel in 
every market for shared use by wireless 
microphones and WSDs. A final decision 
has not yet been made, and the possibil-
ity exists that the new FCC leadership may 
reverse course on this issue. Regardless, 
many areas, particularly suburban and ru-
ral ones, are likely to have more than one 
white space channel. As noted above, eligi-
ble wireless microphone operators can re-
serve any locally vacant TV channel for their 
event, preventing WSDs from operating on 
these channels during the production. 

A new revision on Co-Channel Operation 
with TV Station now allows wireless micro-
phones to operate within four kilometers 
outside the actual service contour or a TV 
station, regardless of the location of the TV 
antenna. Licensed wireless microphone 
professionals are permitted to operate 
closer, or even within the service contour—
if they are indoors and the TV signal mea-
sures less than -84 dBm. 

The commission is to allow the Operation 
in the Guard Band and Duplex Gap, which 
permits some usage within the newly 
blocked bandwidth. An 11 MHz buffer band 
known as the duplex gap has been estab-

lished between the forthcoming downlink 
and uplink 600 MHz mobile broadband 
blocks. No devices shall operate in the 
lowest 1 MHz adjacent to the downlink 
block. The next 4 MHz (653-657 MHz) are 
reserved for licensed wireless microphone 
operators, and will not be shared with white 
space devices. This will be particularly use-
ful for electronic news gathering (“ENG”) 
crews covering spontaneous events. In 
contrast, the upper 6 MHz (657-663 MHz) of 
the duplex gap will be shared between un-
licensed wireless microphones and white 
space devices.

The FCC is making a clearer distinction be-
tween licensed and unlicensed wireless 
microphone operations. Broadcasters, 
motion picture producers, cable stations, 
and creators of content for over-the-air 
broadcast have traditionally been eligible 
for a Part 74 license. License eligibility has 
been expanded, and now includes venues 
and sound companies routinely using 50 
wireless microphones or more. All eligible 
parties should apply for licensed status to 
take advantage of the rights and privileges 
afforded to them, including registration for 
interference protection from WSDs in the 
white space database system, as well as 
access to additional licensed bands out-
side of the UHF TV band. Unlicensed wire-
less microphone operators will no longer 
be able to register their productions for 
interference protection in the database 
system. Although this is less critical be-
cause the FCC expanded license eligibility, 
this poses a challenge for several regional 
productions and non-profit performing 
arts organizations that stage highly so-
phisticated productions while operating 
fewer than 50 wireless microphones, or 
similar devices.

AVAILABLE REBATES
The FCC’s announcement of narrowing 
the bandwidth is not great news. However, 
wireless pro-audio companies are ris-
ing to the occasion with new technology 
that works better and faster in alterna-
tive frequency brands. Additionally, Shure, 
Sennheiser, and Audio Technica are cur-
rently offering rebate programs, which will 
allow you to trade in your eligible system for 
a rebate up to $500 towards your purchase 
of a new system. For questions and con-
cerns, please reach out to B&H for further 
details on independent rebate programs at 
1-800-221-5743, email, or live chat.
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G4 EW-100 Series
  » EK 100 G4 Camera-Mountable Receiver  
  » SK 100 G4 Bodypack Transmitter
  » ME 2-II Omnidirectional Clip-On Lav Mic
  » 1680 Tunable Frequencies across 42 MHz
  » 3-Level Squelch to Block Interference
  » 20 Banks with 12-Channel Presets Each
  » Compander f. Clearer Sound » Auto-Lock Prevents Accidental Adjust.

Mic. System with ME 2-II Lavalier Mic G (SEEW100G4MA1) .... 599.00
ew 135P G4 Sys. with 835 Handheld Mic G (SEEW100G48A1) .. 599.00

LIVE-WIRELESS & IN-EAR MONITORING SYSTEMSLIVE-WIRELESS

Series Digital/
Analog

Frequency
Range

Receiver
Format Range Encryption Max.

Channels
Battery

Type
Battery

Life
Dante/

Ethernet
Rack

Mount
Audio
Output

Shure QLX-D Digital UHF Single  328’ (100m) Yes 22 Lithium-Ion, AA  10 hrs Yes Yes XLR, 1/4”

Shure PGX-D Digital UHF Single 200’ (60m) No 5 AA 10 hrs No No XLR, 1/4”

Shure GLX-D Digital 2.4GHz Single  200’ (60m) No 8 Lithium-Ion 16 hrs No No XLR, 1/4”

Shure ULX-D Digital UHF Single, Dual, Quad 328’ (100m) Yes 60 AA 11 hrs Yes Yes XLR    

Shure BLX Analog UHF Single, Dual 300’ (91m) No 12 AA 14 hrs No No XLR, 1/4”

Shure SLX Analog UHF Single  328’ (100m) No 12 AA 8 hrs No No XLR, 1/4”

Sennheiser Evolution D1 Digital 2.4GHz Single  Not Specifi ed No 15 AA 6 hrs Yes No XLR    

Sennheiser Evolution G4 Analog UHF Single  Not Specifi ed No 32 AA 8 hrs No No XLR, 1/4”

Sennheiser XSW Wireless Analog UHF Single  Not Specifi ed No 12 AA 10 hrs No No XLR, 1/4”

Audio-Technica System 10 PRO Digital 2.4GHz Single, Dual 200’ (60m) No 10 AA 7 hrs Yes Rack Ears Included XLR, 1/4”

Audio-Technica 3000 Analog UHF Single  300’ (91m) No 10 AA 8 hrs No Rack Ears Included XLR, 1/4”

Audio-Technica 2000 Analog UHF Single  300’ (91m) No 16 AA 9 hrs Yes Rack Ears Included XLR, 1/4”

QLX-D
Digital Wireless

Offering networked control, AES-256 
encryption, and simplifi ed setup 
and operation, QLX-D delivers 
outstanding digital wireless sound 
for mid-size events and installations.

Lavalier System (SHXD1483H50) ............................................... 1,053.00
Handheld System (SHD24SM58G50) ............................................. 999.00
COMBO System (SHXD12485G50) .............................................. 1,439.00

Evolution D1 
Digital Wireless

These systems combine digital
innovation with a great selection 
of options and evolution capsules. 
They can quickly locate the best frequencies 
and synchronize up to 15 additional transmission links.

Bodypack Transmitter (SESKD1) ................................................. 199.95
Lavalier System (SEEWD1ME2) ..................................................... 499.95
Headset System (SEEWD1835S).................................................... 499.95

ULX-D
Digital Wireless

ULX-D Digital Wireless offers extremely
effi cient RF performance, networked 
control, Dante digital audio, and 
AES-256 encryption for professional 
sound reinforcement.

Lavalier System (SHULXD144J50) ...................................Call or Log-on
Headset System (SHULXD4G50K) .............................................. 1,399.00
Combo System (SHUD12485H) .................................................. 1,899.00

System 10 PRO
This system operates in the 2.4GHz range 
(outside of TV bands). Its half-rack 
chassis can house 2 receiver units, 
allowing 4 channels to fi t in a single rack space. 
Up to 5 chassis (10 receiver units) can be linked and used simultaneously.

Handheld System (AUATW1302) ................................................... 449.00
Lavalier System (AUATW1101L) .................................................... 349.95
Combo System (AUATW1312L) ...................................................... 849.00

PGX-D
Digital Wireless

PGX-D Digital offers wireless 
audio that sounds like wired, 
rock-solid RF performance and 
simple setup and operation for 
small clubs and venues.

Lavalier System (SHPGXD1493) .................................................... 399.00
Headset System (SHPGXD14PGA3)................................................ 399.00
Handheld System (SHPGXD24SM58) ............................................. 379.00

BLX
Analog

The ideal entry-level 
wireless microphone 
system for small venues, 
BLX offers professional quality 
sound with simple setup and an intuitive interface.

Lavalier System (SHBLX14CVLH9) ................................................. 299.00
Handheld System (SHBLX288P58J) .............................................. 549.00
Headset System (SHBLX14PGJ10)................................................. 299.00

3000 Series
The 3000 Series wireless systems 
offer up to 1001 selectable UHF 
frequencies, clear sound and 
intuitive operation, and 
Frequency-Agile True Diversity UHF.

Bodypack System (AUATW3110BC) ............................................... 449.00
Lavalier System (AUATW3131BC) .................................................. 549.00
Handheld System (AUATW3141BC) ............................................... 549.00

GLX-D Advanced
Handheld Wireless System

  » 2.4GHz ISM Band
  » GLXD4R Wireless Receiver
  »  GLXD2 Handheld Transmitter
  » Includes Rechargeable Battery
  » Microphone Clip » 2 Detachable Antennas » USB Charging

GLX-D Digital Wireless Receiver (SHGLXD4RZ2) ....................... 319.00
With SM 58 Microphone (SHGLXD24S572) ................................... 499.00
Handheld and Lavalier Combo System (SHGLXD124R85) ......... 939.00

Handheld Wireless System

They can quickly locate the best frequencies 

WMS 40 Mini2 Vocal Set
Dual System

  » Frequency Sets A & C
  » Dual Transmitter Operation
  »  x2 HT 40 Mini Handheld 

Transmitters
  » Stable UHF
  » Miniature Receiver Design

(AKWMS40M2VS) .............................................................................. 199.00

System 10 PRO

allowing 4 channels to fi t in a single rack space. 

ULX Series
Wireless Microphone System

  »  Automatic Frequency Selection 
with Group Scan Function

  »  Up to 1440 Frequencies
  »  5-Segment Transmitted Audio 

Signal Strength Meter

Bodypack System (SHULXS14J1) .................................................. 629.00 
Handheld System (SHULXS2458G3) .............................................. 689.00
Combo System (SHULXS12485J) ................................................... 989.00

XSW 1 Series
UHF Wireless Brass Set

  »  SK-XSW Bodypack Transmitter
  » EM-XSW 1 UHF Receiver
  » e908T Gooseneck Microphone
  » Antenna-Switching Reception
  » Automatic Frequency Management

Bodypack System (SESXSW1908A) ............................................... 349.95 
Handheld System with e825 Mic (SESXSW1825A) ..................... 249.95
Headmic System (SESXSW1ME3A)................................................ 349.95

3000 Series
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Ultralink ULM202-USB
Dual Wireless Microphone System

  » 2x Handheld Microphones, 1x USB Receiver
  » 2.4 GHz License-Free Transmission
  » Automatic and Manual Pairing
  » Error Detect and Interference Rejection
  » Dual-Mode Analog/USB Audio Interface
  » Integrated Volume Controls on Microphone
  » Panic Mute Button » Low Battery Indicator

(BEULM202USB) ................................................................................ 149.99

In Ear Monitor Wireless System
1-Pack with Ear Buds 

  » 16-Channel UHF Agility
  » Discrete Right/Left Transmission
  » CADLock Automatic Squelch Control
  » MEB2 TruPitch Dual Earbuds
  » 10-Hour Life on AA Batteries
  » Includes Rack Ears
  » Includes Antenna Relocation Kit

(CASTAGEPASEM) ................................................................Call or Log-On

A2003UHF
Directional Wide-Band Antenna

  »  450 to 960MHz
Wide-Band UHF

  » Enhances Reception
  »  Mounts to Microphone 
Stands

  » Lightweight

(SEA2003UHF) ................................................................................... 279.95

Directional Wide-Band Antenna

PSM 300
Stereo Personal Monitor System with IEM

  » For Live Stage, Theater
  » 24-Bit Digital Audio
  » P3T Transmitter
  » P3RA Receiver
  » Includes SE215 In-Ear Monitors
  » Over 300' Coverage Range
  » One-Touch Scan and Sync Features

(SHP3TR215G20) ............................................................................... 799.00

ATW-A49
UHF LPDA Antennas (Pair)

  » LPDA (Log Periodic Dipole Array) Antenna
  »  Designed for Use with Audio-Technica UHF

Wireless Systems » 440-900MHz Range
  » Directional Coverage Pattern
  » Beam-Width of 90 Degrees
  »  Ideal for Use in Theatrical and Musical

Performances » Sold in Pairs

(AUATWA49) ...................................................................................... 329.00

UA874
Active Directional Antenna

  » Directs a Cardioid Pattern toward Target
  » Four-Position Gain Selector Switch
  » Low-Noise Signal Amplifi er
  » Makes Up for Coaxial Transmission Loss
  » Integrated Threaded Adapter
  » Mounts Easily to Microphone Stands
  » 470-698 MHz

(SHUA874US) .................................................................................... 308.40

R300-HD
Wireless UHF Microphone System

  » Frequency B and C
  »  Handheld Transmitter 

with PL22 Capsule
  » 32 Preset Channels
  » ClearScan Channel Selection
  » EZsync Remote Channel Syncing
  » Rugged Metal Construction

(ELR300HD) ....................................................................................... 299.00

Stage X1U
Digital Wireless USB Microphone

  » Record Wirelessly to Mac or PC Computers
  »  For Lectures, Seminars 

& Recordings
  » 100' Operating Range
  » Easy Pairing for Fast Setup
  » 2.4GHz Digital Wireless System
  » Wireless Receiver Built into a USB Stick

(SASTAGEX1U) ..................................................................................... 89.95

Stage X1U
Digital Wireless USB Microphone

Record Wirelessly to Mac or PC Computers

Wireless Receiver Built into a USB Stick

M6 PRO  Universal-Fit 
Noise-Isolating Musician's In-Ear Monitors 
with Detachable Cables
  » 10mm Moving Coil Dynamic Driver
  » In-Ear Design Reduces Outside Noise
  » Deep Bass and Clear Highs
  » Detachable Cable for Durability
  » Mic, Remote, and Volume Control Cable
  » Two Shirt Clips and 1/4" Adapter
  » Includes Spare Cable
  » 6x Pairs of Silicone Eartips

(MEM6PROCL) ..................................................................................... 49.99

SE215  Sound-Isolating In-Ear 
Stereo Earphones (Black)
  » Compact and Lightweight
  » Dynamic MicroDrivers
  » Multiple Eartips
  » Kevlar-Reinforced Detachable Cable
  » Gold-Plated Connector
  » Soft Carrying Case Included

(SHSE215K) ......................................................................................... 99.00
Clear (SHSE215CL) ............................................................................ 99.00

ew 300
IEM G3 Wireless In-Ear Monitoring System

  »  Includes SR 300 G3 Transmitter
and EK 300 G3 Receiver

  »  Includes IE 4 
In-Ear Monitors

  » Metal Construction
  » Selectable Tuning
  » Wireless Syncing

(SEEW300IEMG3) .............................................................................. 999.00

UM Pro 30  Triple-Driver Stereo 
In-Ear Headphones with Replaceable Cable 

  » Three Balanced-Armature Drivers
  » Up and Over Cable Routing for Security
  »  20 Hz to 18 kHz Frequency Response
  » Sensitivity of 124 dB SPL
  » Braided Aramid-Reinforced Cable
  » Durable and Replaceable MMCX Cable
  » Includes Silicone and Foam Ear Tips
  » Includes Monitor Vault and Cleaning Tool

(WEUMPRO30) .................................................................................. 399.99

Concert 288 All-in-One
Dual-Channel UHF Wireless System

  » CR288 Wireless Receiver
  »  Handheld Transmitter 

& Q6 Dynamic Mic
  » Beltpack Transmitter
  »  LM5 Lavalier Mic and 

HS5 Headset Mics
  »  300' Operating 

Range

(SASWC288ALLH) .............................................................................. 329.99

CR288 Wireless Receiver
 Handheld Transmitter 

Beltpack Transmitter
 LM5 Lavalier Mic and 

UHF-5800 PRO
4-Channel UHF Wireless Handheld Mic

  » Channels: I/J/K/L
  »  567.1 - 593.5 MHz

UHF Band
  »  4 x Handheld

Transmitter Mics
  »  Module Replaceable 

Receiver
  » 4 x Discrete Outputs & Stereo Out » 12-Hour Battery Life

(VOUHF58006) ................................................................................... 449.00

PDWM1904
Single-Channel Wireless 

System with Headset & Lavalier Microphones

  » 8 Selectable UHF Channels
  » RF & AF Signal Indicators
  » Operating Range of 164’
  » Multiple System Use 
  » Simultaneous Output Use

(PYPDWM1904) ................................................................................... 74.25
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ZLX Series
Two-Way Powered Loudspeakers

The ZLX series makes it easier than ever to own and experience 
premium pro audio. Its combination of streamlined industrial 
design, compact size, user-friendly operation and portability, 
and plentiful power have made it the go-to choice for monitors 
and mains in DJ/musician applications such as practice spaces 
and small clubs. It is also great for basic installations and
portable multi-purpose sound.

ZLX-12P-US 12" (ELZLX12PUS) .......................................................................................................................399.00
ZLX-15P-US 15” (ELZLX15PUS) .......................................................................................................................499.00

ELX200 Series
Two-Way Powered Loudspeakers

12" 2-way 1200W powered speaker designed to provide 
dependable amplifi cation, fl exible installation, and 
convenient control for sound engineers and performers. 
It features 1200W of Class-D amplifi cation, which drives 
a 12” woofer and a 1” titanium high-frequency 
compression driver, a frequency range of 51 Hz to 20 kHz.

EON600 Series
Powered Speakers

Completely rethinking how truly good an 
affordable self-contained, portable PA system 
can be, JBL engineers purposely designed and 
built the EON600 from the ground up featuring 
JBL’s advanced waveguide technology, JBL 
designed and manufactured transducers, and 
convenient, wireless remote control of its 
onboard DSP EQ parameters via Bluetooth.

SRX800 Series
Self-Powered Speakers

SRX800 breaks new ground, bringing together JBL’s 
premium transducers and enclosures, Crown’s Proprietary 
Front-End DriveCore Technology, user-confi gurable DSP, 
and full HiQnet Network control compatible with a variety 
of platforms. Each SRX800 Series component delivers a 
perfectly tuned system that is powerful, easy to use, and 
rugged enough for the most demanding applications. 

B200D Series
Active Loud Speakers

  »  High-Power 550W 2-Way PA Sound 
Reinforcement Speaker System

  » For Live and Playback Applications
  »  Ultra-Compact and Lightweight System
Delivers Excellent Sound Even at Extreme
Sound Pressure Levels

JRX200 Series
Loudspeaker System

JRX200 delivers the performance and prestige JBL is known 
for at an affordable price point. With performance, value 
and popular price points, JBL built the JRX200 speakers. 
This means JBL can apply effi cient, high-volume production 
methods and purchase materials at the lowest cost. That's 
how JRX200 delivers unprecedented value.

F1 Model 812 
Array Loudspeaker

The fi rst powered portable loudspeaker that lets you control 
its vertical coverage pattern. Simply choose among four 
different settings. Whether you’re playing at fl oor level, 
on a stage, or facing raked seats or bleachers, you can 
now adapt your PA to match the room.

(BOF1FALS) ..................................................................................................................................................... 1,199.00
F1 Powered Subwoofer (BOF1SW) ............................................................................................................... 1,199.00

B200XL Series
2-Way Passive PA Speakers

A 2-Way Passive PA Speaker is a full-range loud speaker capable of handling 
800W peak power (200W continuous). It features a 12" woofer, a 1.75" titanium 
driver, and 1/4" phone and Speakon connections.
Built tough and capable of handling the rigors of life on the road, it is easily 
mounted onto a 3.5mm speaker stand, placed on the ground or onto its side 
for stage monitoring applications. Musicians, DJs, and sound afi cionados 
will fi nd the B212X speaker a fl exible choice in sound reinforcement.
(BEB212XL) .........................................................................................................................................................159.99
B215XL 1000W 2-Way Passive PA Speaker with 15" Woofer and 1.75" Driver (BEB215XL) .....................219.99

B210D 10” (BEB210DB) ................................. 199.99
B210D 12” (BEB212DB) ................................. 249.99 B215D 15” (BEB215DB) ................................. 329.99

12” (ELELX20012PU) ....................................... 599.00
ELX200-10P-US 10” (ELELX20010PU) .......... 549.00
ELX200-15P-US 15” (ELELX20015PU) .......... 699.00

12" Subwoofer (ELELX20012SU) .................... 649.00
18" Subwoofer (ELELX20018SU) .................... 799.00

EON610 10" (JBEON610) ............................... 399.00
EON612 12” (JBEON612) ............................... 449.00
EON615 15” (JBEON615) ............................... 499.00

SRX812P 12" (JBSRX812P) ........................1,299.00 SRX815P 15" (JBSRX815P) ........................1,399.00

JRX212 12" (JBJRX212) ................................ 249.00
JRX215 15" (JBJRX215) ................................ 299.00

JRX218S 18" Compact
 Subwoofer (JBJRX218) ............................. 499.00

PRX800W Series
Powered Speakers with Wi-Fi

The most advanced PA in its class. Wi-Fi technology 
and sophisticated DSP give you complete control 
over system tuning and performance via the free PRX 
Connect app. An effi cient 1500-watt class-D amplifi er 
and patented JBL Differential Drive technology provide 
best-in-class power and reduced weight. Designed to 
deliver legendary JBL sound for bands, DJs, and more.

PRX812W 12" (JBPRX812W) ........................ 749.00
PRX815W 15" (JBPRX815W) ........................ 849.00

Subwoofers
PRX815XLFW 15" (JBPRX815XLFW) ............ 999.00
PRX818XLFW 18" (JBPRX818XLFW) .........1,099.00 SRX818SP 18" Subwoofer (JBSRX818SP) .................................................................................................. 1,599.00

HX-5B Variable Dispersion 
Line Array Speaker (Black)

The HX-5B is a 2-way compact speaker system that permits both constant 
directivity control over a wide frequency range and changes in directivity. It 
is ideal for reproducing clear sound in spaces with long reverberation times 
or high background noises. Features include high power handling (600 
watts continuous), lightweight polypropylene construction, available
in black and white, plus Speakon and screw terminal connectors. The
HX-5B can be vertically or horizontally mounted with the built-in bracket
or with optional wall, ceiling, and stand-mount hardware.

HX-5B Black (TOHX5B) ......................Call or Log-On HX-5W White (TOHX5W) ....................Call or Log-On
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K.2 Series
2000-Watt Powered Speakers 

QSC has created a spectrum of active loudspeakers 
designed with one common goal –accurate acoustical 
performance for the widest selection of applications. 
Ranging from a compact and potent 8", two-way utility 
loudspeaker to a fi xed-arcuate line array system, 
all K Family models feature common power modules, 
DSP, and performance characteristics – irrespective of their size or confi guration.

The Mackie SRM is the most widely used portable loudspeaker 
ever. It’s unparalleled ease-of-use, professional sound quality, 
and indestructible portability has made it a live sound legend. 
Now with more power and fl exibility than ever, SRM is the 
ultimate portable PA system. It features modern tools like 
application-specifi c speaker modes and an automatic feedback 
destroyer, each with a single-button interface.

Thump Series
Powered Loudspeaker

1300W 12" powered loudspeaker with a redesigned 
amplifi er with Dynamic Bass Response, which 
provides chest-thumping low end for a variety of 
applications including rehearsal studios, small 
bars and coffee shops, small night clubs, karaoke 
events, weddings, houses of worship, fi tness 
centers, and mobile DJs.

Art 3 Series Series
2-Way 800W Active Speaker

Part of the Art 3 Series MK4 line of speakers, the 
RCF ART 312-A MK4 is a lightweight (at 37 lb) and 
portable active speaker designed to deliver full-range 
sound with accurate high frequencies and controlled 
deep bass, for live sound reinforcement, distributed 
sound systems in clubs, corporate events, or mobile 
DJ setups.

DSP, and performance characteristics – irrespective of their size or confi guration.

KW Series
Powered Speakers

The KW Series has been primarily designed for portable 
audio reinforcement. This includes a variety of uses 
in reinforcement for entertainers and presenters. The 
KW122 & KW152 are designed to perform well on their 
own in full-range audio. They can be used singly, in 
stereo pairs or in distributed or delayed systems. The
KW122 may also be used as a stage monitor or can be suspended both vertically and horizontally. 

Truesonic 2 Series 
Two-Way Powered Speaker

Designed with both the musician and the live sound engineer in mind, 
this 10", 2-way powered loudspeaker is capable of handling 550W RMS 
of output power. Its design is angled for use in on-stage monitoring situations, 
but it also features M10 suspension points for stand- and pole-mounting. 
Onboard mixer with two combo inputs for XLR and 1/4" connection points
and capable of handling an SPL of 122 dB (and a coverage range 
of 90° by 60° to boot) this monitor boasts a frequency range of 48 to 22 kHz.
TS210 10" (ALTS210XUS) ..................................................................................................................................249.00

DXR Series
1100W 2-Way Active Loudspeaker

Clear audio and extremely high output levels in 
an unobtrusive and durable design and ideal for live 
sound that requires wide bandwidth audio reproduction. 
The cabinet has a rugged ABS construction with a 
bass-refl ex design for bass performance with reduced
turbulence. The speaker has a biamplifi ed design that provides a peak output power of 1100W. The 
speaker can be placed on a fl oor or stage but also has useful mounting options.

DBR Series
2-Way Powered Loudspeaker

The most portable powered loudspeakers Yamaha has to offer, 
the versatile DBR Series ensures high-resolution sound at any 
output level. Comprised of 10”, 12” and 15” models, each DBR 
loudseaker is housed in a newly designed, durable, lightweight 
cabinet optimized for FOH sound, fl oor-monitoring and even rigged
applications. Whether you're powering your band’s live performance, DJ-ing a party, or MC-ing an event, be 
prepared for DBR Series speakers to take your performance to the next level.

KLA Series
Line Array Loudspeakers

The KLA Series brings the power and sophistication of a line array system into 
an easy-to-use product signifi cantly redefi ning the line-array-product category. 
With its simple Lift, Click, and Play approach, KLA deploys in a fraction of the 
time required by comparable line array products. This fi xed arcuate, active line 
array system is ideal for a wide range of portable and permanently installed 
applications ranging from live entertainment to houses of worship or other
venues where a line array system is desired.

KLA12 12" (QSKLA12B) ...................................................................................... 1,759.99
KLA181 18" Subwoofer (QSKLA181B) ............................................................... 2,149.99

C Series
Passive Loudspeakers

Experience the same Mackie sound quality heard from the 
legendary SRM Series Powered speakers in an incredibly 
versatile passive design. C Series loudspeakers are built 
with rugged road worthy molded cabinets, custom-designed 
high-output drivers and a precision-tuned asymmetrical 
crossover for natural, high-fi delity sound. C Series will 
devlier the sound you need, night after night.

C200 10" (MAC200) ...........................................................................................................................................199.99
C300Z 12" Compact (MAC300Z) .......................................................................................................................349.99

SRM350 10"  (MASRM350V3) ...........................................................................................................................399.99
SRM450 12"  (MASRM450V3) ...........................................................................................................................499.99

DXR8  8"  (YADXR08) ...................................... 549.99
DXR10  10"  (YADXR10) ................................. 599.99

DXR12  12"  (YADXR12) ................................. 699.99
DXR15  15"  (YADXR15) ................................. 799.99

TS212  12"  (ALTS212XUS) ............................. 299.00
TS212W  12"  (ALTS212WXUS) ...................... 349.00

TS215  15"  (ALTS215XUS) ............................. 349.00
TS215W  15"  (ALTS215WXUS) ...................... 399.00

Thump12A 12” (MATHUMP12A) ..................... 299.99
12BST Boosted 12” (MATHUMP12BST) ......... 399.99

Thump15A 15” (MATHUMP15A) ..................... 349.99
15BST Boosted 15” (MATHUMP15BST) ......... 499.99

Art 312-A MK4 12” (RCART312AMK4) .......... 599.00
Art 310-A MK4 10” (RCART310AMK4) .......... 499.00 Art 315-A MK4 15” (RCART315AMK4) .......... 649.00

KW122 12" (QSKW122) ..............................1,099.99
KW152 15" (QSKW152) ..............................1,199.99

KW153 15" (QSKW153) ..............................1,439.99
KW181 18" Subwoofer (QSKW181) ...........1,399.99

K8.2 8” (QSK82) .................................................. 649.99 K10.2 10” (QSK102) ........................................ 699.99
K12.2 12”  (QSK122) .........................................................................................................................................799.99

SRM V3 Series
Powered Loudspeakers

DBR10  10"  (YADBR10) ...................................... 399.99 DBR12  12"  (YADBR12) .................................. 499.99
DBR15  15"  (YADBR15) ....................................................................................................................................599.99
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Pathfi nder
Waterproof Rechargeable Speaker System

  » Rugged, Waterproof Construction
  » 100W Speaker
  » Built-In Bluetooth Receiver
  » Built-In 75-Hour Rechargeable Battery
  » Microphone Input, Mic & Cable Incl.
  » Aux Input for MP3 Players, Smartphones
  » LED Light Bar for Light Effects
  » Built-In Digital AM/FM Radio
  » Telescoping Handle, Wheels, Side Handles

(IOPATHFINDER) ................................................................................ 179.99

Escort 6000
Portable PA System

  » 600W Output
  » Portable Design
  » Digital Multi-Effects
  » Feedback Locating System
  » 2 Folding Speaker Stands
  »  Case with Luggage

Wheels

(PEESCORT612U) ............................................................................... 799.99

CM-30
CUBE Active Monitor Speaker

  »  30 Watt Output
  »  6.5" Coaxial 2-Way Speaker 

with Stereo Preamp
  »  3 Input Channels with XLR Mic or Line, 

2 Aux Inputs for CD or Effects Processors
  »  Metal Grille Cover for Speaker
  »  All-Metal, Recessed Carrying 

Handle for Easy Transportation

(ROCM30) ...........................................................................Call or Log-On

Passport CONFERENCE
Self-Contained Portable Audio System (175W)

  »  For Small- to Medium-Sized 
Audiences

  »  Detachable Speakers with 
5.25" Woofers

  » 5-Channel Powered Mixer
  » 3 XLR Inputs
  » Headphone Output
  » Speaker Cables

(FEPC175W) ...................................................................................... 399.99

EON206P  Portable 6.5" Two-Way PA 
System with Detachable Powered Mixer

  »  Weighs Only 25 lb for Portability
  » 100° Horizontal x 80° Vertical
  »  160-Watt Class D Amplifi er
(80W/Side)

  »  Two Powered Speakers 
with 6.5" Woofers

  » 1" Neodymium Compression Drivers
  »  One Six-Channel Powered Mixer » Combo 1/4" XLR Connector 
on Two Channels » Treble, Bass, Reverb Controls

(JBEON206P)..................................................................................... 449.00

EON ONE  All-in-One 
Linear Array PA System

  » 380W of Power » 118 dB Maximum SPL
  » 10" Low Frequency Woofer
  » 6x 2" High Frequency Drivers
  » Six Channel Mixer with Bluetooth Audio
  » Two Channels of Mic/Line Inputs with EQ
  » Channels 3 & 4: Stereo 1/4" or RCA
  » Channels 5 & 6: 1/8" Stereo Input
  » Compact Design for Portability
  » Includes 2 Height Spacers

(JBEONONE) .................................................................999.00

iNSPIRE iP500  Powered 
Column Loudspeaker with 8" Subwoofer

  » Full-Range Powered Speaker
  » 8" Low Frequency Driver
  » Six 2" Neodymium HF Drivers
  » 600W Class AB & Class D Amplifi ers
  » Spatial Sound Technology for 3D Sound
  » 100° Dispersion » Bluetooth Audio Streaming
  » Digital Mixer with DSP
  » Free iOS Control App
  » Includes Carrying Bag

(TUIP500) ..........................................................................499.99

L1  Compact Line 
Array PA Speaker and Mixer System

  »  Sleek Line Array Speaker
  » Integrated Mixer & Amplifi er Base
  » Compact Speaker with Full Tone
  » Direct & Off-Axis Audio Balance
  » Lightweight Easy Setup
  » Microphone and Line Inputs
  » Adjustable Speaker Positioning

(BOL1) .........................................................................999.00

Envoi  
Portable Battery-Powered Speaker System

  »  10" Woofer and 1" Compression HF Driver
  » 2-Way Active Speaker System
  » Dual Mic Combo Inputs
  » Includes Wireless Handheld Microphone
  » 240W (AC Power), 160W (DC Power)
  » Bluetooth Receiver
  » 2-Band EQ and Reverb Effect
  » Built-In 12-Hour Rechargeable Battery
  » Built-In MP3 Player for SD Card and USB

(DEENVOI) ......................................................................................... 349.99

STAGEPAS 600i  
Portable PA System

  » Dual Speakers & 10-Channel Mixer
  » 680W Total Output » Portable Design
  »  XLR, Combo XLR/TRS, 

Hi-Z & RCA Inputs
  »  USB Port for 

Connecting iOS Device
  » 3-Band EQ per Channel
  » Built-In Reverb & One-Knob Master EQ
  » Stereo Monitor & Subwoofer Outputs » Feedback Suppressor

(YASP600I) ........................................................................................ 899.99

Passport EVENT
Self-Contained Portable Audio System (375W)

  »  For Medium-Sized Audience
  »  Detachable Speakers 

with 8" Woofers
  » 7-Channel Powered Mixer
  » 4 XLR Inputs
  » Hi-Z Guitar Input
  » Bluetooth Input
  » Sub Output
  » Headphone Output » Cables

(FEPE375W) ...................................................................................... 699.99

Passport VENUE
Self-Contained Portable Audio System (600W)

  »  For Larger-Sized Audiences
  »  Detachable Speakers 

with 10" Woofers
  » 10-Channel Powered Mixer
  » 4 XLR Inputs
  » 2 Instrument/Line Inputs
  » USB Flash Drive Connectivity
  » Sub Output
  » Headphone Output » Cables

(FEPE600W) ...................................................................................... 999.99

Built-In 75-Hour Rechargeable Battery

Aux Input for MP3 Players, Smartphones

Eurolive B205D  Active PA 
and Monitor Speaker System

  » 150 Watts
  » Mic Stand Mountable
  » Mic and Line Inputs
  » 3-Band EQ
  » +48V Phantom Power
  » XLR Thru Connection

(BEB205D)......................................................................................... 199.99

PA-5150
5" 150W Portable PA System

  » Rugged and Portable
  » 150W of Power
  »  Built-In Effects and 3-Band 

Equalizer
  » Integrated 3-Channel Mixer
  »  Includes Mic Stand Mounting 

Adapter » Mic Boom Adapter
  » AC Power Cord

(POPA5150) ....................................................................................... 179.99

SRM150
5" Compact Active PA System
  »  This is a combination of Mackie's 

mixer and SRM active 
loudspeaker in an attractive, 
tiny PA system which is not 
only portable but also powerful.

  »  Built-in, three-channel mixer 
has two combo XLR/line inputs, 
a stereo channel for CD/MP3, 
and a powerful three-band active EQ.

(MASRM150) .................................................................................... 249.99

 This is a combination of Mackie's 

Feedback Locating System
2 Folding Speaker Stands

 Weighs Only 25 lb for Portability

1" Neodymium Compression Drivers

Dual Speakers & 10-Channel Mixer
Portable Design
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PWMA200
Wireless Portable Amplifi er 

  » Wireless Rechargeable Amplifi er
  »  Lavalier Mic with 

Bodypack Transmitter
  » Bonus Wired Microphone
  »  All-in-One Design for Easy 

Carrying and Portable Use
  » FM Radio Function
  » Works on Both AC & DC

(PYPWMA200) ..................................................................................... 64.49

Wireless Rechargeable Amplifi er

PMP20
Compact Professional 

20W Power Megaphone
  » Maximum Power Output of 20W
  »  2 Audio Functions: 
Voice & Siren Mode

  » Voice Mode: Amplifi es Your Voice
  »  Siren Mode: Amplifi es an Alert 
Siren Tone through the Megaphone Speaker

  » Ergonomic Pistol Grip and Lightweight Chassis
(PYPMP20) .......................................................................................... 10.92
PMP35R 35W Megaphone & Bullhorn (PYPMP35R) ...................... 15.47

Siren Tone through the Megaphone Speaker
Ergonomic Pistol Grip and Lightweight Chassis

PA-15W Waistband Amp. 
with Head-Worn Microphone, 
TF Card Slot, & USB Port

This portable unit clips on your waistband 
for hands-free public speaking. You can use 
it indoors or outdoors, such as at meetings, 
school programs, sporting events, fi eld trips, 
assemblies, lunch, playground duty, and more. 
It uses an included rechargeable lithium battery.

(HAPA15W) .......................................................................................... 61.95

ER-1215S 
23-Watt Hand-Grip Megaphone

  »  23-Watt Siren-Equipped 
Megaphone with Over 1000' 
Range for Voice, 1640' for Siren

  » Anti-Bacterial Treatment
  » Durable ABS resin Construction
  » Polyimide Diaphragm
  »  Long-Lasting 14-Hour Operating Life from 
6 Standard "C-Cell" Batteries for Voice Operation

(TOER1215S) ....................................................................................... 86.00

with Head-Worn Microphone, 

assemblies, lunch, playground duty, and more. 
It uses an included rechargeable lithium battery.

PWMA50 Waistband
Portable PA System (Black)

  » Small Super Powerful Voice Amplifi er
  »  Used by Teachers, Coaches, Tour 
Guides, Presenters, US Army

  » Projection Range Up to 1/2 Mile
  » Includes Headset Microphone
  »  Built-In Rechargeable Lithium Batteries
  » AUX Input for MP3 Player or iPod » Charging Time: 6 Hours

(PYPWMA50B) ..................................................................................... 29.00
Silver (PYPWMA50S) ...........32.89 White (PYPWMA50W) ..........25.41

PWMA60UB
Waistband Portable

PA System (Black)

  » 50 Watts
  » USB Input for Playing Audio Files
  » Includes Headset Microphone
  » Built-In Rechargeable Batteries
  » Full-Range Sound
  » Powered Up to 12 Hours

(PYPWMA60UB) ................................................................................... 38.87

Small Super Powerful Voice Amplifi er

AN-Mini
Portable Speaker Monitor

  » Compact, Lightweight, and Portable
  » Powerful 4.5" Neodymium Driver
  » Built-In 30W Amplifi er
  »  Dual Mic Inputs - One 1/4" 

and One 3.5mm Powered
  »  Mini Line Input for Connecting a

CD Player, MP3 Player, or Instrument
  » Operates via AC Power or 10 AA Batteries

(ANANMINIBK) .................................................................................. 202.00

Lite-BP MiniVox Lite
Portable PA System

  » Battery Operated
  » Weighs under 3 Pounds
  » Neodymium Driver
  » Mic/Line Inputs
  » Soft Carrying Case
  » Wired Mic
  » Recharge Kit

(ANLITEBPB) ..................................................................................... 342.00

Weighs under 3 Pounds
Neodymium Driver
Mic/Line Inputs
Soft Carrying Case

ER-1000
Personal Public Address System

  » 6-Watt & 10-Watt Modes
  » Cover over 240' Distance in 6W Mode
  » Lightweight Waistband Design
  » Head-Worn Microphone
  » Aux Input
  » Easily Cover Over 240'
  » Power: 6 AA Batteries

(TOER1000WR) .................................................................................. 223.00

PA25R Megaphone
with Detachable Microphone

  » Durable ABS Plastic Construction
  »  25W of Output Power
  » 1250' Effective Range
  » Detachable Microphone 
  » 10-Second Record & Playback
  » Integrated Volume Control
  » Battery Life Up to 4 Hours with 8 “C” Batteries
  » Detachable Shoulder Strap Included  » Siren Mode

(CAPA25R)........................................................................................... 72.95

Dispatch
Mobile PA System with Bluetooth

  » 20W Peak Output
  » 5" Woofer » 1" Tweeter
  » Bluetooth: A2DP
  » Water-Resistant: IPX4
  » Rechargeable Battery
  » Battery Life: 50 Hours
  » Recharge Time: 5.5 Hours
  » Includes Strap, Microphone, Aux Cable
  » Charging Adapter Included

(DEDISPATCH) ..................................................................................... 59.00

Battery Life Up to 4 Hours with 8 “C” Batteries

PMP59IR
50W Megaphone/Bullhorn 

with Lithium Battery

  »  Modes: Talk, Siren, Record
  » Recording Function: 10 sec
  » Aux Input: 1/8" for Audio
  » Maximum Power Output: 50 W
  » Range: 3600'
  » Ergonomic Pistol Grip
  » Includes Lithium Battery and Charger

(PYPMP59IR) ....................................................................................... 54.24

MP-25 Megaphone with Siren,
MP3 Player & Microphone

  » 1,500-Yard Audible Range
  » 25W of Output
  » Built-In Siren & Whistle
  » Built-In MP3 Player
  » Plays Files from SD Cards & USB
  »  Detachable Microphone with Coiled Cable
  » 3.5mm Aux Input » Includes Shoulder Strap

(POMP25) ........................................................................................... 39.95

 Detachable Microphone with Coiled Cable

S602MR Mity-Meg Plus
Megaphone with Detachable Microphone

  » Effective Range: 1760 yd / One Mile
  » Interchangeable Power Source
  » 25W of Output
  » Built-In Siren & Whistle
  » Battery Indicator Lights
  »  Weatherproof, Durable 

ABS Construction

(AMS602MR) ..................................................................................... 138.98

Interchangeable Power Source

HPA40
40W Handheld PA System

  » Convenient Battery and Shoulder Strap Compartment
  » Ultra-Compact » "Wireless Ready"
  » 5" Full-Range Loudspeaker
  » 8-Hour Rechargeable Battery
  » AC & Battery Operated 
  » Mic and Auxiliary Inputs
  »  Includes Microphone, Cable, 

Charger, and Mic Stand Adapter

(BEHPA40) ........................................................................................... 99.99

"Wireless Ready"

 Long-Lasting 14-Hour Operating Life from 
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XLS Series
DriveCore Stereo Power Amplifi ers

  » Lightweight Rackmount Design
  » DriveCore Technology
  » XLR, 1/4”, and RCA Inputs
  » Speakon and Binding Post Outputs
  » Integrated PureBand Crossover System
  » Individual Level Controls » Forced-Air Cooling Fans » LED Indicators

XLS 1002 350W/Channel (CRXLS1002) ...........299.00
XLS 1502 535W/Channel (CRXLS1502) ...........399.00

XLS 2002 375W/Channel (CRXLS2002) ...........499.00
XLS 2502 775W/Channel (CRXLS2502) ................ 599.00 

XLi 800
Stereo Power Amplifi er

  » 300W per Channel at 4 Ohms
  » 200W per Channel at 8 Ohms
  » 600W at 8 Ohms Bridged Mono
  » Stereo/Parallel/Bridge-Mono Mode
  » User Selectable Input Sensitivity » Balanced RCA and XLR Inputs
  » Binding Post and Speakon Outputs » Forced Air Cooling » LED Indicators
  » Short, No-Load, On/Off Thump Protection

(CRXLI800) ..........................................................................................................................................................229.00

CSMA 1120
Commercial Series Mixer/Amplifi er

  » For Commercial and Industrial Use
  » 120W into 8- or 4-Ohm Loads
  » 15W per Channel
  » 4 Input Channels, 1 Output Channel
  » Usable with 70 & 100V Systems
  » Mic/Line & RCA Inputs
  » Hi-Z & 27V Phantom Power Switches
  » Sleep Mode & Auxiliary Output » Voice-Activated Ducking & Priority Mute

(JBCSMA1120) ....................................................................................................................................................599.00

PTA1000
250W Stereo Power Amplifi er

  » Rackmount Design
  » Stereo and Bridged Modes
  » XLR and 1/4” Inputs
  » Dual-Speed Cooling Fans
  » Speakon and Binding Post Outputs
  » Protection Circuitry » Selectable Operating Voltage
  » Individual Level Control Knobs and LED Indicators for Power, Signal, Clipping, Protection, and Volume

(PYPTA1000).......................................................................................................................................................... 94.12

Pro-LITE Series
Power Amplifi er

  » Automatic Clip Limiting
  »  2 Front Panel Attenuators, 

Crossover Select Switch 
  » Inputs: Dual Combination 1/4” XLR
  » Outputs: Three Speakon Connectors 
  » Temperature-Dependent Variable Speed Fan

Pro-LITE 3.0 830W (CRPL30A) ........................................................................................................................479.00
Pro-LITE 5.0 5000W (CRPL50A) .......................849.00 Pro-LITE 7.5 7500W (CRPL75A) ...................1,049.00

SLA-4
Studio Linear Power Amplifi er

  » 1RU Design » Multiple Operating Modes » Toroidal Transformer
  » 1/4" and Euroblock Inputs » Binding Post Outputs » Silent Cooling System

(ARSLA4) ............................................................................................................................................................399.00

GX Series
8-Ohm Power Amplifi er

  » XLR, 1/4” , and Phono Inputs
  » SpeakonÆ Combo Outputs
  » QSC GuardRail Protection
  » Ideal for Driving Sub-Woofers
  » Optimized for 4- and 8-ohm Speakers » Subwoofer/Satellite Crossover Built-In

GX3 300 Watt (QSGX3) .....................................................................................................................................299.99
GX5 500 Watt (QSGX5) .....................................................................................................................................399.99
GX7 725 Watt (QSGX7) .....................................................................................................................................599.99

iNUKE NU4-6000 Ultra-Lightweight
High-Density 6000W 4-Channel Power Amplifi er

  » High-Density Class-D Amplifi er
  »  Built-In Subwoofer-Satellite Crossover
  »  DC, LF, and Thermal Overload Protection
  »  Quad Mono, Dual Stereo, Dual Mono Bridge
  » XLR and 1/4” TRS Input Combo Connectors
  » Professional Speakon Connectors » Back-to-Front Ventilation System

(BENU46000) .......................................................................................................................................................349.99
iNUKE NU1000DSP with DSP/USB, 150W/Channel (BENU1000DSP) ........................................................199.99

EuroPower EPQ304
4-Channel Power Amplifi er

  » 50W/Channel @ 8 Ohms » All-Steel 1RU Rackmount  » ATR Technology
  » Switchable Limiters » Back-to-Front Airfl ow with Filter » Protection Circuitry
  » XLR/TRS Combo Inputs » Speakon Outputs » Detented Gain Controls » Indicator LEDs

(BEEPQ304).........................................................................................................................................................229.99

XLi 1500 (CRXLI1500) ..................................... 299.00 XLi 2500 (CRXLI2500) ..................................... 399.00

Servo Series
Power Amplifi er

  » 1/4" and RCA Input Connectors
  » 5-Way Binding Post and 1/4" Outputs
  » Dual Rack Space Design
  » 10-Segment, 3-Color Level LED Meters
  » Dual Variable Speed Cooling Fans
  » 4-Stage Power Protection Circuitry

SA120 60W/Channel (SASA120) ......................199.00 SA200 100W/Channel (SASA200) ....................199.99
SA600 300W/Channel (SASA600) ...................................................................................................................329.99
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ProFX16v2
Sound Reinforcement Mixer with Built-In FX

  » 16 Input Channels
  »  10 Low-Noise Mackie 
Vita Mic Preamps

  »  USB Recording to 
Computer (Mac & PC)

  » Dual 7-Band Graphic EQ
  » 16 FX Including Reverb, Delay & Chorus
  » Monitor & FX Sends, Stereo & FX Returns

(MAPROFX16V2) ................................................................................ 449.99

Dual 7-Band Graphic EQ
16 FX Including Reverb, Delay & Chorus
Monitor & FX Sends, Stereo & FX Returns

ProFX12v2
Sound Reinforcement Mixer with Built-In FX

  »  12 Input Channels » 6 Low-Noise 
Mackie Vita Mic Preamps

  » USB Recording to Computer 
  »  16 FX Including Reverb, 

Delay & Chorus
  » Per Channel  3-Band EQ
  » Monitor & FX Sends, Stereo & FX Returns » Hi-Z Input

(MAPROFX12V2) ................................................................................ 249.99

6 Low-Noise 

EPM 8
8 Mono + 2 Stereo Audio Console

  »  8 Mono & 2 Stereo 
Input Channels

  »  8x GB30 Microphone 
Preamplifi ers

  »  Recording and Live 
Sound Audio Console

  » Compact Mobile Enclosure
  » Comprehensive Controls

(SOEPM8) ......................................................................................... 299.00

PMP4000
16-Channel Powered Mixer

  » 1600 Watts
  » 8 Mono Line / Mic Channels
  » 4 Stereo Line Channels
  » 24-Bit Effects Processor
  » 7-Band Graphic EQ
  » Ultra-Compact Design
  » FBQ Feedback Detection

(BEPMP4000) .................................................................................... 499.99

8 Mono Line / Mic Channels

EMX-5
12-Input Powered Mixer

  » Integrated 1260 W Power Amplifi er
  » 8 Mono Mic/Line Inputs
  » Four Stereo Inputs
  » Hi-Z Input on Channel 4
  »  Two Aux Sends 

with Dedicated Outputs
  » 3-Band EQ on Each Channel
  » Master EQ for Music Playback or Speech

(YAEMX5) .......................................................................................... 599.99

EMX2
10-Input Powered Mixer

  » Integrated 500 W Power Amplifi er
  » Four Mono Mic/Line Inputs
  » Three Stereo Inputs
  » Hi-Z Input on Channel 4
  » Independent Monitor Output
  » 3-Band EQ on Each Channel
  » Integrated Feedback Suppressor
  » Built-In Reverb » Compatible with 4- and 8-Ohm Speakers

(YAEMX2) .......................................................................................... 399.99

Integrated 1260 W Power Amplifi er Integrated 500 W Power Amplifi er

PMX402M 400-Watt 4-Channel 
Powered PA Mixer/Amplifi er 

  »  USB 2.0 Port for MP3s 
with LCD Display

  »  Built-In Effects with 
Level Controls

  » 400 Watts of Power, 4 Channels
  »  Plays MP3 & WMA Files from 
USB Devices

  » Stereo RCA Inputs & Outputs
(PYPMX402M) ................................................................................... 131.72

Europower PMP550M 5-Channel
Powered Rackmount Mixer

  »  2x 250W Built-In 
Class D Amplifi er

  »  7-Band Master 
Graphic EQ

  » 5 Mic & Line Inputs
  » 2-Band EQ per Channel
  » Feedback Detection Klark Teknik FX with 25 Presets
  » Wireless Ready » Rackmount Brackets Included

(BEPMP550M) ................................................................................... 199.99

X Air XR12 12-Input Digital Mixer
for Tablets with Wi-Fi & USB Recorder

  »  Built-In Wi-Fi Module
  »  IOS, Android, Mac, PC,

Linux Control
  »  Midas-Designed 

Mic Preamps
  » XLR Outputs »  X32 FX Rack with 4 Stereo FX Slots
  » USB Connectivity for Storage » Records Audio via USB

(BEXR12)........................................................................................... 249.99
X Air XR16 16-Input Digital Mixer (BEXR16) ................................ 399.99
X Air XR18 18-Input Digital Mixer (BEXR18) ................................ 599.99

2-Band EQ per Channel

AFS2 Advanced
Feedback Suppression Processor

  » Stereo or Dual-Channel Processing » Wizard Setup Function
  » Full LCD Display » 24 Programmable Filters per Channel
  » Live and Fixed Filter Modes » Selectable Filter Lift Times
  » Application Specifi c Filter Types » Input Channel Metering
  » 24 LED per Channel Filter Metering

(DBAFS2) .......................................................................................... 299.95

DriveRack VENU360
3x6 Speaker Management System

  » dbx Compression & Limiting 
  » Advanced Feedback Suppression » Driver Alignment Delays
  » 31-Band Graphic EQ »  12-Band Parametric EQ 
  » Subharmonic Synthesis » Backline Delay » Noise Gate
  » Android, iOS, Mac & Windows Control

(DBVENU360) .................................................................................... 799.00

DriveRack 260
Loudspeaker Management System

  » EQ, Filtering, Polarity, and Delay » Gain and Crossover Control
  »  Compression and PeakStopPlus Limiters » Graphic and Parametric 
Equalization » Feedback Elimination » Pink Noise Generator and 
Full-Time RTA » 2.7 Seconds of Alignment and Zone 
Delay » Built-In Sub-Harmonic Synthesizer » Security Lockout

(DB260) ............................................................................................. 599.95

SHARK FBQ100
Automatic Feedback Destroyer

  » Delay Line, Noise Gate, and Compressor
  » Integrated Mic Preamp
  »  Destroys up to 

8 Frequencies
  » Balanced XLR and 1/4” I/O
  » Narrow FBQ Filters
  » Subsonic Filter

(BEFBQ100) ......................................................................................... 99.99

PMP500MP3  Ultra-Compact 500W 
8-Channel Powered Mixer

  »  Enormous Power, Incredible 
Sonic Performance, and 
Super-Lightweight

  »  High-Performance MP3 
Player Included to Play 
Audio Files via USB Stick

  »  Studio-Grade Stereo Reverb
adds Finishing Touch to Your Sound

(BEPMP500MP3) ............................................................................... 199.99

DriveRack PA2 Complete
Speaker Management System

  » Crossover for 2- or 3-Way Systems
  » Loudspeaker Management » Mac, PC, iOS, & Android Control
  » AutoEQ Automatic Room EQ Function » Driver-Alignment Delay
  » Automatic Feedback Suppression » dbx Compression & Limiting
  » 8-Band Parametric EQ & Graphic EQ » Subharmonic Synthesis

(DBPA2) ............................................................................................ 399.95
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MultiMix 10 Wireless 
Rackmount 10-Channel Mixer with Bluetooth
  »  One-Button Pairing for Bluetooth Input
  »  Four XLR Mic
Inputs with
Phantom Power

  »  2 Stereo Channels 
with 1/4" TRS Inputs

  » Front-Panel Stereo Mix Output » Stereo Aux Return
  » 60mm Faders on Each Channel » Pre- and Post-Fader Aux Sends

(ALMM10W) ...................................................................................... 299.00

MX42
4-Channel Passive Mini Stereo Mixer

  »  Miniature Audio Mixer 
with 4 Stereo RCA Inputs 
and Stereo RCA Output

  »  Operate Without The Need 
for Battery or External Power

  »  Level Control Dials for Each 
Channel Are Located on the Front

(ROMX42) ............................................................................................ 49.00

MX622 
6-Channel Rackmount Mixer

  » 3 Mic/Line & 3 Stereo Line Inputs
  » Effects Loop with Stereo Return
  » 6-Channel Mixer in 1 Rack Space
  » Clip Indication LED Lights
  » Effects Loop with Independent Level Control

(ARMX622) ........................................................................................ 149.00

ZED14
14-Channel Recording and Live Sound 
Mixer with USB Connection

  »  USB Connection for 
Mac and PC

  » 14 Input Channels
  » 3-Band EQ Section
  » Four AUX Sends
  » Mono and Stereo Channels

(ALZED14) ......................................................................................... 399.00
ZED-6FX Compact Analog Mixer (ALZED6FX) ............................... 149.00

DN-410X
Rackmount Mixer with Bluetooth

  »  Bluetooth 3.0 
with Single-
Button Pairing

  »  4x High-Gain 
Mic/Line Preampsn » 4x XLR Inputs » 8x 1/4" Inputs & 3.5mm 
Stereo Input » Aux Sends & Returns for Outboard Effects

  » Front-Panel Connectivity » Multiple Output Points
  » 1/4" Headphone Output » 3U Rackmount Chassis

(DEDN410X) ...................................................................................... 299.00

MultiMix 4 USB FX
4-Channel Mixer and 
USB Audio Interface
  »  XLR Mic & 1/4" Line Inputs
  » 1/4" Hi-Z Input
  » Stereo 1/4" Outputs
  » 16-Bit/48 kHz Resolution USB Interface
  » 15 Integrated DSP Effects
  » 2-Band Channel EQ » Multi-Color LED Metering

(ALMULTIMIX4U)..................................................................Call or Log-On
MultiMix 8 USB FX 8-Channel Mixer (ALMM8USBFX) ....Call or Log-On

MG10XU 
10-Input Mixer with Built-In FX and USB

  » "D-PRE" Mic Preamps with 48V Phantom
  » 2-In/2-Out USB up to 24-Bit / 192kHz
  » 4x Mic/Line Combo Inputs
  » 6x 1/4" Line Inputs
  » Built-In FX with 24 Presets
  » TRS Monitor Outs

(YAMG10XU) ...................................................................................... 199.99
MG10 10-Input (YAMG10) ..154.99MG06 6-Input (YAMG06) ...... 99.99

"D-PRE" Mic Preamps with 48V Phantom
2-In/2-Out USB up to 24-Bit / 192kHz

199.99

LX-308B
8-Channel Stereo Line Mixer

  »  For CD Players, Keyboards, Tape, Etc. » 8-Channel
  » Rack-Mountable » Two 1/4" TRS Inputs per Channel
  » Pan/Level Control per Channel » Mute Function for Each Channel
  » 2 Mic/Line Level Switchable Chnls » Sub Input/Output
  » Mono Output » 5-Year Warranty

(ASLX308B) ....................................................................................... 610.00

MM-242
4-/8-Channel Mono/Stereo Mini Mixer 

  » Compact Design
  » Heavy-Duty Steel Construction
  » Mono/Stereo Mode Selector
  » 8 x 1/4" Line Inputs
  » 2 x 1/4" A/B Outputs
  »  Individual and Master

Volume Controls » Peak LEDs
  » Battery or External Power Options

(NAMM242) ......................................................................................... 27.64

RX1602
Rackmountable Line Mixer

  »  16-Channel Rackmountable Line Mixer with Balance and Level 
Control and +4/-10 Switching per Channel

  »  Delivers Quiet, Transparent Sonic Character Suitable for 
Professionals, While Delivering a Comprehensive Feature Set for 
Non-Professional Environments

(BERX1602) ....................................................................................... 149.99

Peak LEDs

1642VLZ4

VLZ4 Series
12-, 14- & 16-Channel Mixers

  » The 1202 and 1402-VLZ3 Have 12 or 14 Balanced Line Inputs 
  » The 16-Channel Mixers Offer 16 Switchable Line Inputs 
  »  Super Quiet XDR2 (Extended Dynamic Range) 
Mic Preamps Deliver Studio-Grade Sound

  » All Except the 1202-VLZ3 Have 60mm Tapered Faders 
  » Aux Sends, Level, Pan and PFL Solo on Each Channel
  »  3-Band Active EQ (80Hz, 2.5kHz, 12kHz), 
Control Room/Phones Source Matrix

1604VLZ4 16-Channel 4-Bus Compact Mixer (MA1604VLZ4) ..... 899.99 
1642VLZ4 16-Channel 4-Bus Compact Mixer (MA1642VLZ4)  .... 699.99
1202VLZ4 12-Channel Compact Mixer (MA1202VLZ4) ................. 269.99
1402VLZ4 14-Channel Compact Mixer (MA1402VLZ4) ................. 399.99

Q802USB

XENYX QX Series
Premium USB Audio Mixers

  » Premium Ultra-Low Noise, High Headroom Analog Mixers 
  » State-of-The-Art Xenyx Mic Preamps 
  » Studio-Grade Compressors with Easy One-Knob Functionality
  »  Neo-Classic British 3-Band EQs
  » 2 State-of-The-Art Xenyx Mic Preamps
  » Built-in Stereo USB/Audio Interface

Q802USB 8-Input 2-Bus Mixer (BEQ802USB) ................................. 79.99
QX1202USB 10-Input 2-Bus Mixer (BEQX1002USB) .................... 109.99
QX1202USB Premium 12-Input 2-Bus Mixer (BEQX1202USB) ... 129.99

EPM-12
Audio Console

  »  12 Mono & 2 Stereo 
Input Channels

  »  12x GB30 Microphone 
Preamplifi ers

  » Compact Mobile Enclosure
  » Recording and Live Sound Audio Console

(SOEPM12) ........................................................................................ 328.00
EPM-8 8 Mono + 2 Stereo Audio Console (SOEPM8) .................. 248.00
PM-6 Mono + 2 Stereo Audio Console (SOEPM6) ........................ 220.00

EPM-12

Compact Mobile Enclosure

16-Bit/48 kHz Resolution USB Interface
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StudioLive AR8 USB
8-Channel Hybrid Performance 
and Recording Mixer

  » 2 Mono and 2 Stereo Channels
  » 8x4 24-Bit/96 kHz USB Interface
  » 4 Class-A Microphone Preamps
  » Two Instrument Inputs » 3-Band EQ
  » Wireless Bluetooth Streaming

(PRSLMAR8) .....................................399.95
AR12 USB 14-Channel (PRSLMAR12) ........................................... 499.95
AR16 USB 18-Channel (PRSLMAR16) ........................................... 599.95

Si Impact  40-Input Digital 
Mixing Console and 32-In/32-Out USB Interface
  »  32 Mic Inputs » 8 XLR/1/4" 

Combi-Jacks for Instruments
  » DSP from Lexicon, dbx & BSS
  » 31 Output Busses with DSP & GEQ
  » 4-Band Parametric EQ on Ea. Channel
  » 8 VCAs + 8 Mute Groups
  » 26 Motorized Faders » 4 Customizable Fader Layers
  » 5" Touchscreen Display » 32x32 USB Audio Interface for Recording

(SO5056170) ..................................................................................2,299.00

Ui12
12-Input Remote-Controlled Digital Mixer

  »  Control via Tablet, PC, or 
Smartphone » Integrated Wi-Fi

  » DSP, DigiTech & Lexicon
  »  Per Channel 4-Band EQ, HPF

& Dynamics
  » Reverb, Delay, and Chorus

(SOUI12) ........................................................................................... 299.00
Ui16 16-Input Remote-Controlled Digital Mixer (SOUI16) ......... 399.00
Ui24R 24-Channel Digital Mixer / USB Recorder (SOUI24R) ...... 999.00

StudioLive 16 Series III
Digital Mixer - Digital Console/Recorder
  » 17 Touch-Sensitive Motorized Faders
  » 16 Channels: 8 Mic and 8 Mic/Line
  » 16 FlexMixes: Aux, Subgroup, or Matrix
  » Comprehensive Updated Fat Channel
  » Four 32-Bit Stereo DSP FX Processors
  » Includes StudioLive AI Software Library
  » Mac, Windows & iPad Compatible

(PRSL16S3) ..................................... 1,999.95
StudioLive 24 Series III (PRSL24S3) .........................................2,499.95
StudioLive 32 Series III (PRSL32S3) .........................................2,999.95

ProDX8
Wireless Digital Mixer

  » Bluetooth Streaming and Mixing
  » Recallable Mix Presets
  » 6 XLR/14" Combo Inputs
  »  3-Band EQ, Low-Cut & 

Comp per Channel
  »  Remote Control of

Levels, EQ, FX & More
  » 16 FX Including Reverb, Delay & Chorus

(MAPRODX8) ..................................................................................... 269.99

DL1608 iPad-Controlled 
Digital Live Sound Mixer 
  » With Lightning Connector
  » Integrated iPad Dock on Faceplate
  » iPad Mixing with Master Fader App
  » Extensive DSP Built In
  » 16 Onyx Microphone Preamps
  » Optional Wireless iPad Operation
  » Snapshot Mix Total Recall » Support for Multiple iPads

(MADL1608LIGH) ............................................................................... 599.99
DL806 iPad-Controlled 8-Channel Digital Mixer (MADL806L) .... 499.99

TouchMix-8  Compact Digital 
Mixer with Touchscreen

  » 12 Inputs » 8 Mic Preamps
  » Color Touchscreen
  »  Wireless Control via 

iPad App »  DSP Processing
  » Assignable Pitch Correction
  » USB Wi-Fi Adapter Included » Carrying Case Included

(QSTM8) ............................................................................................ 899.99
TouchMix-16 Compact Digital Mixer (QSTM16) .......................1,299.99
TouchMix-30 Pro 32-Ch, Compact Digital Mixer (QSTM30) ....1,899.00

Mixer with Touchscreen

8 Mic Preamps

 DSP Processing

TF1
Digital Mixing Console

  » Touchscreen & 17 Motorized Faders
  »  16 Analog XLR/TRS Combo 
Mic/Line Inputs

  » RCA Pin Stereo Line Inputs
  » 16 Analog XLR Outputs
  » 2x2 Recording via USB Storage Device

(YATF1)...........................................................................................1,999.99
TF3 Digital Mixing Console (YATF3) ...........................................2,499.99
TF5 Digital Mixing Console (YATF5) ...........................................2,999.99

Digital Mixing Console

Touchscreen & 17 Motorized Faders

2x2 Recording via USB Storage Device

X32 40-Channel,
25-Bus Digital Mixing Console

  »  Programmable MIDAS-
Designed Mic Preamps

  » 6-Band Parametric EQs
  » Digital Snake Ready
  »  32x32 FireWire/USB

Audio Interface Card
  » 40-Bit Floating-Point DSP
  » 7” Color TFT Display » Motorized Faders » Virtual FX

(BEX32) ..........................................................................................1,999.99

X32 Rack 40-Input, 25-Bus Digital
Mixer with 16 Microphone Preamps

  »  16 Programmable MIDAS 
Microphone Preamps

  »  8 XLR Outputs, 6 Aux 
Inputs/Outputs

  » 48-Channel Digital Snake Ready via AES50
  » 32x32 USB Audio Interface Card » 40-Bit Floating-Point DSP
  » Built-In Virtual FX » 5” Color TFT Front-Panel Display

(BEX32RACK) .................................................................................... 999.99

48-Channel Digital Snake Ready via AES50

31 Output Busses with DSP & GEQ
4-Band Parametric EQ on Ea. Channel

Qu-16C (Chrome Edition)
Rack-Mountable Digital Mixer
  »  Chrome Knobs & Faders + 

Updated Firmware
  » Touchscreen Interface
  » Motorized 100mm Faders
  »  16x Mic/Line Inputs

and 3x Stereo Inputs

(ALAHQU16C) .................................................................................1,699.00
Qu-24C 30-In/24-Out Digital Mixer (ALAHQU24C) ....................2,299.00
Qu-32C 38-In/28-Out Digital Mixing Console (ALAHQU32C) ....2,999.00

SQ-5  48-Channel 36-Bus 
Digital Mixer with 16+1 Motorized Faders
  »  24 Microphone Preamps
  » 7" Capacitive Touchscreen
  » 96 kHz FPGA Processing
  » Eight Stereo FX Engines
  » 32x32 USB Audio Interface
  » AES Output » 12 Stereo Mixes + LR
  » 16 LCD Channel-Strip » 16 Assignable SoftKeys

(ALAHSQ5) .....................................................................................2,799.00
SQ-6 48-Channel / 36-Bus Digital Mixer (ALAHSQ6) ...............3,499.00

32x32 USB Audio Interface
12 Stereo Mixes + LR

Bluetooth Streaming and Mixing

Digital Live Sound Mixer 

DL32R
Wireless Digital Live Sound Mixer

  »  Complete Wireless 
Control via iPad

  »  Personal Monitor 
Mixing with Any iOS

  » 3U Rackmount Design
  » 14 Fully Assignable XLR Outputs
  » 32 Mic Inputs with Onyx+ Recallable Pres
  » 28 Output Busses with EQ & Alignment Delay

(MADL32R) .....................................................................................1,799.99

M32R
Digital Mixing Console

  » 16 Midas PRO Microphone Preamplifi ers
  » 40-Bit Float Point Internal Processing
  »  17 Midas PRO Motorized 

100 mm Faders
  » 8 Digital FX Engines
  » 25 Time-Aligned Mix Buses
  » Durable Aluminum & High-Impact Steel

(MIM32R) .......................................................................................2,499.99
M32C 40-Input Digital Rack Mixer (MIM32C) .............................. 999.99

MR12  12-Input Digital 
Mixer for iPad/Android Tablets with Wi-Fi 
and USB Recorder

  » Integrated Wi-Fi Module
  »  iOS, Android, Mac, 
Windows, Linux Control

  »  Midas Microphone Preamps
  » XLR Outputs » M32 FX Rack with 4 Stereo FX Slots
  » USB Connectivity for Storage » Records Audio via USB

(MIMR12) .......................................................................................... 449.99
MR18 18-Input Digital Mixer (MIMR18) ....................................... 879.99

16 Midas PRO Microphone Preamplifi ers
40-Bit Float Point Internal Processing
 17 Midas PRO Motorized 

25 Time-Aligned Mix Buses
Durable Aluminum & High-Impact Steel

Mixer for iPad/Android Tablets with Wi-Fi 
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AT-LP120USB
Direct Drive Professional DJ Turntable 
with USB Output

  » USB Output » Direct Drive Motor
  » 33 1/3, 45, and 78 rpm Speeds
  » +/-10% and 20% Pitch Control
  » Cast Aluminum Construction
  » Includes AT95E Cartridge & Stylus
  » Includes Audacity Recording Software

(AUATLP120BKU) ............................................................................... 299.00

Direct Drive Motor

Includes Audacity Recording Software

PT01 Scratch
Portable Turntable with DJ Scratch Switch

  » Built-In Adjustable Slide-Switch
  » Slide-Switch Replaceable
  » Built-In Speaker
  » USB Class Compliant
  » 33-1/3, 45, and 78 rpm
  » Outputs: RCA and Headphone
  » AC or Battery Powered
  » Dust Cover & Integrated Carrying Handle

(NUPT01S) ........................................................................................ 129.00

Built-In Adjustable Slide-Switch

Outputs: RCA and Headphone

SL-1210MK5
Analog DJ Turntable

  » Adjustable Braking Speed
  » No-Click Pitch Control
  » Instant Pitch Reset
  » Quartz Direct-Drive
  »  33 1/3 and 45 

rpm Speeds
  »  Die-Cast Aluminum Platter

(TESL1210MK5) ..............................................................................1,999.00

M6
4-Channel USB DJ Mixer

  » 4-Channel Club-Style Mixer
  » LED Metering
  » 3-Band EQ per Channel
  »  Replaceable Crossfader 
with Slope Control

  » Class Compliant USB Audio Interface
  » Microphone Channel with Dedicated EQ
  » Mac and Windows Compatible

(NUM6USBBLACK) ............................................................................. 149.00

4-Channel USB DJ Mixer

Class Compliant USB Audio Interface
Microphone Channel with Dedicated EQ
Mac and Windows Compatible

NDX500
USB/CD Media Player & Software Controller

  » Touch-Sensitive Jog Wheel
  » DJ Software Control via USB MIDI
  » USB Audio Interface

» Pitch Tracking up to 100%
  » Anti-Shock Skip Protection
  » Programmable Playback Modes
  » Reloop Button Jumps to Beginning of Loop

(NUNDX500) ...................................................................................... 249.00

iM1
DJ Mixer

  » iPod Dock
  » 2-Channel Layout
  » Record Sets to iPods
  » 2-Channel EQ on Each Channel
  » Replaceable Crossfader

(NUIM1) .............................................................................................. 49.00

CDJ-2000NXS2 
High-Resolution Pro DJ Multi-Player
  » 24-Bit/96 kHz Compatibility
  » 7" Full-Color LCD Touch Screen
  » 8 Hot Cues
  »  Stream Audio over Wi-Fi 
from Smartphones

  » SD Card Slot & USB-A for Portable Media
  » CD/DVD Audio Player » Pro DJ Link LAN Connection

(PIDJ2000NXS2) .............................................................................2,197.00
CDJ-900 Nexus Professional Multi-Player (PICDJ900NXS) .....2,197.00

DJM-900NXS2 
4-Channel Digital Pro DJ Mixer
  » 4 Phono Inputs and 4 Line Inputs
  » 4 Input / 4 Output USB Soundcard
  » 4 In / 1 Out Digital Coaxial
  » Sound Color, Beat & Frequency Effects
  » Independent Send / Return for External FX
  » Pro DJ Link Support » 96 kHz / 24-Bit
  » 3-Band Isolator EQ per Channel
  » Two Headphone Outputs 1/4" & 1/8" » Three USB Ports

(PIDJM900NXS2) ............................................................................2,199.00

PLX-1000 
Professional Turntable
  » User-Friendly Control Layout
  »  High-Torque Direct Drive 
Motor System

  »  Tempo Control with Variable 
Width Levels

  » Built to Reduce Vibration » Rubber Encased Tone Arm
  » ±8%, ±16%, ±50% » Die-Cast Zinc Chassis
  » Detachable Audio and Power Cables

(PIPLX1000) ...................................................................................... 699.00

PLX-500-W  High-Torque, 
Direct-Drive Turntable (White)
  » User-Friendly Control Layout
  » High-Torque Direct-Drive Motor
  » Built with Vibration Damping
  »  USB Output » Switchable Phono 

Line Output » rekordbox Compatible
  » Includes USB, Audio & Power Cables
  » Includes Headshell with Cartridge

(PIPLX500W) ..................................................................................... 349.00
Black (PIPLX500K) .......................................................................... 349.00

DJM-750MK2 4-Channel 
Prof. DJ Club Mixer with USB Soundcard
  » 4 Phono Inputs and 4 Line Inputs
  » 4 Input / 4 Output USB Soundcard
  » Sound Color, Beat,  Frequency Effects
  »  Independent Send / Return for
External FX » 48 kHz / 24-Bit

  » 3-Band Isolator EQ per Channel
  » Two Headphone Outputs 1/4" & 1/8" » Two USB Ports

(PIDJM750MK2) .............................................................................1,199.00
DJM-250MK2: 2-Channel DJ Mixer (PIDJM250MK2) ................... 349.00

SC5000 Prime Professional DJ Media 
Player with 7" Multi-Touch Display

  » Dual-Deck Playback Engine
  » Separate Audio Outputs for Each Layer
  » Self-Contained Software Librarian
  » Three USB and One SD Card Reader
  » Digital Audio Outputs: 24-Bit/96 kHz
  » 7" High-Defi nition Multi-Touch Display
  » Eight Multi-Function Trigger Pads
  » Plays FLAC, ALAC, WAV, MP3, and More

(DESC5000PRIM) ............................................................................1,899.00

VL12 Prime Professional Direct Drive 
Turntable with True Quartz Lock

  »  High-Torque: 5 kgf/cm
  » Isolated Direct Drive Motor System
  » Built-In RGB Platter Light
  » Isolation Feet Eliminate Feedback
  » S-Shaped Tone Arm for Accurate Tracking
  » Adjustable Pitch Range: ±8, 16, 50%
  » 100mm Pitch Fader » Detachable Audio and Power Cables
  » Includes 45 rpm Adapter

(DEVL12PRIME) ................................................................................. 899.00

Isolated Direct Drive Motor System

S-Shaped Tone Arm for Accurate Tracking
Adjustable Pitch Range: ±8, 16, 50%

USB/CD Media Player & Software Controller

Reloop Button Jumps to Beginning of Loop

2-Channel EQ on Each Channel

Roland DJ-99
2-Channel DJ Mixer

  »  Visually Based on TR-909 
Drum Machine

  » Audio Innovate Mini innoFADER
  » Cue Mix Functionality
  » DVS Mode for Digital Vinyl Integration
  » Channel Fader Curve Control & Reverse
  » 3-Band EQ per Channel » 1/4" Microphone Input

(RODJ99)........................................................................................... 249.99

DVS Mode for Digital Vinyl Integration
Channel Fader Curve Control & Reverse

SD Card Slot & USB-A for Portable Media

Sound Color, Beat & Frequency Effects
Independent Send / Return for External FX

96 kHz / 24-Bit

Professional Turntable

Switchable Phono 
rekordbox Compatible

Includes USB, Audio & Power Cables
Includes Headshell with Cartridge

Separate Audio Outputs for Each Layer

7" High-Defi nition Multi-Touch Display

PRO MIXER DJX900USB
Professional 5-Channel DJ Mixer

  »  Infi nium Contact-Free 
VCA Crossfader

  » Beat-Syncable FX
  » USB Audio Interface
  » Adjustable Crossfader Curve
  » 3-Band EQ
  » Mac & Windows OS

(BEDJX900USB) ................................................................................. 249.99
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Mixtrack Pro 3 DJ Controller
for Serato DJ with Integrated Sound Card

  » All-in-One Serato Controller
  »  Integrated Audio 

Interface
  »  16x Multifunction 

Performance Pads
  »  Touch Strips for 

Dynamic FX Control
  » Dual 5” Hyper-Responsive Jog Wheels

(NUMIXTRAKPR3) .............................................................................. 199.00

TRAKTOR KONTROL Z1
DJ Mixing Interface

  » Two-Channel Tactile Mixer
  » 24-Bit/96kHz Converters
  » Low-Latency Headphone Cue
  »  Filter, Gain, 3-Band EQ, and 

Level Faders
  » Plug-and-Play with Mac/PC, iPad, iPhone
  » Includes TRAKTOR LE 2 Software

(NATRKNTRLZ1)................................................................................. 199.00

Plug-and-Play with Mac/PC, iPad, iPhone

DDJ-SB3 
Portable 2-Channel Serato DJ Lite Controller
  » Serato  DJ Lite Software Included
  » Serato Flip Function
  »  Large Aluminum-Plated 
Jog Wheels

  »  Eight Performance 
Pads per Deck » iZotope-Powered Effects

  »  2-Channel Mixer » Deck Control: 4 Decks » Slip Mode for Smooth 
Transitions » Needle Search Pad » Adjustable Crossfader Curve

(PIDDJSB3) ....................................................................................... 249.00

DDJ-SX2 
Serato DJ Controller
  » Serato DJ Software Included
  » Supports Serato Flip Function
  »  Large Aluminum
Plated Jog Wheels

  » Eight Performance Pads per Deck
  » iZotope-Powered Effects
  » Versatile 4-Channel Mixer » Slip Mode for Smoother Transitions
  » Needle Search Pad » Adjustable Crossfader Curve

(PIDDJSX2) ....................................................................................... 999.00

DDJ-WeGO4 
Digital DJ Controller
  » For Mac, PC, iPad, iPhone
  »  Jog Wheels Control 
Simultaneous Effects

  » Built-In Audio Interface
  » Pulse Control Multi-Color LEDs
  » USB Bus Powered » Charges Connected iOS Devices
  » iPad/iPhone Stand » Includes rekordbox dj Software
  » Includes Virtual DJ LE » USB and Power Cords Included

(PIDDJWEGO4K) ................................................................................ 299.00

DDJ-SZ2 
Flagship 4-Channel Controller for Serato DJ
  » Designed for and Includes Serato DJ
  »  Large Touch-Capacitive 
Jog Wheels

  »  Dual USB Cirrus Logic 
Soundcards

  » Supports DVS Control » Four-Channel DJM-Style Mixer
  »  Two Banks of Eight LED Performance Pads » Magvel Contact-Free 
Magnetic Crossfader » Pitch, Jet, Echo, and Filter FX

(PIDDJSZ2) .....................................................................................1,999.00

Traktor Kontrol S4 MK2
DJ Software Controller

  »  Works with TRAKTOR 
DJ iPad/iPhone App

  »  Aircraft-Grade 
Aluminum Jogwheels

  »  Color-Coded RGB Indicator Buttons » Flux Mode Buttons 
for Each Deck » +18 dBu Balanced 1/4” Outputs

  »  Includes TRAKTOR PRO 2 with Remix Decks

(NATKS4MK2) .................................................................................... 599.00

MIXON 4
DJ Controller for Serato DJ

  »  24-Channel Hybrid 
DJ Controller

  »  Plug-and-Play for Serato DJ 
and djay Pro

  » 16 Color-Coded RGB Drum Pads
  » Slip and Loop Modes » Macro FX: Dynamic Effect Combo Control
  » Harmonic Mixing Capable » Large Aluminum Jog Wheels with LEDs
  » USB 2.0 Audio Interface » Compatible with Mac, PC, iOS, Android

(REMIXON4) ...................................................................................... 799.99

MC6000MK2 Professional
Digital Mixer and Controller

  »  4-Channel/8-Source 
Real-Time Matrix

  » Dual-Deck Functionality
  » Built-In 24-Bit Audio Interface
  » 8 Assign Keys for Effect Control
  » 14-Bit 100mm Long Pitch Slider
  » 105mm Touch-Sensitive Jog Wheels

(DEMC6000MK2) ............................................................................... 699.00

MC4000 Professional
2-Channel DJ Controller for Serato

  »  Professional 
2-Deck Controller

  » Two Microphone Inputs
  » Hot Cue and Sample Pads
  » Touch-Sensitive Jog Wheels
  » 24-bit/44.1 kHz Audio Interface
  » Echo and Ducking Effect for Microphones

(DEMC4000) ...................................................................................... 399.00

Party Mix 
DJ Controller with Built-In Light Show

  » Party DJ Control System
  » RCA Audio Outputs
  » Plug-and-Play
  » Sync Button
  »  Effects and 

Multiple Pad Modes
  » Looping and Sampling Capabilities
  » Includes Virtual DJ LE Software

(NUPARTYMIX) .................................................................................... 99.00

Party DJ Control System

Looping and Sampling Capabilities
Includes Virtual DJ LE Software

DJ-808
4-Channel DJ Controller for Serato DJ

  » Includes 606, 707, 808 & 909 Sounds
  » TR-S Sequencer Controls Serato Sampler
  » Built-In VT Voice Transformer
  » 16 Velocity-Sensitive RGB Pads
  » Large, Low-Latency Platters
  » 24-Bit / 96 kHz
  » Professional Standalone Mixer
  » Includes Serato DJ and Pitch 'n Time

(RODJ808) ......................................................................................1,299.99

DJ-505
2-Channel, 4-Deck DJ Controller for Serato DJ
  » Two Channels, Two Low-Latency Platters
  » Deck Select for up to Four Decks
  »  8 x Dedicated Pad Controls 

for Serato DJ
  »  Serato Sampler and 

16-Step Sequencer
  » Built-In 24-Bit/48 kHz Audio
  »  Phono/Line RCA Inputs 
  » +1XLR, RCA, and 1/4" Outputs » MIDI Output and USB Port

(RODJ505) ......................................................................................... 699.99

DJ-202  2-Channel, 4-Deck 
DJ Controller for Serato Intro
  » Two Channels, Two Low-Latency Platters
  » Deck Select for up to Four Decks
  »  8 x Dedicated Pad Controls 

for Serato DJ
  » Built-In Roland Drum Kits
  » 16-Step Sequencer
  »  Built-In 24-Bit/48 kHz Interface
  » 1/4" Mic Input & RCA Outputs » MIDI Output and USB Port
  » Includes Serato DJ Intro » USB Cable Included

(RODJ202) ......................................................................................... 299.99

16 Velocity-Sensitive RGB Pads

Professional Standalone Mixer
Includes Serato DJ and Pitch 'n Time

Two Channels, Two Low-Latency Platters
Deck Select for up to Four Decks

Two Channels, Two Low-Latency Platters
Deck Select for up to Four Decks

8 Assign Keys for Effect Control

Two Microphone Inputs
Hot Cue and Sample Pads
Touch-Sensitive Jog Wheels
24-bit/44.1 kHz Audio Interface

Serato  DJ Lite Software Included

iZotope-Powered Effects

Serato DJ Software Included
Supports Serato Flip Function

Eight Performance Pads per Deck

Digital DJ Controller

Pulse Control Multi-Color LEDs

Designed for and Includes Serato DJ

Xone:K2
Professional DJ MIDI Controller

  »  4-Channel 48kHz Internal Soundcard
  »  52 Hardware Controls
  » 171 MIDI Commands across 3 Layers
  » Confi gurable Layering System
  » USB Bus Powered
  » Headphone Output on Front
  »  X:LINK Interface to

Xone:DB or More K2s
(ALXONEK2) ...................................................................................... 399.00

171 MIDI Commands across 3 Layers
Confi gurable Layering System
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M447
Competition DJ Turntable Cartridge

  » Engineered for Scratch DJs and Turntablists
  » High Output Voltage and Tracking Force
  »  Designed for Scratching, 
Spin-Back and Back-Cuing

  » Polished Gemstone Stylus
  »  Stereo Channel Balanced within 2dB for High Accuracy
  » Compatible with Shure N44-7/7Q/7Z Replacement Needles

(SHM447) ............................................................................................ 79.00
N447 Replacement Stylus for M447 (SHN447) .............................. 39.00

AT-HS1
Universal Turntable Headshell

  »  Universal 1/2" 
Tonearm Mount

  »  Fits 4-Pin Turntable 
Cartridges

  »  Color-Coded
Lead Wires

(AUATHS1)........................................................................................... 26.89

SFG-2  Stylus Tracking Force 
Gauge for Turntable Cartridges
  »  Accurately Measures the 

Stylus Tracking Force in 
Order to Minimize Needle 
and Vinyl Wear, Skipping, etc.

  »  Utilizes a calibrated beam balance that Mounts Between the 
Platter Spindle and Cartridge and Measures Tracking Forces from 
0.5 to 3.0 Grams in 0.05 Gram Increments

  » Minimal Friction with Rolling Beam Pivots

(SHSFG2) ............................................................................................ 39.00

Pro S - Concorde Series
Cartridge and Stylus 
(Single, Black)

  »  Includes Cartridge 
and Stylus

  » Concorde Body
  » Preinstalled Stylus

(ORCCPROSS) ..................................................................................... 99.99

CC Pro
Single DJ Cartridge with Stylus

  »  Provides a Balance of Sound Quality
with Tracking Ability for a Range
of Music Styles

  »  Flat, Transparent Sound Across the
Spectrum with Good Handling Ability

  »  Cartridge Connects Directly to the Turntable
Tonearm and Comes with an Attached Stylus

(ORCCPROSC) ................................................................................... 101.99

Omega
Elliptical Headshell-Mounted Cartridge
with Stylus

  »  Includes Cartridge 
and Stylus

  » Elliptical Cartridge
  » Headshell Mounted
  »  Archiving with 
USB Turntables

(OROMEGA) ......................................................................................... 34.99

M97XE
Low Mass Turntable Cartridge

  » Rich Sonic Detail and Response
  » Extremely Accurate Reproduction
  » Elliptical Stylus 
  » Die-Cast Aluminum Mounting Block
  »  Dynamic Stabilizer Aides In

Playing Uneven Surfaces 
  » Compatible with the Shure N92E Replacement Needle
  » SIDE-GUARD Stylus Protection System

(SHM97XE) .......................................................................................... 99.00

RHP-10
Mono DJ Headphone

  »  Professional 
One-Ear Assembly

  » Neodymium Driver: 50 mm
  » Ergonomically Padded Handle
  » Water-Resistant Ear Pad » Swivel-Mounted Ear Cup
  » Detachable Cable » Max SPL: 109 dB
  » Artifi cial Leather Case

(RERHP10MONO)................................................................................. 69.99

WHLB White Label
DJ Turntable Cartridge

  »  High Output Voltage and Tracking 
Force Designed for Optimum 
Results in Nightclubs

  »  Diamond Stylus
Designed for Preserving
Hard-to-Replace Vinyl Records

  » Stereo Channel Balanced within 2dB for High Accuracy
  » Compatible with the Shure NWLB Replacement Needle

(SHWHLB) ......................................................................................... 109.00

HPX2000 
High-Defi nition DJ Headphones

  » High-Defi nition Bass & Transparent Highs
  » Single-Sided, Oxygen-Free Copper Wire
  » Rugged, yet Comfortable Design
  » Rotating, Reversible Earcups
  » 40mm Cobalt Drivers
  » High Dynamic Range
  » Includes Adapter

(BEHPX2000) .............................................. 19.99

HP800  Professional 
Folding DJ Headphones
  » 40mm Dynamic Driver
  » 180° Swivel for Full Pivot Action
  » Maximum Power Handling: 1700mW
  » Folding Design for Ease in Portability
  » Replaceable Earpads
  » 1/8" to 1/4" Adapter

(DEHP800)......................................................................................... 149.00
HP600 (DEHP600) .............................................................................. 99.00
HP1100 (DEHP1100) ........................................................................ 199.00

AT95E
Dual Magnet Phonograph Cartridge

  » Frequency Response: 20 to 20,000Hz
  »  Channel Separation: 
>20dB at 1kHz

  »  Channel Balance 
within 2dB

  » Standard Half-Inch Mount
  » Includes Mounting Hardware & Stylus Guard

(AUAT95E) ........................................................................................... 39.98

Frequency Response: 20 to 20,000Hz

Mono DJ Headphone

Neodymium Driver: 50 mm

 High Output Voltage and Tracking 

Professional 

Maximum Power Handling: 1700mW
Folding Design for Ease in Portability

149.00

HDJ-X10 
Professional DJ Headphones
  » 50mm Dome-Type Drivers
  » Closed, Dynamic Earpads
  » 90° Rotatable Housing
  » Adjustable Headband
  » Folding Design
  »  2x Mini-XLR Cables:

Coiled & Straight
  » 1/8" to 1/4" Adapter Included

Black (PIHDJX10K) .......... 349.00 White (PIHDJX10S) .......... 349.00

HDJ-X5-K 
HDJ Over-Ear Headphone
  » 40mm Dome-Type Drivers
  » Closed, Dynamic Earpads
  » 90° Rotatable Housing
  » Adjustable Headband
  » Folding Design
  » 1.2 m Short Coiled Cable
  » 1/8" to 1/4" Adapter Included

Black (PIHDJX5K) .............................................................................. 99.00
White (PIHDJX5S) .............................................................................. 99.00

HDJ-X10 
Professional DJ Headphones

HDJ-X5-K 
HDJ Over-Ear Headphone

HD 25
Monitor Headphones

  »  Lightweight and Durable Design, 
Ideal for Professional Use

  »  Adjustable, Padded Headband 
Fits Virtually any Head Size

  »  Closed-Back Earcups and 
Thick On-Ear Cushions

(SEHD25MH) ..................................................................................... 149.95
HD 25 Light (SEHD25LH) ................................................................ 129.95
HD 25 Plus (SEHD25PH) ................................................................. 199.95

 ..................................................................................... 149.95

Single DJ Cartridge with Stylus

 Cartridge Connects Directly to the Turntable
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Par 20
Aluminum Light Fixture (Black)

  » Black Aluminum Exterior
  » Standard Household Base
  »  Octagonal Gel Frame with 

Easy Secure Gel Frame 
Spring Clip 

  »  Includes A/C Cord 
and 3.5" Hanging Yoke

(ODLSPAR20B) .................................................................................... 19.03

PAR38
Spot with Lamp

  » 150W PAR Can
  »  Great Light for Mobile DJs, Live

Performances & Installations
  » Supplied for Use With 120VAC
  »  Includes the Fixture, a Lamp, 

Power Cord & Gel Frame
  » Compact (7x7x6”) and Lightweight (2 lb)

(AMPAR38BL) ...................................................................................... 21.62

Compact (7x7x6”) and Lightweight (2 lb)

Mega Bar RGBA
42" Linear Fixture

  » Multicolored » Electronic Dimming 0 to 100%
  » 6 Operating Modes » Built-In Microphone
  » 3-Pin DMX Connection » Power Cord Daisy Chain

Black  (AMMBRGBA) ........................................................................ 159.00
White  (AMMBRGBAW) .................................................................... 159.00

Electro Swarm
LED Effect Light

  » Six Sound-Activated LEDs
  » Master/Slave Confi guration
  » Stepper Motor
  » No Duty Cycle
  » Daisy-Chainable

(ELECTROSWARM) .............................................................................. 89.95

Intimidator Spot 155
LED Moving Head

  » 9 x Colors + White and Split
  » 9 x Gobos + Open
  » 32W Cool White LED Engine
  » 17° Beam Angle
  » Pan / Tilt: 540° / 270°
  » 2 x DMX Channel Modes: 6 or 11
  »  Master/Slave Operation » Supports Power and DMX 
Daisy-Chaining » Mounting Hardware Included

(CHINTMSPT155) .................................................................Call or Log-On

Mega Bar 50
RGB RC Light Bar

  » Includes Remote Control » 126 10mm LEDs
  » 7-Channel DMX Modes
  » Seven Operating Modes
  » Color Strobe Effect
  » DMX-512 Protocol
  » Electronic Dimming
  » Beam Angle: 40°
  » Multi-Voltage: 90-240V

(AMMEGABAR50R)............................................................................... 97.86

Stinger Spot  Startec Series Mini LED 
Moving Head Light

  » 10W LED Source » 7 Colors + White and Split
  » 7 Fixed Gobos » Pan and Tilt Inversion
  » 2 DMX Channel Modes: 9 and 11 Channels
  » 4 Internal Show Modes + Sound Activation
  » Pulse and Random Strobe Effects
  » Selectable Dimming Curves
  » Build Complex Lighting Installations
  » Includes Omega Mounting Bracket

(AMSTINGERSPT) .............................................................................. 199.99

Pocket Pro
Compact LED Moving Head Light

  » Bright White 25W LED Source
  » Compact and Lightweight (at 7.3 lb)
  » Gobo Wheel with 7 Replaceable Gobos
  » Kit of 4 Additional Gobos Included
  » Pan and Tilt Inversion Mode
  » Separate Color Wheel with 7 Colors
  »  4 Internal Show Modes +

Sound Activation
(AMPOCKETPRO) ............................................................................... 299.99

SlimPAR 56
LED PAR Can Lighting Effect

  » Slim 2.2” Profi le
  » 108 Red, Green & Blue LEDs
  » 3- or 7-Channel DMX-512 Modes
  » Color Mixing with or without DMX
  »  Built-In Automated and 
Sound Activated Programs

  » Pulse Effect with Adjustable Speed

(CHSLIMPAR56) ................................................................................... 79.99

Freedom Par Tri-6  Battery-Powered 
RGB LED PAR with Wireless DMX

  » RGB Color Mixing, 6x 3W Tri-Color LEDs
  » Battery Runs 20 Hours (Single-Color)
  » Built-In D-Fi Wireless DMX
  » 15° Beam Angle, 29° Field Angle
  » 0 to 100% Dimming
  » Built-In Automated Programs
  » Variable Color-Strobe Effect
  » Adjustable Kickstand

(CHFRDOMPRTR6) ............................................................................. 279.99

DJ COLORrail
IRC LED Wash Light

  » 320 RGB LEDs
  » Eight Sections of DMX Control
  » Automated and Sound-Activated Programs
  » Chase and Runway Effects
  » Power Linking

(CHCLRRAILIRC) ................................................................................ 179.99

COLORdash Batten Quad-6
Linear RGBA Wash Fixture

  »  Six Individually 
Controlled RGBA LEDs

  » Individual Pixel Control
  » Smooth Color Mixing and Fading
  »  Silent and Flicker-Free Performance » Simple and Complex DMX 
Channel Profi les » 4 Distinct Dimming Curves

  » 3-Button LED Digital Display » Includes Hanging Bracket
  » Includes Two Floor Trunnions

(CHCOLORDBTQ6) .............................................................................. 269.99

LB-Par Hex
RGBAW+UV LED Light

  » 6-Color Mixing » 6 or 11 DMX Channels
  »  Automated and Sound-Activated 

Programs » Strobe Effects
  »  16-/32-Bit User Selectable 

Dimming Modes
  » 4-Button LED Control Panel
  » 3-Pin XLR In and Out
  » Dual Mounting Bracket Included

(BLPARQAUDHEX) ................................249.99249.99

  » Multicolored » Electronic Dimming 0 to 100%

Mega Hex Par
Compact RGBAW+UV LED Wash Light

  »  Low-Profi le PAR for Wash/Uplighting
  » 5 x 6W RGBAW+UV LEDs, 25° Beam Angle
  » UV Glow, Variable Color Temperatures
  » DMX & AC Connectors Oriented Sideways
  » 5 x DMX Channel Modes
  » 5 x Operational Modes
  » 0-100% Dimming » Includes Adjustable Scissor Yoke
  » Includes UC IR Wireless Remote and Airstream IR App Transmitter

(AMMEGAHEXPAR) ............................................................................... 99.99

Mega Flash DMX
800W Strobe (120VAC)

  »  Bright 800-Watt Lamp ZB-800
  »  Adjustable Flash Rate 

and Intensity Rate
  » 1 to 15 Flashes/Second
  » Thermostat Protection
  » Large Coverage Area
  » Easy Lamp Replacement
  » Built-In Adjustable Hanging Yoke

(AMMFDMX) ...................................................................................... 149.99

Intimidator Spot 155

7 Colors + White and Split

5 x 6W RGBAW+UV LEDs, 25° Beam Angle

DMX & AC Connectors Oriented Sideways

» 320 RGB LEDs

 Bright 800-Watt Lamp ZB-800
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Hurricane 700
Fog Machine

  » Professional Fog Machine
  »  For Enhancing Visual Lighting 
Effects, Laser Effects

  » Generous Capacity Tank
  » Quick Heat-Up of Water-Based Fog
  » Manual Fog Button » Includes Wired Remote
  » Includes a Yoke Bracket » Includes 0.6L of Fluid

(CHHUR700FOG) .................................................................................. 36.99

Hurricane Haze 4D  Haze Machine 
with Wired Remote Control

  » Water-Based Hazer
  » High-Output Haze: 4300 ft³/minute
  » Low-Noise Fan » 2x DMX Channels
  » Heat-Up Time: 2 minutes
  »  0.9 Gallon Tank » 4-Button 
LED Display to Access Functions

  » Compact Design
  » Included FC-T Wired Timer Remote » Included Hanging Bracket

(CHHHAZE4D) ......................................................................Call or Log-On

Funfetti Shot
Confetti Launcher

  » For Entertainment Venues
  »  Works with Most 

Confetti Types
  »  Includes Wireless Transmitter 

& Receiver
  » Double Bracketed Yoke
  » DMX Compatible

(CHFUNFETTSHT) .............................................................................. 299.99

Gobo Projector IR

  » Bright 10W White LED
  »  Projects Custom Gobo 
Images on Surfaces

  »  Static or Slow Rotating 
Gobo Images

  » Optional IR Remote
  » Includes 4 Color Gels
  » Includes 4 Replaceable Gobos » Easy Gobo Replacement

(AMGOBPRJCTR) ............................................................................... 159.99

Mister Kool II  Low-Lying Fog Machine 
with Wired Remote

  » 700W Water-Based Fog Machine
  » Fog Output 3000 ft³/minute
  » 8 Minutes of Continuous Operation
  » 3-Minute Warm-Up Time
  » 25.6 oz Gallon Fluid Tank
  » Manual, Continuous, Time-Controlled
  »  Control Duration and Interval » Includes ADJ VFTR13 Remote & 

12' Cable » Lightweight (at 19 lb), Compact Design

(AMMISTERKLII) ..................................................................Call or Log-On

VF Flurry
Snow Machine

  »  Spray Distance: 
6.5 - 16.4'

  » 33.8 oz Fluid Tank
  » Low Fluid Sensor
  » Wired Remote
  »  Uses Water-Based

Fluid

(AMVFFLURRY) .................................................................................. 119.99

Bubbletron
High-Powered Bubble Machine

  » Compact and Easy to Operate
  »  Front Load Fluid Intake
& Dispenser

  »  Produces Hundreds of 
Bubbles per Minute

  » Large High Velocity Fan
  » Bubbles Shoot Rapidly into the Air
  » Wired On/Off Remote Switch

(AMBUBBLETRON) ............................................................................... 99.99

M-600L
16" Mirror Ball Package

  » M-1616 16" Glass Mirror Ball
  » M-101 HD A/C Motor
  » PL-1001ETL Pinspot PAR Light
  » 30W ZB-4515 Lamp Included
  »  Pinspot Hanging Bracket 

Included
  » For Permanent Installations

(AMM600L) ......................................................................................... 82.34

Vapour
Fog Machine

  » Precise Output Control
  »  Wide Range of 

Atmospheric Effects
  »  Integrated DMX Interface 

(XLR 5-Pin)
  » Detachable Timed Remote
  » Multi-Link Daisy-Chain Feature

(ROVFM) ........................................................................................... 838.95

EZ Gobo LED
Gobo Projector

  » Battery-Powered LED Gobo Projector
  » Projects a Custom Image Anywhere
  » Manual Zoom for Short or Long Throw
  » Includes 10 Wedding-Ready Gobos
  »  Magnetic Base Affi xes to Most Metal 

Surfaces, No Need for Clamps
  » Scissor Clip with Eye Loop

(CHEZGOBO) ........................................................................Call or Log-On

Micro
Galaxian II Laser

  »  DJ and Nightclub Lighting Effect
  » 200 Green & Red Laser Beams
  » Auto or Sound Active Modes
  » Built-In Programs
  » Fan Cooled
  » RF Wireless Remote
  » Includes Dual Hanging Bracket

(AMMICROGALII) ................................................................................. 79.99

Gobo Zoom
USB Projector

  »  D-Fi USB Compatibility for Instant 
Wireless Master/Slave or DMX Control

  »  Digital Display for Controlling Direction, 
Dimmer, and Gobo Rotation

  » Manual Zoom for Short or Long Throw
  » Includes 10 Wedding-Ready Gobos
  » User-Confi gurable Standalone Operation
  » Accepts Custom Gobos

(CHGOBOZOMUSB) ............................................................................ 299.99

EZ Laser RGFX  Battery-Powered 
Laser with Wireless Remote 

  »  Independent Red and Green Laser Diodes
  » Projects Thousands of Beams
  »  Sound-Activated and Automated 
Programs » Dispersion: 80°

  » IRC-6 Wireless Remote Included
  » Lithium Battery: up to 6 Hours of Use
  » Variance-Free Operation
  » Includes Mounting Hardware

(CHEZLASERGFX) ................................................................................. 79.99

H2O IR 12W
LED Simulated Water-Flowing Effect

  »  Long-Life, Bright 12W LED
  » Five Colors plus White and Split Colors
  »  2x Glass Effect Wheels & 

One Color Wheel
  »  Single Color and Scrolling 

Colors Modes
  »  Adjustable Beam Angle: 34 or 43°
  » Runs All Night (No Duty Cycle) » Manual Focusing Lens

(AMH2OLEDIR) .................................................................................. 169.99

Five Colors plus White and Split Colors

Hurricane 700
Fog Machine

Quick Heat-Up of Water-Based Fog

AF-3
Antari Fan

  » 4 x Control Options
  » Low Power Consumption
  » DMX and Local Control
  » Metal Housing
  »  Adjustable Mounting 

/ Floor Bracket

(ELAF3) ............................................................................................. 412.00

Antari Fan
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PTAU45
Stereo Power Amplifi er

  »  20 Watt x 2 10% RMS 
at 4 Ohms

  » Power on LED Indicator
  » Bass & Treble Tone Control
  » USB Input » Switchable MIC Pager and Mixing Modes
  » 1/4” Front Headphones Jack » 3.5mm Aux CD/MP3 Input Jack
  » 1/4” Front MIC Jack with Volume Control » Volume Control

(PYPTAU45) ......................................................................................... 66.75

DN-312X
12-Channel Mixer with Mic Priority

  » Six Mic/Line Combo XLR-1/4" Inputs
  » Channel 1 Mic Priority over Channels 2-6
  » Three Stereo RCA Inputs » Balanced XLR Outputs
  » Mono Out and Mic Output on 2x 1/4" » 3-Band EQ
  » Recording Output: Stereo RCA » AC or DC Power Source

(DEDN312X) ...................................................................................... 179.00

135MA
35W Commercial Mixer/Amplifi er

  » 3 Inputs, 1 Output 
  » Phoenix and RCA inputs
  » Telephone Output
  »  VOX or Switch 

Priority Muting
  »  Bass and Treble 

Controls

(CR135MA) ........................................................................................ 208.95
160MA 60W Commercial Mixer/Amplifi er (CR160MA)................. 341.25

C100 Classic Series
Public Address Amplifi er (100W)

  » Output for Tape Recorder or Booster Amp
  »  Thermal Pprotection 
and Electronic 
Shutdown

  » 4 Inputs
  » Aux Muting
  » Telephone Input

(BOC100)........................................................................................... 375.00

 Thermal Pprotection 

SPT15A
Reentrant Horn Loudspeaker 
7.5W 25/70V

  »  Weatherproof, 
All-Metal Construction

  »  Built-In Rotary 
Impendace Selector

  » Easy-to-Install and Maintain

(BOSPT15A)......................................................................................... 79.99

PDIC81RD 8" Two-Way 
In-Ceiling Speaker System

  » Two-Way Speaker
  » Midbass Speaker
  » Voice Coil
  » Dome Tweeter
  » In-Ceiling Installation
  » Pair

(PYPDIC81RD) ..................................................................................... 45.90

CSP-162
6.5" 2-Way Ceiling Speaker System

  » Up to 150W Power Capacity
  » For 70V, 100V & Low-Ohm Systems
  » Integrated Multi-Tap Transformer
  » Front-Baffl e Located Tap Selector
  » 3/4" Titanium-Coated Tweeter
  » 6.5" Woofer » Sealed Backcan Enhances Fidelity
  » 7.5" Clearance » Vented Port Enhances Low Frequencies

(SECSP162) ....................................................................................... 199.00
CSP-142 80W 4" 2-Way Ceiling Speaker (SECSP142) ................ 149.00

FP6020-II
Sound-Focusing Speaker (Clear Dome)

  »  Dual-Parabolic Dome Technology Provides a
Targeted Hot-Spot with Defi nitive
Stereo Separation

  »  Twin 1” Concave Aluminum
High-Excursion Drivers
in Individually Sealed
Compartments for Stereo or Mono Music and Messaging

  » ZeroRefl ection Enclosure Technology » Coverage Angle of 30°
(SOFP602020D) ................................................................................. 517.00

SD72W
Dual Cone Ceiling Speaker 

with Baffl e (White)

  »  Dual Cone Speaker
  »  4W 70.7/25V 

Transformer
  » CRS Baffl e

(ATSD72W) .......................................................................................... 26.99

Control 1 Pro
Professional Compact Loudspeaker

  » Compact Two-Way Speaker System 
  »  Magnetically Shielded for Safe

Use Near Computer Monitors 
  » Full Frequency Response
  » 5” Woofer & 0.75” Tweeter
  » Sonicguard Protection Circuitry
  » Perfect for Video Editing or DAW Use

Pair - Black (JBC1PROB) ............................................................... 164.00

Control 24CTM  Two-Way Vented Ceiling 
Speaker in Low Ceiling Venues - Pair 

  » 30 Watts Power Capability
  »  8W Multi-Tap Transformer for 
70V and 100V Systems

  »  4 1/2" Woofer, Injection Molded 
Graphite Cone with Butyl Rubber Surround

  » Extremely Wide 150° Coverage
  » Shallow 4" Depth
  » 1/2" Polycarbonate Tweeter for Extended Response

Pair (JBC24CTM) .............................................................................. 148.00

EVID-4.2T
2-Way 200-Watt Installation Speaker

  »  Rugged Surface-Mount Weather-Resistant 
Installation Monitor in black Finish

  » Equipped with 70V/100V Transformer
  »  Dual 4" Woofers with

Magnetic Shielding
  » Use with Video and Computer Monitors
  » 1" Coherent Coverage Waveguide Horn Tweeter
  » Titanium Dome Tweeter with Neodymium Magnets

(ELE42T) ........................................................................................... 329.00

CE500A 
Multi-Purpose Speaker

  » 80W Internal Amplifi er
  » 5.5" Woofer and 0.5" Tweeter
  » Integrated Limiter
  » XLR Mic/Line Input
  » XLR Link/Output Connector
  » RCA Line Input
  » Mounting Hardware Included

(BECE500ABK) ................................................................................... 129.99

Reentrant Horn Loudspeaker 
Dual-Parabolic Dome Technology Provides a
Targeted Hot-Spot with Defi nitive

SCM268
4-Channel Microphone Mixer

  »  For Sound Reinforcement » Rack-Mountable
  » Compact Design » 4 XLR Mic Inputs » 4 RCA Inputs
  » XLR Output » AUX RCA Phono Output
  » Supplies 12V Phantom Power » Low Noise Floor

(SHSCM268) ...................................................................................... 234.00

IA1200
Integrated Amplifi er with USB & SD Inputs

  »  RCA, USB, SD,
AUX Inputs

  »  Push-Button
and RCA Outputs

  » 1200W Peak Power » SD Card Size up to 32GB
  » Play MP3 Files » iPod Playback through USB Input
  » Record from Aux / RCA Inputs » Repeat / Random Playback
  »  Bass, Treble & Balance Controls

(TEIA1200) ..........................................................................Call or Log-On

and RCA Outputs

 Rugged Surface-Mount Weather-Resistant 

1" Coherent Coverage Waveguide Horn Tweeter

Graphite Cone with Butyl Rubber Surround
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IN-LINE PROBLEM SOLVERS & ACCESSORIES

For all Problem Solvers & 
Accessories
 SCAN THIS
or visit BandH.com/w15336

PROFESSIONAL AUDIO CABLES

Cloudlifter CL-1
Mic Activator

  »  Mic Input » Improves Signal-
to-Noise Ratio » Use with 
Passive Dynamic & Ribbon Mics

  » +25 dB of Clean, Transparent Gain
  » Requires Only Phantom Power to Operate
  » Ideal for Long Cable Runs » Use with Low-Output Mics

(CLCL1) ............................................................................................. 149.00

TM

IMA-1030 Switchable
In-Line Attenuator

  » Provides -10, -20, or -30 dB of Attenuation
  »  For Use with All Low-Impedance & 
Phantom-Powered Condenser Mics

  » XLR Female to XLR Male
  » Shielded Metal Case to Prevent Interference

(PEIMA1030) ....................................................................24.99

CBT-500
Audio Cable Tester

  »  Multiple-Type Cable Tester » XLR: 3-Pin 
and 5-Pin » SpeakON: 2-, 4-, and 8-Pole

  » Phono (RCA), Phone (1/4" TRS and TS)
  » DIN: 3-, 5-, and 8-Pin » RJ45 (Ethernet)
  » BNC: 75 Ohms » USB: Type A to Type B
  » Includes Two Removable Leads and Battery

(HOCBT500)......................................................................................... 44.95

IMP 2
Single-Channel Direct Box

  » Passive Design
  » Designed for Both PA & Studio Use
  » 1/4” Parallel Wired In / Out Jacks
  »  Uses Whirlwind’s TRHL-M Transformer with Metal Shield
  » Ground Lift Switches Help Eliminate Hum & Buzz » Rugged Built

(WHIMP2) ........................................................................................... 53.00

Patch Box II  Analog Stereo Output 
Multiplier and Signal Converter

  » Balanced 1/4" Inputs
  » XLR, 1/4", and RCA Outputs
  » Passive Design
  »  Pair of Balanced Stereo Inputs
 That Feed 12 stereo Outputs

  » Balanced to Unbalanced Conversion
(HEPB2) ............................................................................................ 139.99

Micmute PPD
Latching Switch-On/Switch-Off
Audio Switch (Desktop)

  » Convenient Desktop Design
  » Metal Housing
  » Indicating Rocker Switch

(WHMICMUTEPPD) .............................................................................. 78.00

QBOX Audio Line
Tester/Cable Tester/Test Tone Generator 
  »  Send a Tone or the Signal From 

the Built-In Condenser Mic
  »  Confi rm Incoming Signals 

at Mic Level
  » Built-In Amplifi er
  » XLR or 1/4" Outputs

(WHQB) ........................................................218.00

Latching Switch-On/Switch-Off

78.00

PB223 Mic Power II
Dual 48V Phantom Power Supply

  »  Input Connectors: 
2x 3-Pin XLR Female

  »  Output Connectors: 
2x 3-Pin XLR Male

(ROPB223) .......................................................................................... 56.00

ProD2  Stereo Passive 
Direct Box 

  »  Great Sounding, Stereo, Rugged Passive DI 
for Electronic Keyboards and Drum Machines

  » Very low Harmonic and Phase Distortion
  »  -15dB Pads for Range of Input Levels 

and Ground Lift Switches
  » Ideal for Live Sound and Studio

(RAPROD2) .................................................. 149.99

for Electronic Keyboards and Drum Machines

149.99

PDI-40
Passive Direct Box

  » 1/4” Balanced Input
  » XLR Balanced Output
  » Parallel Output for Connecting to Amp
  » Converts High Impedance to Low Impedance
  » -20 or -40dB Pad » Ground-Lift Button Minimizes Hum

(KOPDI40) ........................................................................................... 24.99

Parallel Output for Connecting to Amp
Converts High Impedance to Low Impedance

CBT-MF 
Multi-Function Cable Tester

  » Tests 11 Connector Types
  » Integrated Test Tone Generator
  » Simple & Convenient Operation
  » Detachable Chassis for Long Cable Runs
  » XLR, TRS, Speakon, RJ45, RCA, BNC & More

(KOCBTMF) ......................................................................................... 99.95

Multi-Function Cable Tester

Detachable Chassis for Long Cable Runs

MicMute MM11 PRO
Microphone Mute Switch

  »  Switchable Push-to-Talk or 
Push-to-Mute Function

  » Passes Phantom Power
  » Lowers the Mic Signal about 60 dB
  » 0.09" (0.23 cm) Steel Chassis
  » 2 Balanced XLR Jacks, a Single Female Input

(ROMS111) .......................................................................................... 44.00

DSM-1X
Digital SPL Meter
  » Easy-to-Read 4-Digit LCD Display
  » 4 Ranges Measuring between 30 and 130 dB
  » 32 to 8000 Hz Response
  » Max., Min., and Instantaneous Data Hold
  » Automatic Out-of-Range Detection
  » Internal Battery Tester

(NADSM1X) .............................................................. 74.99

LSP-1 Laptop SoundPort
3.5mm Stereo Mini Male 
to 3-Pin XLR Male 
In-Line Adapter
  »  Volume Control of Outgoing 
Stereo Signal

  »  3.5mm Male Input and 
XLR Male Output

(DSLSP1) ............................................................................................ 80.00

3.5mm Stereo Mini Male 

CM-130 Check Mate
SPL Meter

  » Lightweight, Miniature with 0.1dB Resolution
  » Built-in Electret Condenser Microphone with Windscreen
  »  Large Backlit Level Range Display with Low, Medium, 
and High Level Readouts » AC Signal Output

(GACM130) .......................................................................59.99
CM-140 Check Mate (GACM140) ................ Call or Log-On 

HE-2-XLR
Dual-Channel Hum Eliminator

  » Eliminates AC Hum
  » Breaks Ground Loops
  » 1/4" TRS and XLR Connectors
  » Audiophile quality components 
  »  Converts automatically between 

balanced and unbalanced lines 

(EBHE2XLR)......................................................................................... 93.00

NA3MM   XLR Male to 
XLR Male Adapter

  »  Die-Cast Exterior Housing 
Protects Terminations

  »  Latch Lock Connectors
Prevent Cables From Being
Accidentally Disconnected

  » Compact Space Saving Design
(NENA3MM) ...........................................................................................6.61

Shielded Metal Case to Prevent Interference

 ....................................................................24.99 6.61

PS400 Ultra-Compact Phantom 
Power Supply

  »  Provides Selectable 
12V or 48V power for use 
with Any Condenser Mic

  »  High-Quality Components
Enable Ultra-Low Noise via XLR Connectors

  » Rugged Construction Promises Years of Durability
(BEPS400) ........................................................................................... 24.99

Cloudlifter CL-1

Requires Only Phantom Power to Operate
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DIGITAL AUDIO CONNECTORS

Connector AES/EBU (3-Pin XLR Connector) SPDIF RCA (RCA or JIS F05 Connector) TOSLINK (JIS F05 Connector) TOSLINK Mini (3.5 mm Connector) ADAT Optical (JIS F05 Connector)
Cable 2-Conductor + Ground Coaxial or Fiber Optic Fiber Optic Fiber Optic Fiber Optic
Signal Stereo Stereo Stereo Stereo 8-Channel

Basic
Application

Standard connection for professional 
digital audio. Two channel or Left / Right

Typically used in professional and 
consumer level audio devices.

Two channel or Left / Right

Based on S/PDIF protocol utilizing optical 
fi ber cable for digital audio.
Two channel or Left / Right

Based on S/PDIF protocol utilizing optical 
fi ber connector for digital audio. Used on 

compact devices. Two Channe or Left / Right

Typically used in professional audio
applications for transfering or receiving

8 channels of audio

UNBALANCED AUDIO CONNECTORS

Connector 1/4” TS 1/8” TS RCA Sub-Mini
Cable 1-Conductor + Ground 1-Conductor + Ground 1-Conductor + Ground 1-Conductor + Ground
Signal Unbalanced Unbalanced Unbalanced Unbalanced

Basic
Application

Unbalanced signal, typically used in for instruments 
such as guitars, bass, and synthsizers

Unbalanced signal, typically used in smaller modular 
synthsizer formats such as eurorack

Unbalanced signals, typically used in professional DJ 
equipment and consumer home audio Typcially used in compact electronic devices

SPEAKER CABLE CONNECTORS

Connector Speakon 1/4” TS Banana
Cable 2-, 4-, 8-Conductor 2-Conductor 2-Conductor
Signal Unbalanced Unbalanced Unbalanced

Basic
Application

Standard pro audio speaker cable.  NL-2 is typical single speaker 
input. NL-4 is typically used for bi-amped speakers. NL-8 is 

typically used for tri-amped 3-way speakers.
Single speaker cable Audiophile and prosumer 

single speaker cable

BALANCED AUDIO CONNECTORS

Connector XLR 3-Pin 1/4” TRS 1/8” TRS 1/8” TRRS TT or Bantam DB25
Cable 2-Conductor + Ground 2-Conductor + Ground 2-Conductor + Ground 3-Conductor + Ground 2-Conductor + Ground 8x 2-Conductor + Ground
Signal Balanced Balanced Balanced Balanced Balanced Balanced

Basic
Application

Balanced microphone and line 
level signals

Balanced line level signals or 
unbalanced stereo signals

Balanced line level signals or 
unbalanced stereo signals

Typically used for cell phones. 
Balanced stereo signal

with a microphone

Balanced line or microphone level, 
typically used pro-audio patchbays 
for recording or broadcast studios

Balanced line or microphone level, 
typically used in pro-audio for 

multi-channel audio equipment

Choosing Audio Cables
Whether you are looking to run cable in your professional studio or simply to get 
your home theater set up, B&H’s cable selection runs the gamut to cater to your 
needs. With cabling solutions including 3-pin XLRs, 1/4” TRS and instrument, 
1/8” stereo, DB25 connectors, RCA, Speakon, and a variety of digital audio cables 
such as AES/EBU, TOSlink, and more, B&H has your audio cabling needs covered. 
To fi nd the exact cable you need, log on to www.BandH.com/CableFinder/ProAudio

SCAN
THIS

CODE

To view a full listing
of all Pro Audio Cables

or visit our website
BANDH.COM/W15337

www.BandH.com/CableFinder/ProAudio
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